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CHAPTER 1

Composition Features and Tool Bars

Amgraf’s OneForm Designer Plus
Amgraf’s OneForm Designer Plus (OFDP) software is a Windows-based
package for electronic forms, PLUS the addition of Amgraf’s MECCA III
Business Forms Composition and Prepress Software for the accurate design
and output of conventional paper forms.

It provides the forms professional with all of the necessary layout and make-up
functions to compose multi-color/multi-part business forms in either Spot
Color or Process Color. Powerful drawing tools, along with a comprehensive
library of templates, fonts, borders, and pantographs, to enable the efficient
creation of high quality cut-sheet, continuous, unit set, mailer, and other
business forms.

Composition Features
• Import Pre-Designed Business Forms. The following formats can be

imported: Encapsulated PostScript (.eps), PostScript (.ps), Portable
Document Format (.pdf), and MECCA Graphics (.g).

• Forms Design Tools. Not only do you have the standard Draw Line, Draw
Box, Place Text, Resize, Move, and Copy, you also have the extensive set
of business form drawing features found on MECCA III Systems such as
Scale, Rotate, Hold Position, and Step-and-Repeat, just to name a few.

• Flat, Graduated, and Radial Screens. Screens can be placed within boxes
or any shape. They are controlled from 0% to 100% in 1% increments,
while the screen lineage can be as coarse as 20 lines per inch or as fine as
150 lines per inch. The operator can choose either a flat screen, a graduated
directional screen, or a graduation radiating from a specified center point.

• Snap-to-Grid Background Reference. Business forms can be accurately
designed using the Snap-to-Grid and Window Zoom features. A grid of
printable reference lines can be displayed on the screen to force alignment
of items in the form. The operator can define the horizontal and vertical
spacing of the points. Business forms with exact typewriter or
computer-printer spacing in tenths and sixths are easily and accurately
created with this feature.

• Borders and Pantographs. A wide variety of borders, pantographs, and
blockouts can be merged from the 120+ stock library included with the
package.

• Color Separations and Layers. Thirty-two layers (overlays) are supported
for color separation and multiple-part forms. Text and rules can be assigned
to a particular layer, and the operator can choose to display or hide
individual layers or parts on the screen, as well as during printing. The
Output Specification panel makes it simple to image up to 32 color
separations in perfect registration on any PostScript device.



Basic Drawing Tools

2 OFDP Business Forms Composition – Ver 8.0

• Barcodes. OneForm Designer Plus includes software and fonts for
barcodes: Postal Zip and FIM Codes, Code 39, Interleaved 2 of 5, Code
128, Codabar, UPC-A, UPC-E, and EAN-13 to name a few.

Basic Drawing Tools
The drawing tools give you easy access to the types of components you can
create. They are easy to use. For lines, simply choose Draw Line and make
two individual picks; the start and end of the line. Boxes and Rectangles need
two diagonal corners. Interactive Text just needs a pick for the position and
you are ready to start typing. To quit out of text input, toggle off the Text
Input tool or click your right mouse button to display a pop-up menu and
select Done.

Draw Line

Input Text

Draw Box

Draw Circle

Draw Spline

Draw Rectangle

Draw Area

Add Logo

Figure 1-1: Tools for Drawing
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Types of Drawing Components
Listed below are the different types of drawing components that can be created
with the OneForm Designer Plus software. These are in order of the Tool Bar
where many of them can be found. Barcodes are only under the Draw menu.

Vectors

Vectors are lines. They are drawn by either the Line or Rectangle tool. It also
includes lines drawn as Prorated Multiple Lines and Chained Lines under the
Draw, Vector menu. Rectangles are four lines drawn at once to represent a
rectangle shape. The four lines are combined together for moving, grouping
and deleting.

Text

Text is created through the Text Input tool or by the Draw Text menus. All
are creating text as fonts, just placing the text is different with each option.
Under Draw Text there are three options: Mark Anchor Position, Mark Left
and Right Positions and Place Text in Boxes.

Boxes

A Box is a rectangular or square shape with a stylized look for printing. It
can be as plain as a rectangle with just square corners, or special with rounded
corners and screened. The box component can have inside filled areas, screened
bars (odd, even or both), individual line weights on each side, all as one
component. It even has a library of borders and pantographs.

Arcs/Circles/Ellipses

The Circle tool, creates circles. The Draw, Arc menus not only have circle,
but also include arc (semi-circle), and ellipse.

Splines

A spline is an irregular smooth curve which needs four points to complete.
We are creating Bezier splines.

Areas

Areas are screened or solid fills that are created by picking an outside path.
Types of Areas include: Rectangular, Poly Line Area and Special Shapes.

Rasters

These are black-and-white, grayscale, or color scanned images brought into
the form using the Add Logo tool.

Barcodes

There are eleven different types of barcodes that can be generated: Codabar,
Code 3 of 9, Postal (FIM and ZIP), UPC (A and E), Interleaved 2 of 5, and
Code 128, EAN-13, Intelligent Mail, and the Interleaved 2 of 5 Luhn Check
Digit.
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Pop-Up Menus Contain a Variety of Functions
Pop-up menus contain a wide variety of options specific to the current
component or tool chosen. The pop-ups can be accessed by a right mouse
click.

The pop-up menu holds many options that aid in modifying properties or
positioning a component. Use the Select Cursor tool to pick a component, then
right-mouse to access the pop-up menu.

Properties: When you right click after selecting a component, it will bring
up the pop-up menu for that component. One of the options will allow you to
see the properties of that component. Any changes made here only affect this
component’s properties.

Cancel: This ends the current action.

Continue: This closes the pop-up window and allows you to continue the
previous action.

For example, the following pop-up menu is associated with Lines. Use the
Select Cursor tool to pick an existing line. Then, right-mouse to access the
pop-up options. A line’s properties are found under the option "Vector
Properties".

Figure 1-2: Pop-Up Menus Hold Many Varying Options
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The Tool Bars
The OneForm Designer Plus tools are described in the following usage
groupings:

• File Function Tools

• Drawing New Components

• Modifying Properties and Size with the Select Cursor

• Modify Drawing Tools (Move, Copy, Scale, Rotate)

• Accuracy Controls, Measure, and Undo

• Select Cursor Controls

• Cut and Paste Tools

• Zooming Tools

• Using the Text Tools

• Set Line, Box, and Area Attributes Before Drawing

• Fielding Tools

Figure 1-3: The Tool Bars are Active after Starting a New Form
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File Function Tools

Figure 1-4: New / Open / Save / Print

The File function tools are the shortcuts to New, Open, Save and Print. New
File creates a new graphic ".g" file which is an 8.5" x 11" page for you to
start designing your own form. The Open File tool allows you to browse
through your directories to open existing graphic files. Save File will save the
current version under the existing file name, and Print takes you to the standard
Windows Print dialog box for proof printing.

Creating a New Form File

Selecting New immediately brings up a New Drawing Setup dialog box for
naming the new file. This dialog allows you to setup the properties pertaining
to the new file.

Figure 1-5: Setup a New Drawing Dialog

The file created can be either a graphic file (.g) or electronic form file (.elf)
ready for drawing artwork and fields according to your OneForm Profile.



Chapter 1: Composition Features and Tool Bars

New Drawing Setup Dialog

7

Before selecting [Okay], you have an opportunity to setup the following items:

File Name: The file name is very important to the whole process. It is used
as the basename for any other files generated. The convention needed for OFDP
e-forms is an alpha/numeric name with no spaces or punctuation. Also, the
file name should be at least 3 characters, start with an alpha character, and
use the extension of .elf (for electronic form).

If you are creating files just for printing, you can use any amount of
alpha/numeric characters and end with the extension of .g (for graphics art).

Date Initialized: This is the date the file was originally created. The date is
generated by the computer and cannot be changed.

Operator ID and Job Number: Here you can input names and job numbers
to assist in production management.

Form Width and Depth: This determines the size of form you are creating.
The default is in the Units of points. You can change this at any time.

Form X Origin and Form Y Origin: This represents the location of the
form’s lower-left corner in the window display.

The options for Color Model, and Layer Color all deal with Color display
and printing. You are able to create either Process color, Spot color, or RGB
color files. The difference in printing techniques are significant and affect the
creation and output process. "Process" color is based on a Color Number made
from the four colors: cyan, magenta, yellow, and black. Whereas, "Spot" color
refers to a pre-mixed ink color number (FCP number) and is controlled by our
Layer attribute. For HTML e-forms, the "RGB" (Red, Green, Blue) color model
works well. See Business Forms Composition, Working with Color for more
information.

Comments: This is a handy place to keep comments concerning production
of the job.

Units: OFDP allows you to work in different units. If you need to see the
drawing size in another unit, just make the unit selection here. This temporarily
controls this dialog’s unit display. Changing the default preference for Units
is found under Options, Drawing Options, Units.

You can modify the Drawing Properties through the Options, Drawing Options,
Drawing Properties menu.
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Opening an Existing Form File

When you click Open on the Tool bar, you are opening an existing file. It will
bring up a dialog box listing all valid files in the last directory opened.

The standard OneForm Designer Plus can open two types of files:

.g – OFDP and MECCA Graphic Files

.elf – OFDP Electronic Form Files

You may look in another location by clicking the Folder dropdown field and
double-clicking the name of the folder that contains the file you wish to open.
Continue doing this until you get to the folder which holds your file. Then,
in the list of files, click the file name and select [Open].

Figure 1-6: Open Files Dialog

You can also back out of the current folder by clicking the Close Folder icon.

A Shortcut: If you have opened the file recently, it may be in the file name
list in the bottom of the File menu. There will always be a list of the last ten
files opened. Just select the name from the list.
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Saving and Proof Printing Your File

When you select Save, the action is immediate. You are overwriting the
existing file with the current version.

The Save As allows you to save items under a different name. Here you have
an opportunity to give it a new name or save it in a different location. Use
"Save All Components" to save the entire file. The Save As has many other
saving options such as Save Only Grouped Components, and Save Only
Current Layers. All of the save options are explained in Chapter 5.

When naming files remember to use the file naming conventions described on
page 7.

Printing the Form

When you select the Print Form you will be printing through Windows Print
Manager. File’s Print option includes the standard Windows Print Manager:
Print, Preview and Print Setup.

You can use your View selections to print the form with fields (Normal Fields)
or without fields (No Fields).

Figure 1-7: Windows Print Dialog

For creating PDFs, use the OFDP Save As PDF option. This will create PDFs
that recognize OFDP’s unique commands and features.
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Drawing New Components

Draw Line

Input Text

Draw Box

Draw Circle

Draw Spline

Draw Rectangle

Draw Area

Add Logo

Figure 1-8: All of These Tools Create New Components

Each of these tools create components and add them to your drawing. You
will find the right-mouse button causes a pop-up menu to appear with a variety
of choices relative to the drawing tool you are currently using.

Following is a description of the simplest form of usage for each tool to give
you a general idea of how they work.

Draw Line: To create a line, you would pick the Draw Line tool first. Then
pick two points on your page representing the start and end of the line. You
will stay in the Draw Line tool until you toggle out of it or pick another
drawing tool. All lines drawn will have the properties specified within the Set
Line Properties dialog.

Text Input: Inputting text requires just a position pick after selecting the Text
Input tool. The text cursor will appear ready for you to start typing. The
position of the text is relative to the position picked and its composition mode:
Flush Left, Flush Right, Centered, or Justified. Toggle out of the Text Input
tool or select Done within the pop-up menu to end typing. (If Notepad opens,
you have the "Text Editor" option turned on.)
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Draw Box: Drawing a box simply requires selecting the Box tool and picking
two diagonal corners. Box components have additional attributes which can
be applied through the Set Box Properties, such as rounded corners, screens,
bars, borders and pantographs.

Draw Circle: This option lets you create full circles. For a full circle pick the
center and tangent. The line weight of a new circle is controlled by the Set
Line Properties tool.

Draw Spline: This tool draws curved lines. After picking the Spline tool,
select four control points on the screen to represent the anchors the curve is
to travel through. Finish by right-clicking and choosing Done. The line weight
of a new spline is controlled by the Set Line Properties tool.

Draw Rectangle: Drawing a Rectangle (which is made up of four lines) simply
requires selecting the tool and picking two diagonal corners. The line weight
is controlled by the Set Line Properties tool.

Draw Area: An Area is a color fill placed within a closed boundary. After
picking the Area tool, start picking the boundary control points on the screen.
Finish by right-clicking and choosing Close Path or Done. The properties of
a new area is controlled by the Set Area Properties tool. Hint: Draw your
boundary guide with lines and splines, and then come back and trace over
them with the draw area tool, since it cannot be modified.

Figure 1-9: Types of Drawing Components
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Add Logo
Adding a logo to a form is done by choosing the Add Logo tool and picking
the position for the upper-left corner of your logo. This will bring up the Raster
Image Properties dialog window for browsing to the logo. Click [Okay] and
the logo will be placed on the form.

Figure 1-10: Adding a Logo
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Raster Image Properties Dialog
The Raster Image Properties dialog gives you the ability to browse for the
logo and size it before being added to the form.

Once a logo has been selected, you will see a location path in the Path field
and a preview of the image in the Preview box. (GIF files cannot be previewed.)

There are a number of valid logo file types that can be brought into OneForm
Designer Plus.

Logo Description and Extension:

BMP (*.bmp) Photo CD(*.pcd) 
LEAD (*.cmp) Portable Graphics (*.png) 
GEM Image (*.img) Sun Raster (*.ras) 
GIF (*.gif) TGA (*.tga) 
JPG (*.jpg,*.jpeg,*.jff,*.jtf) TIFF (*.tif) 
Macintosh Picture (*.pct) Windows Icons (*.ico,*.cur)
MacPaint (*.mac) Windows Metafile (*.wmf) 
Microsoft Paint (*.msp) Winfax (*.fxs) PCX (*.pcx)

Of these, two are common logo file types for use with HTML Internet forms:

GIF (*.gif) 
JPG (*.jpg, *.jpeg, *.jff, *.jtf) 

The Height and Width fields are the physical dimensions of the logo. These
values can be changed in order to control the final size of the logo.

The Layer, Color, and Screen Properties is set at the time the logo is brought
in. For details on these properties see Set Line Attributes.

Original Size imports the logo with no distortion. The image can be scaled
by moving the Scale slider bar scale bar from left to right. The Height and
Width values will display the image size as the percentage changes.

Modifying Raster Properties
You will find information about the Raster Component in the properties. It
will tell you the file type and size of the image.

This dialog has a field for Changing the Layer of the component and applying
an HTML Alternate Text Display.

Raster Properties does not allow you to resize, it only reports the current size.
Use Modify Size instead.

Modifying the Size of Existing Logos
If existing logos need to be resized, pick on the logo with the Select Tool and
then choose the Modify Logo Size in the pop-up. You will be given an
opportunity to pick a side or corner to modify. Picking a corner will keep it
proportional.
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Select Cursor Controls

Figure 1-11: This is the Select Cursor

Clicking and dragging a component with the Select Cursor will initiate the
Move option. Following are the select cursor click-drag controls.

Box/Field
Handle Click/Drag -> Move
Inside Click/Drag -> Move
Shift Click/Drag -> X/Y Constraint
Ctrl Click/Drag -> Handle for Resize
Ctrl-Alt Click/Drag -> Copy

Vector (Line)
Click/Drag -> Move
EndPoint Click/Drag -> Resize Line 
EndPoint Shift Click/Drag ->

Move Endpoint
Shift Click/Drag -> X/Y Constraint
Ctrl-Alt Click/Drag -> Copy

Text
Handle Click/Drag -> Move
Inside Click/Drag -> Move
Shift Click/Drag -> X/Y Constraint
Ctrl-Alt Click/Drag -> Copy
Dbl Click -> Edit

Raster (Logo)
Handle Click/Drag -> Move
Inside Click/Drag -> Move
Shift Click/Drag -> X/Y Constraint
Ctrl Click/Drag -> Handle for Resize
Ctrl-Alt Click/Drag -> Copy

Also, once a bounding box is displayed, the keyboard arrows can "Nudge" the
component. The amount can be controlled by inputting a value, then arrow.

Modify Properties with the Select Cursor
The Select Cursor is used to modify the properties of existing items. For
example, toggle on the Select tool and pick on the item to modify. Notice a
bounding box with handles will appear showing you that it has been identified.
By clicking your right mouse button while the item is selected, a pop-up menu
will appear with choices relative to that component type. Selecting Properties
will bring up a Modify Properties dialog (for that component) allowing you
to change them. Note: When the Select Cursor picks the page canvas, its
pop-up menu is a shortcut to the Text Editor Selector and Group.

Modify Properties by
selecting any item first
then the right mouse
pop-up menu.

Select Cursor

Figure 1-12: Use the Select Cursor Tool to Modify Properties
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Modify Size Options
Each component type has modify size options in its pop-up menu. For example,
toggle on the Select tool and pick on the line to modify. Notice that handles
will appear showing you that it has been selected. By clicking your right mouse
button while the line is selected, a pop-up menu will appear with choices for
modifying its length. Descriptions of some of these options are below:

Modifying Lines

Break Line: is when you want to create a break in an existing line. This option
breaks a line into two segments or cuts out a middle portion of the line. After
choosing a line with the select cursor, choose Break Line and pick the two
points where you want to break the line. Finish the process by selecting Done
in the pop-up menu.

If the two picks are the same point, the line will be broken in two with no
obvious break. If the two picks are different, the section between the two picks
will be cut out.

Trim Line: This will trim lines in reference to another line. Choose your
Select tool and the line that will be your trim marker. Right-click your mouse
and choose Trim Line. Click on the end-point of the line you want to trim.
Choose Done Trimming in the pop-up menu when finished.

Modify End of Line: This is a method for lengthening or shortening your
line. With Modify End of Line, you can extend or shorten the length of the
line without changing the angle of the line. After selecting the line with the
Select tool, choose this option and select the end to modify. Now, simply pick
on the new position.

Modifying Boxes

Modify Box Size: This will resize a box by grabbing a side (or corner) and
clicking on the new position. Use the Select Tool to pick a box, then choose
Modify Box Size and grab a side or corner of the box. As you move the cursor,
you will see the box size change. Pick the new position for your side or corner.

Divide Box into Rows: This cuts a box into rows and creates two separate
boxes, one on top of the other. Dividing a box is as simple as choosing the
box, selecting the option, then picking the position for the cut. The box is
immediately horizontally divided into two. [CTRL]+[F11] is the shortcut.

Divide Box into Columns: This works in the same manner as Divide Box
into Rows, it just cuts the box vertically. Shortcut is [CTRL]+[F12].

Modifying the Size of Existing Logos

If existing logos need to be resized, pick on the logo with the Select Tool and
then choose the Modify Raster Size in the pop-up. You will be given an
opportunity to pick a side or corner to modify. Picking a corner will keep it
proportional.
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Modify Tools

Move

Copy

Scale

Rotate

Figure 1-13: These Tools allow you to Modify Existing Components

The Modify Options allow you to Move, Copy, Scale, or Rotate any component.
After picking a Modify tool, choose the component to modify. These tools
also work with Groups of components.

Move and Copy Tools
Move and Copy: Choosing the Move or Copy tool on the tool bar allows you
to move or copy any component to a new position. These tools work in an
identical manner, so we will explain the concept through the move.

Moving a component is easy. After picking the Move tool, pick the component.
Then pick a handle and its new position. To constrain the movement go to the
pop-up menu and select either Horizontal or Vertical Only.

Move Copy

Figure 1-14: The Move and Copy Pop-Up Menus are Similar
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Options to aid you in moving and copying components can be found in their
respective pop-up menu. Descriptions of these options are found below:

Horizontal Only: This only allows movement in the horizontal direction.

Vertical Only: This only allows movement in the vertical direction.

Set Plumb: This allows you to pick a vertical plumb line for moving left and
right.

Set Level: This allows you to pick a horizontal level line for moving up and
down.

Repeat Last Move: This will replicate the previous "move" both in direction
and distance. This is not a continuous function and must be chosen each time
that you want to repeat the move. [Ctrl+F10] is the shortcut.

Repeat Copy: This will repeat your last copy; both in direction and distance.
[Ctrl+F10] is the shortcut.

Bring Others: If you move a component within a group and you want to move
the other components so that they remain in the same relationship to the
component moved, choose "Bring Others." Begin clicking on the other
components, they will be moved to the new position so that they remain in
the same relationship as they were to the original. This is a continuous function
and will continue to allow you to "Bring Others" until you choose Done in
the pop-up menu.

Copy Others: If you have a group of items and you copy a component within
that group, you may use "Copy Others," and select the other components to
copy. Upon clicking on them, they will be copied to the new position so that
they remain in the same relationship as it was to the original. This is a
continuous function and will continue to allow you to "Copy Others" until
you have chosen Done in the pop-up menu.

Step Count: This will allow you to copy an item multiple times by entering
the number of copies and distance in both the horizontal and vertical direction.
This will create multiple copies in one easy step.

Allow GUID Item Move: GUID Items are combined components. This allows
the component selected to be moved separate from its combined pieces. The
combine is still in effect, but the individual items can be adjusted.

Continue: Use this to close the menu without making any additional choices.

Cancel: This option cancels the last pick. Use it to "repick" if you happen to
grab the wrong component to move.

The Position Assistant options are used to easily define a location for the
cursor when picking. For example, Component Center places the cursor in the
center of a component regardless of where you picked it. They are always
available under the Options Menu. For complete details on usage of the
Position Assistant options, see Chapter 5: The OneForm Designer Plus Menus.

The Plumb and Level options work the same for Move and Copy. There are
examples of usage on the next page.
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Set Plumb and To Plumb Position
The Plumb options are found under the Move and Copy pop-up menu. They
move/copy items left and right.

Figure 1-15: Plumb To a Position

To use "Set Plumb", first choose either the "Move" or "Copy’’ tool. Next,
right click your mouse and choose Set Plumb in the pop-up menu. You will
be prompted to "Pick location to Plumb to". This is the left/right position
where you want items to line up, a yellow vertical reference plumb line will
appear at the identified pick. Now, click on the object that you wish to
Move/Copy. A bounding box will appear and the pointer will change to the
picking handles. Click upon one of the handles and the item will Move/Copy
left or right placing the chosen handle against the vertical plumb line. Continue
identifying objects and clicking on their handles until all objects are lined up.

The "To Plumb Position" option will remain active at all times when using
Move/Copy until it is deactivated in the pop-up menu. When finished moving,
uncheck To Plumb Pos.
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Set Level and To Level Position
The Level options are found under the Move and Copy pop-up menu. They
move/copy items up and down.

Figure 1-16: Level To a Position

To use "Set Level", first choose the "Move" or "Copy" tool. Next, right click
your mouse and choose Set Level in the pop-up menu. You will be prompted
to "Pick location to Level to". This is the up/down position where you want
items to line up, a yellow horizontal reference line will appear at the identified
pick. Now, click on the object that you wish to Move/Copy. A bounding box
will appear and the pointer will change to the picking handles. Click upon one
of the handles and the item will Move/Copy up or down placing the chosen
handle against the horizontal level line. Continue identifying objects and
clicking on their handles until all objects are lined up.

The "To Level Position" option will remain active at all times when using
Move/Copy until it is deactivated in the pop-up menu. When finished, uncheck
To Level Pos.
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Scale and Rotate Tools
Scale and Rotate both operate in a similar fashion in that they need two pieces
of information before any action can take place; an anchor position and a
value.

To resize a component choose the Scale tool and select the item to modify.
Handles will appear noting it is selected. The Hint Line at the bottom of the
screen will prompt you to "Pick Center to Scale". This is the anchor position
of the component as it is scaled; it will shrink or grow from that position.
Once you have chosen the anchor position, the Scale dialog box appears for
you to input the scale factor. The scale factor is the fraction in which you
want to increase or decrease the size of the component. Click on [Okay] to
accept the value and see the component resize. Hint: Just filling in X-Scale
will always proportionally scale.

Figure 1-17: Scale and Rotate Dialogs

Pick the Rotate tool to spin the item counter-clockwise. Select the item to
modify. Handles will appear noting it is selected. The Hint Line at the bottom
of the screen will prompt you to "Pick Center to Rotate". This is the anchor
position of the component as it rotates; it will rotate around that position. Once
the anchor has been chosen, the Rotate dialog box will appear. Enter the angle
and select [Okay]. The object will rotate counter-clockwise with positive angles
and clockwise with negative angles. Note: Boxes can only be rotated in 90,
180, 270, and 360 degrees.

The following options aid in scaling and rotating items. They can be easily
accessed through their respective pop-up menu.

Pick Center: This is the center point in which you rotate items around and
the anchor point for scaling. This is the fixed position as the component changes
when scaling or rotating.

Key in Size: This is only on the Scale pop-up. This is the scale factor. The
scale factor is the fraction that you are scaling the component. To get an exact
size think of it as "Want/Have". After measuring what you have, type in the
fraction as the size you want / and what you have.

Key in Angle: This is only on the Rotate pop-up. This is the angle to rotate
your component. Input the angle in degrees. The object will rotate
counter-clockwise with positive angles and clockwise with negative angles.
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Repeat Rotate/Scale : This will repeat the last rotation or scale by the values
previously set. set in the dialog.

Rotate/Scale Others : This will rotate or scale other components on the form
using the values previously set.

Make Copy when checked, will produce X number of copies rotated on the
center point. The number of copies is determined in Copy Count. This is only
on the Rotate dialog.

Copy Count is only on the Rotate dialog. This is the number of copies to be
rotated around the center point.

Cursor Accuracy Controls, Measure, and Undo

Grid Snap On/Off

Component Snap On

Eight Direction Lock

Measure

Undo

Figure 1-18: Grid On with Eight Direction Lock Assists in Accuracy

Grid Snap On/Off is a handy toggle that when "ON" will snap components
to the grid. The Grid Properties and the Ruler can be found under the Options,
Grid Options menu.

Comp Snap will snap your cursor onto nearby components. For example, this
is needed when drawing lines that should end on the edge of a box.

The Eight Direction Lock forces lines to be drawn in only eight directions:
0, 45, 90, 135, 180, 225 270, and 315 degrees. This option is for ruling a
form. Toggling it off will draw lines in all directions. When drawing a box,
the Eight Direction Lock will lock the box into a square.

The Measure tool measures the distance between two picks on a page. It
displays the X and Y Difference, Distance, and Angle in selected units. To
measure the distance of something, click on the Measure tool. Next, click the
two points in which you want to measure the distance.
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Figure 1-19: Measure Tool and Dialog

A dialog box will give the X (Horizontal) and Y (Vertical) difference, the
distance and angle the cursor traveled, and choice of units to be displayed.

The Undo tool will restore the last modify which took place. It is an unlimited
Undo, up to your last Save. You can also use [Ctrl-Z].

Cut and Paste

Figure 1-20: Cut / Copy / Paste

These options are standard Windows editing options of Cut, Copy, and Paste,
with a twist. To cut or copy, first Group Select Pick the item. Then, choose
the Cut or Copy tool on the Toolbar. Finally, click the Paste tool and the
position to paste. You can continue pasting the items into new locations as
many times as needed. The items remain on the clipboard (a temporary storage
area) until you cut or copy again.

These options are normally used to paste items into another file. Because of
this, Paste has a pop-up menu that includes "Combine at Original Location"
along with the standard Position options.

The items will be pasted on the new page as a white group of components so
that they can be handled easier if they end up in the wrong spot. It will be
necessary to use Edit’s menu option of Group Unselect All to unselect.

Since the component Copy and Move Tools (on the left tool bar) have extensive
positioning options, it is recommended that you use them for standard forms
composition.



Chapter 1: Composition Features and Tool Bars

Set Text Properties

23

Zoom Options

Figure 1-21: Down / Up / Zoom Area / Fit Screen

The Zoom options available allow close up viewing of details. Zoom Up brings
you closer to the screen, while Zoom Down moves you away from the screen.
The Zoom Area option allows you to select any area within a rubberband box
by making two picks. This is an easy method to zoom into a specific area. To
revert back to the entire graphic, choose Fit Screen.

The Text Tools

Figure 1-22: New Text Input / Check Spelling / Set Text Properties / Readout /
/ Text Editor / Composition Mode

There are four tools that work specifically with text. The first one is for creating
new Text Input. This requires a position pick after selecting the Text Input
tool. The text cursor will appear ready for you to start typing. The position
of the text is relative to the position picked and its composition mode: Flush
Left, Flush Right, Centered, or Justified. You must toggle out of the Text Input
tool or select Done within the pop-up menu to end typing.

Set Text Properties

Figure 1-23: Set Text Properties Tool

The Set Text Properties gives you the ability to set (or describe) the attributes
of any new text item before it is created. When the Set Text Properties icon
is picked you will see the dialog box appear:
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Figure 1-24: Set Text Properties Font Tab Dialog

Once all text attributes have been selected, choose the [Okay] button to accept
them. Then whenever you create a piece of text through the Text Input tool,
these attributes are used. The attributes chosen will appear in the Readout.

The only attributes which will be discussed here is the Text Font Tab. All
others are completely detailed in Chapter 6: Working with Text.

Text Font Tab

The following are components of the Text Properties:

CompMode –
FL = Flush Left
FR = Flush Right
CE = Centered
JU = Justified
FLC = Flush Left Centered
FRC = Flush Right Centered

Font Name – Font Selected from List
H-Size – Horizontal Point Size
V-Size – Vertical Point Size
Lead – Baseline-to-Baseline Leading in Points
Rotation – Angle Position of Text
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The CompMode (Composition Mode) field has a drop-down list of four
different modes which are: Flush Left, Centered, Flush Right, and Justified.
This controls how lines of text are placed within your text box.

Flush Left aligns all left edges, Flush Right aligns right edges, Centered will
center all lines over each other, and Justified will adjust each line’s spacing
to align both the left and right edges of the text.

The Font Name field shows what font is currently selected. Clicking on the
[...] button next to the Font Name field will bring up the font list of all fonts
accessible to your system with their associated font mnemonic. Select the
font/style needed and then click the [Okay] button.

The next options control the size of your text. The Horiz Size (Horizontal
Size) field controls the width of the text and the Vert Size (Vertical Size)
field controls the height. These values can be entered in 1/10th point
increments. When they have two different values, you are requesting it to
expand or condense the font.

Leading controls the spacing from the baseline of the first text line to the
baseline of the second text line. The values can be input in 1/10th point
increments. It is recommended that the leading be equal to or larger than the
vertical size of the text to keep lines from oversetting.

The Left Margin is the point where your first character of your lines will
align. The Right Margin determines where your line will end and begin to
wrap to the next line.

Text Attributes Readout

Figure 1-25: Font / Horizontal Size / Vertical Size / Composition Mode

The Text Attributes Readout displays a quick reference as to the Font Style,
Font Size and Composition Mode of your Text Attributes. Font Characteristics
cannot be changed here and simply represent the characteristics determined in
your Text attributes. When in a text box, this will display its current font
characteristics: Font, Size, Style and Composition mode.
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Check Spelling

Figure 1-26: Spelling Tool

You can check the spelling of text with the Check Spell tool. If no text is
picked or grouped, it will run through the entire file and show you a bounding
box to identify the text it is currently checking.

To check a portion of the file, group the text to be checked and then choose
the Check Spelling tool. To check just one text component, identify it with
the select cursor. The Check Spell tool will then only check the text within
that text bounding box.

Interrupting the Check Spell program, must be done cautiously. If you do not
allow it to complete the entire task and you close or cancel to soon, the last
task is considered cancelled. To avoid a Replace not taking place, just select
Ignore before the Cancel. Then the last task is the Ignore not a Replace.

Text Editor Selector

There are two methods for entering text: Interactive or Text Editor. The
Interactive mode is the default, you can see the text composed as you are
typing. The Text Editor is a toggle which turns off Interactive mode and opens
an editor and composes the text after the editor is closed.

Figure 1-27: Text Editor Selector Tool

When using the Text Editor, you simply choose the Text tool and pick the
position in which you wish to place text. As long as you have the Text Editor
turned on, the Text Editor will appear each time you begin placing text and
each time you edit.
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Figure 1-28: Notepad Text Editor Allows Immediate Commands

Advantages of Using the Text Editor

You may enter text using all of the notepad features such as the [Del], [Arrow]
keys, [Insert], [Page Up] and [Down] along with cut and paste. Also, the text
can have embedded MECCA Immediate Composition Commands.

Text is discussed completely within Chapter 6: Working With Text.

Set Line, Box and Area Properties
These three tools are for controlling the characteristics of items which have
not been drawn yet. You are "setting the look" before the item is to be drawn.
The two most commonly used are Set Line Properties and Set Box Properties.

Set Line Properties

Set Box Properties

Set Area Properties

Figure 1-29: Set Properties Tools
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The Set Line Properties Dialog Box
The Set Line Properties gives you the ability to describe the attributes of any
new line, rectangle, circle, or spline component through the following dialogs.
They control the line weight, line style, and color attributes.

Figure 1-30: Line Properties Dialogs for Process Color Files

Weight – Line Thickness Shown in Current Unit
Style – Line Style Used: Solid, Dashed, Dotted, etc.
Color – Process Color needs Four Color Process Number.

Spot Color needs a Layer 1 - 32 and the Percentage of Color

The default attributes for the Draw Line tool is a Black, half-point solid line.

The Process Color Model uses Four Color Process (FCP) Ink Numbers to
display colors. Getting Black requires you to use our FCP Number that
represents Black, which is 700 or 0. White is 600. The others colors in the
list represent standard industry ink color numbers, i.e., 267, 289 and 300 are
ranges of Blue.

If you need to draw your lines in Blue instead, you can use Set Properties to
set it ahead of time.

When the form’s Color Model is Spot Color the line properties dialog will
allow you to pick from the stock of 32 different Layer Colors through [Select
Color].
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Figure 1-31: Spot Color Files Control Color with Layers

Color Model Affects Set Attribute Dialogs for [Select Color]

When the form’s Color Model (found in the Drawing Properties option) is
Spot Color, then the dialog will allow you to pick from 32 different preset
Layer Colors.

The Process Color Model uses Four Color Process (FCP) Ink Numbers to
display colors. Getting Black requires you to use our FCP Number that
represents Black, which is 700 or 0. White is 600. The others colors in the
list represent standard industry ink color numbers, i.e., 267, 289 and 300 are
ranges of Blue.

The Box Properties Dialog Box
By setting the values for the Draw Box tool you can easily create any type of
box needed in your form.

Box Attributes are:

Edges and Corners are
One-half point weight,
solid style, black.
All corners are Inverted Round,
15 point Radius.
Inside Screen is 5% Gray.
Screen Lineage is 100.

Box Attributes are:

Edges and Corners are
2 point weight, solid style, black.
UL and UR corners are Round,
with 30 point Radius.
LL and LR corners are Square.
Inside Screen is 1-15%
Graduated at Angle 270.
Screen Lineage is 80.

Figure 1-32: Box Properties Define the Look of the Box

The Set Box Properties has Edges, Corners, and Inside tabs for basic box
attributes.

Weight – Line Thickness Shown in Current Unit
Style – Line Style Used: Solid, Dashed, Dotted, etc.
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Layer/Start and End Color – 1 - 32 Layers and the Percentage of Color for
Spot Color files or a Four Color Process Number for Process Color.

The Edge and Inside tabs both have a Color choice. The color chip shows you
the current color. It can be accessed by clicking the [Select Color] button.

Figure 1-33: Set Box Edge Properties Dialogs

The Inside Tab

The Box Inside Tab controls the inside screen values of the box. These are
controlled by the following options:

For Spot Color files, the dialog shows you which layer the component is on
and what color the layer represents. Box insides can have two colors applied
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allowing a graduating effect. The Color Chip shows the intensity of the color,
where 0% represents white and 100% represents solid. Sliding the density
selector to the far left will expose the word "None". This will make the inside
of the box transparent.

Screen Type: When asking for a graduation, dots normally produce the effect.
There are a variety of dot shapes which are controlled by the Psdots.ps file
on the originating System. This effect can also be created by lines. The defaults
are dots or lines.

Set Graduation Angle: This lets you type in the angle for the direction of
graduation from the Start Color to the End Color. Think of a compass in which
the origin is the Start Color and the angle represents where the End Color will
land.

Graduation Type: This describes the color variance effect. This is either no
transition (None), transition along an angle (Directional), or transition from
a central point (Radial). When Radial is selected a Radial Center X and Y
starting point can be entered.

Figure 1-34: Modify Box Inside Properties
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Area Attributes Dialog Box
Creating an area requires several basic picks. The area attributes are controlled
by the current setups in the Area Attributes dialog box. This dialog has the
same values as the Line and Box Attributes.

Figure 1-35: Set Areas Properties Dialog Box

Once you have defined the characteristics of the Area you are about to draw,
[Okay] your selections. Select the Area tool and begin by choosing the first
point of your area. Continue picking the outer boundary of the area until you
have completed the Area. End your Area definition by choosing Close Path
from the right-mouse pop-up menu.
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Electronic Field and Form Tools

Figure 1-36: Add E-Form Field / Auto Fields / Field Properties

Both Add Field and AutoField tools allow you to add new electronic form
fields to your form. The Add Field tool creates a field with the location and
dimensions defined by your two picks.

The AutoField tool picks up the size attributes defined by its dialog box and
determined location method, gutters and position of the field. Every time the
AutoField tool is selected the dialog box will appear allowing you to set the
location method, gutters and field dimensions prior to drawing. [Okay] and
you are ready to draw fields.

And don’t forget the Set Field Properties tool, which presets the properties
of the field prior to drawing it. Many times it is helpful to determine the
properties before drawing the field, although it is not necessary, since the Field
Properties dialog box will appear each time a field is drawn.

Figure 1-37: E-Form Preferences/Field List/Set Tabbing Order and Add Required
Fields/Data Table Assists/E-Form Server Preferences

These tools allow you to quickly build an E-Form Project. For more
information on Electronic Field and Form Tools, see the Creating Electronic
Forms manual.
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Pop-Up Menu’s Position Assists
These options are for assisting you in positioning the cursor during drawing
a new component or for moving or copying an existing component.

Hold: The Hold acts as a temporary marker for the purpose of defining a
component’s location for drawing, moving, copying or modifying. Coordinates
can be input through the keyboard; choosing the numeric, unit mnemonic and
an arrow key to define the direction. [Entering] will lock that position.

Using the Hold: Activate the Move tool and select a component. Make a second
pick on the component. This is the position in which you are picking up the
component. Right click and select the Hold function under Position Assists.
Pick the upper-left corner of your page as your hold position. The Hold
character appears as a red square. It represents a temporary marker in which
you can measure from. Input "2i" on the keyboard and then the right arrow
key. Now input "1i " and the down arrow. You will notice the cursor move
with each dimension. The keystrokes will display in the center of the Help
bar at the bottom of the screen as you input them. Once you are finished
inputting the position, [Enter]. The position that you picked on your component
is moved to the keyed position. Hold may be used when drawing new
components and when modifying existing components. [F9] is the shortcut.

Key In Absolute Position: This function will allow you to specify the location
of a component in relationship to the origin of the page. Key in Absolute
Position will allow quick and accurate placement of components.

Using Key in Absolute Position: Select the Line Tool and choose Key In
Absolute Position in the pop-up menu. A dialog box will appear. Input the ’X
Coordinate’ and ’Y Coordinate’ and [Enter].

Key in Relative Position: This function will allow you to specify the location
of a component relative to the current position or first pick (whichever applies).
This is also helpful in defining the dimensions of a component.

Using Key in Relative Position: Select the Line Tool and pick the position for
the first point of the line. Choose Key In Rel. Position in the pop-up menu.
Enter the horizontal and vertical distance from the first pick. Key in the number,
units and direction (arrow keys). [Enter] when the dimensions have been
entered. For example, input ’1i’ and the right arrow key. Then input ’2i’ and
the down arrow key. [Enter].[F12] is the shortcut for Key in Relative Position.

Horizontal/Vertical Only: This refers to the move or copy tools. This is for
elimination of movement in a specific direction. Horizontal Only will only
allow movement in the horizontal direction; while Vertical Only allows
movement in the Vertical direction.

The following components are discussed more in depth in
Position Assists.

Midline: Using Midline allows you to find the midpoint of a line. If moving
a component, select the line to move and then Midline. Midline can be found
either through the pop-up menu or under the Options menu. Make a second
pick on the line and it will pick up the component at the midpoint. [F11].
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Midpoint: This tool is for finding the point that is equidistant from two picks.
This is different from Midline because Midline can only be used to find the
midpoint of a line. Midpoint will take your two picks and find the point that
is exactly half way between any two picks. [ShiftF10]

Align: The Align feature is a simple but powerful option which allows the X
and Y values of a point to be specified separately. It is as if you drew a vertical
construction line through the first point selected, and a horizontal construction
line through the second point and then took the intersection of the horizontal
and vertical construction lines as the final point and placed your object or
cursor to that point. [Shift+F11] is the shortcut.

Intersect: Using intersect establishes a point at the intersection between two
components such as lines and/or circles and arcs. Lines are considered to be
extended to infinity in each direction, and arcs are considered to be complete
circles. If more than one intersection is possible, such as when a line passes
through a circle, the intersection closest to the point picked will be used.
[Shift+F10]

Direction and Distance: This allows you to define the location and dimensions
of Components. Choose the Line tool and make your first pick. Choose
Direction and Distance and input the angle and length of the line. [Okay] will
finish your line.

Component Center: This will find the center of any component, single or
grouped. Simply choose this option and click anywhere on the component in
which you want to find the center of. [Shift+F9]

Set Plumb/To Plumb Position: With a single pick, Set Plumb will place a
temporary vertical line in which you can align components. Once a Plumb
position has been chosen, choose a component to align with your Plumb line;
select the component and then the side to be aligned. This will work with
Grouped Items.

Set Level/To Level Position: With a single pick, Set Level will place a
temporary horizontal line in which you can align components. Once you have
chosen your Level line, choose a component to align with your Level line;
select the component and then the side to be aligned. This will work with
Grouped Items as well.
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Hot Keys for Position Assistant
There are several hot keys that serve as short cuts
to many of the frequently used position assistant
functions.

[F9] Hold

[F10] Intersection

[F11] Midline

[F12] Key in Relative Position

[SHIFT + F9] Component Center

[SHIFT + F10] Midpoint

[SHIFT + F11] Align

[SHIFT + F12] Key in Absolute Position

[CTRL + F9] Repeat Copy

[CTRL + F10] Repeat Move

[CTRL + F11] Divide Box into Rows

[CTRL + F12] Divide Box into Columns

Using Hot Keys
Here is an example of how a hot key might be used.
The exercise will be to use Key in Relative Position
to specify the width and height of a box. Key in
Relative Position allows the user to input the
direction and distance for either drawing or
modifying.

First, choose the Box tool and the position for the
upper-left corner of the box. Next, input the Key
in the Relative Position Hot Key sequence, [F12]
and input "60p" and the right arrow key. Then, input
"40p" and the down arrow key. Finally, [Enter] to
finish.

This has drawn a box that is 60-points wide and
40-points deep, starting from your first pick. 
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Figure 1-38: OneForm Designer Plus Hot Key List
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CHAPTER 2

Tutorial – Drawing A New Form
This tutorial is designed to acquaint you with OneForm Designer Plus. The
following will be covered as we draw the WYWO form:

• Setting Drawing Properties • Modifying Properties

• Setting Grid Properties • Adding a Logo

• Setting Component Properties • Save Finished Form

• Drawing Components • Printing Your Form

Message

Operator

CALLED TO SEE YOU

WANTS TO SEE YOU

PLEASE CALL

WILL CALL AGAIN

URGENT

RETURNED YOUR CALL

To

Date Time

of

Phone
Area Code Number Extension

WHILE YOU WERE OUT

( )

Figure 2-1: Take a Moment to Look at the Sample Form
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Setup New Drawing Properties
The first step in creating a new form is to create a canvas to work on. When
you click the New File tool you are taken into the New Drawing Setup dialog.
Before selecting [Okay], you have an opportunity to type in a file name, form
size, and select a color model.

Figure 2-2: Starting a New Form

We are going to draw a "While You Were Out" message form. Our new name
is wywo.elf and the size is 4 x 5 inches. Keeping the Form Type of Custom
will give you an opportunity to type in the form size.

Our example is drawn as a "Spot Color" color model, so make that selection
in the Color Model drop-down, if it is not already. This affects how the Set
Attribute Dialogs display for choosing colors.

[Okay] confirms your choices and closes this dialog box. You will then see
a page canvas that is 4 x 5 inches. This blank page is ready for you to start
creating components.

The OFDP drawing tools will also become active. Click the Save As icon and
browse for a location to save the wywo.elf file. As you are working, remember
to Save often.
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Turn on a Grid
OneForm has a handy grid option which assists in accurate component
placement. The Grid Properties dialog is found under the Options, Grid
Options menu.

Figure 2-3: The Grid Assists in Accuracy

The Grid Properties dialog allows you to customize your grid spacing. You
may choose [On] or [On/Snap] to turn on the Grid display. [On/Snap] will
not only turn on your grid, but will snap all of your components to it. This is
the option we want to use for our form. Setup the grid with the same 1/16i
spacing as shown in Figure 2-3.

Draw Foundation Ruling First
The easiest way to start a new form is to draw any ruling first as a foundation
for the form using the line and box tools. Creating text and placing it into the
correct position would be next. Adding any other items such as screens or
logos is usually the last step in forms design.

Looking at our form we have many lines, a few boxes, and lots of text. Since
we want to draw the ruling first we will start by learning how to set the
properties for lines and boxes before drawing.
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Set Line and Box Properties

The Set Properties tools gives you an opportunity to setup the style of your
lines and boxes before drawing. Set both of them to 1-point weight. While
you are in the Box Properties, go to the Inside Tab and Select Color. Change
the density to "None" meaning "no color". This will cause only line edges to
appear as you draw your boxes.

Figure 2-4: The Set Properties and Attributes Dialog Boxes
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Draw Boxes and Lines

We are now ready to draw the first box with its 1-point rule while picking on
the grid for positioning. It will be easy to visually space the items by keeping
the same amount of grids between items.

The second box needs a 2-point rule, so go back into the Set Box Properties
tool and set its Edges before drawing.

Figure 2-5: Draw Boxes and Lines Using the Grid

Our lines are 1-point rules and we have previously set the line attribute
properties. Draw the lines by simply picking a start point on the grid, and then
picking the end point.

When drawing form lines, it is helpful to have them locked in drawing straight
across or up and down positions. So toggle on the Lock Eight Directions
tool.

Figure 2-6: Lock in Eight Directions While Drawing Lines

The beginning of the lines can be adjusted later, using a modify pop-up menu
option, Modify End of Line. After placing our text we will then see where the
beginning of the lines need to start. For now, draw all of them same. This
gives us locations for our text.
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Drawing Multiple Lines

The Draw menu holds other drawing options. Under Vector you will find an
option for drawing Prorated Lines. Setup the properties through the dialog.
and then draw your rectangular shape.

Figure 2-7: Draws Equally Spaced Lines

This will give you equally spaced lines with 2 internal horizontal lines and 1
internal vertical line.

Draw your rectangular shape counting the grids as you go. Our example has
9 grids down and 21 across, or close to the middle.

After drawing your lines, use the Select cursor to move the vertical line over
to the right. Hold down the Shift key as you move it horizontally.
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Place Top Text
On the top tool bar, the Set Text Properties tool allows you to setup text
attributes before creating the text. The Text Attributes Readout displays the
current Font Style, Size, and Composition Position.

Figure 2-8: The Set Text Properties Dialog Box

To create text use the Input Text tool. Pick a position (such as the beginning
of the first line) and start typing. The current Text Properties will be applied.
To quit out of text input, toggle off the Text Input tool.

Modify Lines with Select Cursor

You can now modify the lines to the right of the text. Use the Select Tool to
pick and identify the line, then pick the white handle to move, and drag to its
new location.

Figure 2-9: Use the Modify Line Icon or the Modify Line Pop-Up Menu
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Modifying Text Properties
If you happen to forget to set the text properties to the desired attributes before
creating the text, you don’t have to delete it and start over. Instead you can
modify the existing text component’s properties.

All component properties are accessed through a right-mouse pop-up menu.
Use the Select Tool to pick the component first, and then press your right
mouse button.

Shown is the pop-up menu for Text components. Select the Properties Change
option and the Modify Text Properties dialog will appear.

Figure 2-10: Getting to the Modify Properties Dialog

If you have not saved your file yet, take the time to save the file.
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Place Text in Boxes
This option allows you to place multiple text pieces, within rectangular shapes,
easily.

Start by setting your Text Properties to 6-point. Then locate Draw’s Text option
Place Text in Boxes.

After selecting Okay for the gutters and composition modes (as shown), it will
prompt you to draw a dynamic rectangle. It uses this rectangle to provide the
region in which it looks for box shapes. The positions will be portrayed by
red lines.

Select Start Inputting Text from the right-mouse pop-up menu and type in the
text, and press [Tab]. The cursor will move to the second location. Type in
each piece of text and [Tab] to finish.

Figure 2-11: The Red Diagonal Line Indicates a Text Position
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Add a Logo
A scanned logo can be brought into your form through the Add Logo tool.
Pick where the top of the logo will fall. This will bring up the Raster Image
dialog so you can locate the image file (GIF, JPEG, BMP, etc.) you wish to
include. Once it is brought into your drawing, it can be moved, copied, and
scaled.

Figure 2-12: Add a Logo to Give it a Custom Finish

Note: Image file color modes compatible with OFDP are Bitmap, Grayscale,
and RGB.

Now that you have the artwork of the form finished, please Save, Print, and
proof.

Our next step will be adding the electronic fill fields. Since we will be
referencing our drawn lines, you can now turn off the grid: Options, Grid
Options, Grid Properties.
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Save Finished Form
As you can see we now have a finished form.

Figure 2-13: Use the Save Icon to Quickly Save any Changes

Save your file often by using the Save File tool.
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Printing Your Form
When you select Print you will be printing through Windows Print Manager.
This is actually a print screen of the form in the window.

Figure 2-14 Windows Print Dialog

It is recommended that you create PDF files for digital printing instead, by
using our PDF Generator Module and Save As PDF option. For more
information, see Chapter 12: PDF Files for Digital Printers in the PDF
Generator Module reference manual.
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CHAPTER 3

Tutorial – Designing a Form with Boxes

The generally accepted definition of a form is a piece of paper containing
pre-printed data that also has spaces for the entry of additional information
after the form is printed. The fact that the additional information will be entered
at a later time determines that the document is a form.

Forms composition is different because spacing can be critical. A form that
looks nice but not spaced properly is a disaster. Forms are printed to become
clerical tools. After printing, the blank spaces are filled in by hand, machine,
typewriters, computers, or other methods. They are filled in, decollated, rubber
stamped, mailed, stapled, read, filed and processed in a variety of ways.
Spacing plays a major role in forms creation if the form is to function properly.
Learning to place items in the proper spacing becomes a major role in forms
composition.
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PREFIX DESCRIPTION BAS
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M019

This is not a form as there are no fill in blanks.
Spacing accuracy of rules is not a consideration.

This is definitely a form since data is to be placed
inside the rules after printing.

Figure 3-1: A Pricelist and a Form

Spacing on Forms

Business printers and scanners that fill-in or read forms move horizontally and
vertically in increments of inches. Therefore, forms must be drawn using inches
as the measurement scale. Using whole picas or points is not the same. See
Figure 3-2.

They are quite close but there is a difference and that difference accumulates
as you work your way down the form. Accuracy on a continuous form is vital.
As you can see, after a distance of eight inches, there is a spacing difference
of approximately four points, which is more than enough to create difficulties.
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Spacing difference

12-point spacing1/6-inch form spacing

8-inch depth

Figure 3-2: Spacing Differences Between Inches and Points

Almost all business machines space down six lines to the inch. Single spacing
is one-sixth of an inch (1/6"), double spacing is one-third of an inch (1/3"),
and triple spacing is one-half inch (1/2"). From left to right the standard is to
print and scan ten (10) characters to the inch or a tighter look of twelve (12)
characters to the inch.
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Open a New Form Drawing Template
Start out by selecting the [Open File] tool and going to the templates located
at C:/Program Files/Amgraf/OneForm/Templates/Continuous and selecting a
template size of 9.5x7. This drawing is in Spot Color mode and will give us
a page size of 9.5" x 7". Use Save As, Save All Components to save into a
new location so as not to draw on the original template file.

Turn on Grid Spacing
Setting up a grid will insure accurate picks and spacing. It causes the cursor
to pick grid locations when you are drawing. The grid has a default of 1/20"
and 1/12" which is the most commonly used measurements in business
composition. Let’s keep the default spacing and turn the grid snap on: Options
Menu, Grid Properties, Grid On/Snap.

The screen would display 20 lines across and 12 lines down each inch. This
makes it very busy. So adjust the grid display to show every other grid point
just by changing the "Minor Division Count". Type in a 2 and [Okay].

All of your picks will go exactly in between grids or to grid points. This allows
you to have control over print positions.

Figure 3-3: Set Grid Spacing for Form
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Getting Ready for Drawing
We are going to draw the following form. It has three types of boxes,
graduations, lines, and text. All of which are spaced correctly in inches.

CUSTOMER NO. CUST. ORDER NO. DATE ORDERED DATE SHIPPED SHIP VIA REPRESENTATIVE

ORDERED SHIPPED PROD. NO. DESCRIPTION UNIT PRICE AMOUNT

Figure 3-4: An Invoice Form to Draw

There are several functions which we are going to use in our exercise that is
specifically designed for the Business Form world. They are:

Units
Grid Toggle,
Draw Box, and
Place Text in Boxes

What we are attempting to do with this exercise is to explain how to approach
a form and combine all of the capabilities of these functions into producing a
finished product.

Setting the Units of Measure
Since we have spent so much time discussing the importance of spacing, make
sure you are in inches. If your system is not setup as inches, then pick the
following: Options Menu, Drawing Options, Units, Inches.

Insuring Accurate Spacing
Make sure you can see your grid. If not go back to the instructions on the
previous page.

Check to make sure that the Grid Tool is ON. We want all boxes and lines
to be drawn on grid locations.

Also, toggle the Component Snap Tool OFF. We want all boxes and lines
to be placed only on grids, and to ignore existing components as we draw.
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Drawing Boxes
In this exercise we are drawing the form with boxes. The inside fills are
incorporated in a box, and the size can always be modified later.

Before drawing, setup the box attributes using the Set Box Properties Tool.
The box edges will be drawn as .5-point Solid lines, so the Edges Tab will
look like the following:

Figure 3-5: Box Edges and Lines are .5-Point Weight

Now, look at the form in your mind’s eye, see that it is made up of three
different types of boxes. The first being the top empty box with two rounded
top corners. Secondly, we have a black box which holds our white lines and
reverse type. Third is the entire graduated box.

Figure 3-6: Three Separate Boxes
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Empty Box with Rounded Corners
Before drawing, setup the box corners. Go directly to the Corners Tab and
make the changes shown below:

We are rounding only the two top corners, so turn off the checkbox for
making all four corners the same. Select Round and give them a radius of
1/6 of an inch. You can type in fractions if you don’t know the decimal
equivalent. It will convert it automatically.

Figure 3-7: Setup the Corners and Insides

Next, go to the Inside Tab. Change the white screen to be empty. You do
this by clicking the [Select Color] button to open the Spot Color dialog.
Move the density slider to the left until "None" appears. Click [Okay] to
save. This will change the Color Start Layer Density to "-1".

Go to the Draw Box tool and snap the first corner onto the inch grid marker
that represents 1 inch from the top corner. The next pick will be 2 1/2 visible
grid lines down and at the 8.5 inch mark over. This will make our box 7.5
inches wide and have a row of print positions in the middle.
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Black Box with Square Corners
Go back into the Set Box Properties tool to make the following attribute
changes. Here we are getting rid of the rounded corners and putting in a black
inside fill on Layer 1.

Check the Box for "All
the Same". Then, set
one of the Corners
Back to Square.

On the Inside Tab,
[Select Color]. Then,
for Layer 1, slide the
Color Density to 100%.

Figure 3-8: Setting the Inside to Black

Go into the [Select Color] dialog to designate the Color Density by sliding
the bar to 100%. Click [Okay]

Draw the box connecting it at the bottom corner of the first one and making
it 2 1/2 visible grid lines deep and aligning right edge of the first box. Your
box has four square corners and is solid Black.
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Graduated Box
Again, we need to Set Box Properties. Go to the Inside Tab. The Graduation
Type needs to be Directional with the Graduation Angle at 90-degrees. Next
is the Color Start and End Densities. Just type in the percentages. The fill
starts out lighter with a 5-percent screen, going to a darker screen of 30-percent.
Just type in the percentages. Click [Okay].

Looking at the graduated piece the graduation travels up. Think of it as the
Start Color in the center of the directional compass. The End Color is at the
end of the direction requested.
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▼

▼

▼

▼

▼

▼

START COLOR

END C
OLOR END COLOR

END COLOREND C
OLOR

90

270

315

0

45

225

180

135

30° END

5° START

90° ANGLE

Figure 3-9: Graduation Type, Angle, and Layer Color Densities

Now pick the two diagonal corners that make up the entire bottom piece. The
first pick is connected to the previous box. The depth of our box is on the 5
inch grid marker. The width should be 7.5 inches, so pick on the grid that
aligns with the other box edges.
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Dividing the Boxes into Individual Columns
Boxes are different than rectangles in the sense that they can be broken into
smaller box segments. We are going to divide the top box into columns instead
of drawing lines. At this time where you divide it is not really important for
this exercise, just divide it five times, similar to Figure 3-4. You can pick on
each major inch grid marker, or make them unequal like our sample.

To divide the top box into columns, you would first pick the top box with
the select tool, and then press the right mouse button to get to the Modify
Box pop-up menu. Choose Divide Box into Columns and then pick on the
grid line where the box should split. Notice that you now have two boxes
side by side.

Figure 3-10: Divide the Top Box

Now, select the right-most box of the two and go through the steps again.
Press the right mouse button to get to the Modify Box pop-up menu. Choose
Divide Box into Columns and then pick on the next position within the box.
Do this three more times to create the box segments.

On the large bottom box, divide it using our hotkey. The hotkey to Divide
Box into Columns is [Ctrl]+[F12]. You Again let’s not measure and just
visually pick the locations. Select the bottom box and notice the handles
appear. Now press [Ctrl] and the [F12] simultaneously and you will see the
prompt Pick Point to Divide Box Cols. Pick the grid line where the box is
being cut. Do this four more times to create the box segments.
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Drawing White Lines
The black filled box has white lines drawn over it. These lines are drawn
because there is no way to draw a box that has only one side white, while all
other sides are drawn in black.

Figure 3-11: Draw in the White Lines in Same Positions

Set the color of the lines to white by going to the Set Line Properties tool,
[Select Color]. Slide the layer color to 0 density (white).

Figure 3-12: Set Lines to White

Draw the lines in the same positions as you divided the bottom box.
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Changing Angle of Graduation
Every other graduated box is graduating at an opposite direction. This is easy
to accomplish by changing the direction of the Graduation Angle found in Box
Properties Inside Tab. Since we have divided our boxes into six separate box
components, we can now change the angle of three of them to 270 degrees
causing the End Color to travel downward.

Getting to the Box Properties dialog is accomplished by using your Select tool
to pick the box to modify and pressing the right mouse button to access
that component’s properties through Box Properties.

Figure 3-13: Change the Angle on Three Boxes

Go directly to the Inside Tab and change the angle to 270 degrees. Select
[Okay] and notice the graduation is now traveling downward.
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Text Placement

Since our text on this form is within rectangular shapes, the option of Place
Text in Boxes will work best. It was designed to assist in the placement and
input of text into pre-drawn boxes usually found in business forms.

Set Text Properties

On the tool bar you will find the Set Text Properties tool. This allows you
to setup the text attributes before creating the text. For the top row of text we
want Arial, 6-point.

CUSTOMER NO. CUST. ORDER NO. DATE ORDERED DATE SHIPPED SHIP VIA REPRESENTATIVE

Figure 3-14: Example of the Text to be Input

Figure 3-15: Set Text Properties Dialog Box

Using Place Text in Boxes

Place Text in Boxes is found under Draw, Text menu. The box shapes can
be drawn with Lines, Rectangles or Boxes. The system is looking for four
sides to determine the box for placement.

The Place Text in Boxes option has gutters and composition mode selections
for placement within the box. Set the Gutters as shown below, and the
Horizontal Mode to Flush Left, and the Vertical Mode to Flush Top.
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Figure 3-16: The Place Text in Boxes Dialog Box

Select [Okay] and immediately pick around the top row of boxes. This is
similar to the "zoom" function when using a dynamic rectangle to determine
the area. When picking the top row, pick on the outside of the lines as shown
in Figure 3-17.

Figure 3-17: Pick Two Corners Surrounding the Row of Boxes

The boxes selected for text will appear red with a diagonal line drawn through
each one. Right click and choose Start Inputting Text. The input cursor will
appear in the first box ready for you to start typing. The Tab Key will move
you to the next box. When you have finished inputting text in the last box,
remember to Tab before clicking off the Input Text tool.
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As you can see, Place Text in Boxes is faster and definitely more efficient
than the Input Text tool. The positioning is done without you having to hold
position or move the text.

Creating the Second Row of Text

Repeat the same steps for the second row of text. First, Set Text Properties
and make your attributes 8-point, Arial Bold, and the layer color density to
0. This will make the text white like we made our lines white. For the Place
Text in Boxes options, set the Composition Modes to Center, Center, and 0
gutters.

ORDERED SHIPPED PROD. NO. DESCRIPTION UNIT PRICE AMOUNT

Figure 3-18: The Second Row of Text is White

Saving and Printing

The form is complete. Save the form by clicking on your Save Tool and print
with the Print Tool or the recommended Save as PDF.
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Figure 3-19: Save and Print the Finished Form
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CHAPTER 4

Setting Drawing Component Properties
Setting your drawing component attributes is an important element in obtaining
the final effect. It is most efficient to set the properties before drawing the
component. For example, set the Box Properties first and then draw a box, all
boxes drawn will contain those properties. To modify the properties of an
existing component, choose the component with the Select Cursor and
right-click to obtain that component’s properties. The Modify Properties dialog
for that component will appear. Any changes made here will only affect the
current component selected.

Set Line Properties

Set Box Properties

Set Area Properties

Set Text Properties

Figure 4-1: The Four Drawing Component Properties Tools

These four set properties tools are on the Tool Bar and are signified by a
rainbow chip at the top of the button. Clicking on a Properties tool will bring
up its dialog. A Set Properties dialog gives you the ability to set (or describe)
the properties of a new component before it is created. Note: Fielding tools
are described in the Creating E-Forms manual.

The Line Properties Dialog Box
Choosing the Line Properties tool on the Tool Bar will take you to the Set
Line Properties Dialog. This dialog controls the attributes for the Draw Line,
Circle, Spline and Rectangle tools.

The following are options on the Line Properties Dialog:

Weight – Line Weight Shown in Current Unit
Style – Line Style Used: Solid, Dashed, Dotted, etc. 
Layer – 1 through 32. 
Color – This section is controlled by the Color Model of Drawing Properties.

If it is "Process Color", it will have "FCP Number" (Four Color
Process).
If it is "Spot Color", it will have "Layer/Density".
In both cases, click [Select Color] Button to set the color.

Screen Type – Dot or Line Screen
Screen Lineage – Lineage Value
Screen Angle – Angle or Auto (system default)
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Figure 4-2: Line Properties Dialog for Process Color Model

Figure 4-3: Dialog Change for Spot Color Model

Setting the Line Weight
By typing a value in the Line Properties "Weight" field, you can vary the
thickness of your lines. If you’d prefer a different line weight from the default
value, type a value in the weight field with its corresponding unit of
measurement.

For example, you could enter 2.5p for a 2.5-point line. The practical upper
limit seems to be 500-points (5000 decipoints), though you’re unlikely to ever
need a line that thick. The practical lower limit is 0.1-point (1 decipoint). This
is because most output devices can’t manufacture a line thinner than one
decipoint. It is also possible to use a 0 weight invisible line that will display
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on the monitor, but will not appear on the final printed page. This is common
for construction lines.

0.5 pts

1.0 pts

1.5 pts

2.0 pts

2.5 pts

3.0 pts

10 pts

Figure 4-4: Setting the Line Weight

All values typed into the weight field will automatically be converted into
your current unit of measurement. For example, a 1p value would convert into
0.014 inches when inches is your current unit of measurement.

Valid Units of Measurement:

i = Inches c = Centimeters a = Picas
p = Points m = Millimeters
d = Decipoints t = Mils

Setting the Line Style
There are four different line styles available: Solid, Solid-Sq, Dotted, and
Dashed. Choosing Solid will draw a continuous unbroken rule of the specified
weight. Solid-Sq (Solid-Square) affects lines that are used to makeup corners.
Squared ends extend half of the line weight on each end to meet and fill-in
the notched corners. Dotted will create a line with a dotted pattern. Dashed
will create a line containing a dashed pattern.

Dotted

Dashed

Solid Square Ends

Solid

Figure 4-5: Setting the Line Style

In some cases, the line style may not be one of the common selections but
one which was designed by the composer. If this is the case, choose the User
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Lines Style as the Line Style. The properties of the User Defined Line Style
can be viewed under the User Line Style tab. More information on User Line
Styles can be found in Chapter 5.

Set Layer/Color and Screening Attributes

Clicking the Color [Select Color] button will bring up one of the following
two dialogs. Which dialog it displays is according to the file’s designated
"Color Model" found in the Drawing Properties: Process Color or Spot Color.

Process Color is based on the use of a four color press, and uses the colors
of Cyan, Magenta, Yellow, and Black. The layer has no affect on the color
because the separations are always CYMK. Color is controlled by the "Four
Color Process (FCP) Number" assigned.

Spot Color refers to a single run ink color in offset printing. Spot color is any
color generated by an ink (pure or mixed) that is printed through a single run.
The artwork is designating "Spots" for color a be applied. OneForm controls
spot colors through "Layers", by assigning colors to layers through the Drawing
Properties. Once a color is selected a Density can be applied to the Spot color.

Figure 4-6: Clicking [Select Color] Opens the Set (Process or Spot) Color Dialog

As you can see the dialogs are different. The main difference is that each layer
is pre-defined a color within the Drawing Properties for Spot Color files, and
that the spot color can have a density.



Chapter 4: Setting Drawing Component Properties

Setting Color Properties (All Components)

67

Screen Type: Dots normally produce the varying color percentages. This effect
can also be created by lines.

Set Screen Lineage: The value reflects the number of dots in a row within
the screen and is measured in linear inches. The proper screen lineage is
normally determined by what type of output device the artwork is output on
and also the press that is printing the job. This is also referred to as "screen
gauge" or "screen ruling."

The default value is 133. This is correct for high resolution imagesetters but
when sending to a proof printer it is automatically adjusted upon output. For
final artwork on low resolution printers the values between 40 and 60 are
better. If lineage is set too high for the device, the screens will appear to be
darker than they should.

Screen Angle: The dot angle assigned to a separation color determines the
direction that a row of dots will travel to create a screen. This also controls
the direction of lines when the Screen Type is "Line". When the screen angle
reports "Auto" the angle is determined from the "FCPANGLE" file. Defaults
for Spot color printing is "45 degrees". Defaults for Process color is "cyan
105 degrees", "magenta 75 degrees", "yellow 90 degrees", and "black 45
degrees".

Setting Process Color Attributes

Layer: The layer attribute is a number (0-32) assigned to the component and
is used for viewing only. The Options, Set Layers On/Off controls the viewing
of the components where you can hide components just by turning off their
layer number. The layer has no affect on the color with Process Color files.
Here a layer can hold components of many colors and it will print as long as
the layer is turned on.

FCP Number: This is a Four Color Process (FCP) number based on the use
of the four colors of Cyan, Magenta, Yellow, and Black. OneForm’s FCP
Color numbers 600 through 700 represent White to 100% Black. The other
FCP color numbers in the list represent standard industry ink color numbers,
for example 289 is a Dark Blue and 300 is a cyan Blue.

Some basic OneForm FCP Color Numbers:
1 through 7 = OneForm’s Primary Colors
600 = White
610 = 10% Black
650 = 50% Black
700 = 100% Black

When you type in your FCP Color Number (or select from the list), then
pressing [Tab] will display the new color chip and show the CYMK values
which make up that color.
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Figure 4-7: Select Color’s Process Color Dialog

See Chapter 8: Working with Color for more information.

Setting Spot Color Attributes
Layer/Color (Spot): This shows you which layer the component is on and
what color the layer represents. There are 32 layers possible on your form.
The Color Chip shows the intensity of the color. It’s density can be accessed
once you click [Select Color] button. The density values range from 0% to
100%, where 0% represents white and 100% represents solid.

[Select Color] - By default,
the spot color attributes
dialog holds 32 layers,
each with a different color.

To draw a Blue line, select
layer 4.

Figure 4-8: Choose a Pre-Defined Layer Color Chip
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Click on the desired layer color you wish to use, and then choose the [Okay]
button. Choosing the [Cancel] button will close the color palette and return
you to the previous dialog box without changing the layer color.

Density: To control the visual and printable screening percentage of the
component, you can type in a value or move the density’s slider control to the
left and right. Moving the slider control to the left will lighten the line and to
the right will darken the line. The value of screening percentage will be shown
in the field above the slider control. By picking the slide bar on the opposite
end of the slide indicator, you can change the screening percentage in 10%
increments. Your arrow keys will change the density in 1% increments. The
density values are from 0% to 100%. Where 0% represents white and 100%
represents solid.

See Chapter 8: Working with Color for more information.

Modifying Attributes of Existing Lines
To make corrections to the attributes of existing drawn lines, you will need
to choose the Select Cursor tool from the toolbar. Then, pick on the line and
choose the Vector Properties in the pop-up menu. You will be taken into the
Modify Line Properties. Make the necessary changes to the values and then
[Okay]. You will immediately see the change has taken place. Repeat this
process for each line that needs changed. Groups of lines can be changed in
one instance.

Figure 4-9: Vector Properties is in the Pop-Up Menu
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Set Box Properties

Figure 4-10: Use the Box Properties to Set Box Attributes

Choosing the Box Properties tool will take you to the Set Box Properties
Dialog shown in Figure 4-12. This is where you set the values for the Draw
Box tool. Box components have several tabs, each controlling different aspects
of the box attributes. We will describe each tab in detail.

Box Attributes are:

Edges and Corners are
One-half point weight,
solid style, black.
All corners are Inverted Round,
15 point Radius.
Inside Screen is 5% Gray.
Screen Lineage is 100.

Box Attributes are:

Edges and Corners are
2 point weight, solid style, black.
UL and UR corners are Round,
with 30 point Radius.
LL and LR corners are Square.
Inside Screen is 1-15%
Graduated at Angle 270.
Screen Lineage is 80.

Box Attributes are:

Corners are 3 point weight, solid
style, black. Edges are zero
(invisible) weight. All corners are
Square with a 20 point length, this
is input as radius. None for Inside
Screen Density.

Box Attributes are:

Edges and Corners are One
point weight, Dash style, black.
All corners are Round, 20
point radius. Inside Screen is
15% and Screen Lineage is
100.

Figure 4-11: Box Attributes Define the Look of the Box

Box Edges Tab
The following are options of the Edges Tab:

Bottom Weight – Line Weight Shown in Current Unit 
Right Weight – Line Weight Shown in Current Unit 
Top Weight – Line Weight Shown in Current Unit 
Left Weight – Line Weight Shown in Current Unit 
Style – Line Style Used: Solid, Dashed, Dotted 
Position of Each Edge – Inside, Centered, or Outside 
Layer – 1 through 32. Click [Select Color] Button
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Color – FCP Color Number or Percentage of Color. Click [Select Color] Button
Screen Type – Dot or Line Screen 
Screen Lineage – Dot or Line Screen 
Screen Angle – Angle or Auto (system default) 
Inside Bars – None, Odd, Even, or Both 
Panto Number – Number that corresponds to the Pantograph 
Border Number – Number that corresponds to the Border 

Figure 4-12: Box Edges Tab

Line Weight and Style are common among lines and boxes. It is discussed in
Set Line Attributes.

Position: Edges Position is the location of your line in relationship to the
dimensions of the box.

Line Weight
Outside

of the Grid

Line Weight
Centered

on the Grid

Line Weight
Inside

of the Grid

Figure 4-13: Edges Position
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The Position drop-down list has three choices available Outside, Centered, and
Inside. These choices control how the specified line weight will be positioned
in relationship to the dimensions of the box when drawn.

If Inside is selected, then all of the line weight specified will be inside of the
dimensions of the box. This means that when measuring width and depth of
the box, you need to measure from outer edge to outer edge of the sides.

Centered will center the specified line weight on the edge of the boxes
dimensions. Meaning that one-half of the line weight stays within the box and
the other half will be outside of the box dimensions.

The Outside choice will place all of the specified line weight outside of the
dimensions of the box. This will mean that when measuring dimensions of the
box you must measure from inside edge to inside edge of the line weight to
get the boxes proper width and depth.

The Layer, Color, and Screen Properties are very similar to Line’s Properties
and are described on page 66. The Boxes Edge and Corner Tab share the same
Set Color Properties dialog.

Since the Edges Tab is the first one seen when Box Attributes opens, it reports
the following:

Bars: This refers to the type of bars displayed.

Panto Number: This is the number that corresponds to the pantograph in the
library.

Border Number: This is the number that corresponds to the border in the
library.

Box Corner Tab
The following are options of the Corners Tab:

Lower Left Type – Square, Rounded, or Inverted 
Lower Right Type – Square, Rounded, or Inverted 
Upper Right Type – Square, Rounded, or Inverted 
Upper Left Type – Square, Rounded, or Inverted 
Radius of Each – Shown in Current Unit 
Style – Line Style Used: Solid, Dashed, Dotted, etc. 
Weight – Line weight shown in Current Unit 
Layer – 1 through 32. Click [Select Color] Button
Color – FCP Color Number or Percentage of Color. Click [Select Color] Button
Screen – Dot or Line Screen 
Screen Angle – Angle or Auto (system default) 

Corner Style: There are three styles of corners available on your box: Squared,
Rounded or Inverted. This will apply that style of corner to all 4 corners of
the drawn box, unless you turn off All the Same. If you do not want all of the
corners to be the same, unselect All the Same and you will then be able to
input different characteristic for each corner.
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Figure 4-14: Box Corners Tab

Radius: If Rounded is selected as the Corner type, you must also input a value
in the Radius field to indicate the size of rounded corner needed. This also
controls the length of corners, when Print Corners Only is selected.

Weight: This controls the weight of the corner lines and is only enabled when
Corners Print Only is checked.

Corners Print Only: This will print only the corners of the box. When this
is checked, the radius will represent the length of the corners to be printed.
See Figure 4-11 for an example.

Box Attributes are:

Top and Bottom Edges are 3 point Weight,
Solid, Black. Left and Right Edges are
zero (invisible) Weight. All Corners are
Round with a 10 point Radius. No Inside
Screen.

Box Attributes are:

Top and Bottom Edges are 6 point Weight,
Solid, Black. Left and Right Edges are 2
point Weight, Solid, Black. All Corners are
Round with a 20 point Radius. No Inside
Screen

Figure 4-15: Creating Tapered Corners
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Box Inside Tab

The following are options of the Inside Tab:

Inside Bars – None, Odd, Even, or Both 
Layer – 1 through 32. Click [Select Color] Button
Color – FCP Color Number or Percentage of Color. Click [Select Color] Button
Screen Type – Dot or Line Screen 
Screen Lineage – Lineage Value 
Screen Angle – Angle or Auto (system default) 
Graduation Angle – 0 through 360 degrees 
Graduation Progression – Linear, Logarithmic, Reverse Logarithmic 
Graduation Type – None, Directional, Radial 
Radial Center X and Y – Starting Coordinates of the Graduation 

With Boxes, you have separate controls for the Inside. This allows you to add
a solid color fill, graduated color fill or bars to the interior of any drawn box.

Figure 4-16: Box Inside Tab

Bars: You may choose bars to be displayed. If bars are chosen, the bar’s
attributes may be specified within Even/Odd Bars. Choices include: None,
Even, Odd, or Both.

The Layer, Color, and Screen Properties are similar to the Line Properties
and are discussed on page 66. The only difference is that Box Insides have
both a Color Start and Color End, and can have a transparent value. For Spot
Color models this is "None", and for Process Color models this is the FCP
Color Number "-1". See examples shown in Figure 4-17.
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Box Graduations

Boxes have the ability to produce graduated screens. When the Starting and
Ending Densities are not the same, a graduated screen is produced. This section
refers to the properties of the screen.

Box Attributes are:
Color Start is 10% and Color End is
50% with a Graduation Angle of 90.

Box Attributes are:
Color Start is 10% and Color End is
50% with a Graduation Angle of 270.

Figure 4-17: Screens Graduate When the Start and End Color are Different

The Grad Angle is the direction the graduated screen transitions from start
to end. 0° will place the ending density on the right side of your box, 90° will
place the ending density on the top of the box, 180° will put the ending density
on the left side, and 270° will place the ending density on the bottom.

START COLOR 0

90

180

270

45135

225 315

END COLOR

END C
OLOR

END COLOR

END C
OLOR

Figure 4-18: Direction Compass for Graduated Screens

Graduation Progression: A graduation area can be either a Linear,
Logarithmic, or Reverse Logarithmic type graduation. Each type of graduation
creates a different effect. In simple terms a Linear graduation splits the span
of color into equal steps, where a Logarithmic graduation does not span equally.
It has more of the starting values span through the area where a Reverse
Logarithmic is the complete opposite with more ending values spanning
through the area.



Set Box Properties

76 OFDP Business Forms Composition – Ver 8.0

Linear (Default) Logarithmic Reverse Logarithmic

Figure 4-19: Each Progression Type Spans the Color Differently

Graduation Type: This describes the color variance effect. This is either no
transition (None), transition along an angle (Directional), or transition from
a central point (Radial). When Radial is selected a Radial Center X and Y
starting point can be entered.

Y + (Positive)

Y - (Negative)

X + (Positive)X - (Negative)

Default
Center Position
X = 0i, Y = 0i

Radial Graduation Setups:

Inside Start Color = 605
Inside End Color = 640
Inside Grad Angle = 0
Radial Grad = Y
Radial Grad Center: X = 0 / Y = 0

Radial Graduation Setups:

Inside Start Color = 640
Inside End Color = 605
Inside Grad Angle = 0
Radial Grad = Y
Radial Grad Center: X = 0 / Y = 0

Radial Graduation Setups:

Inside Start Color = 605
Inside End Color = 640
Inside Grad Angle = 0
Radial Grad = Y
Radial Grad Center: X = -1i / Y = .5i

Figure 4-20: Changing the Radial Center Gives a Different Effect
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Box Even/Odd Bars Tab

The Even/Odd Bars Tab describes the type of bars drawn within the box.

Spacing – Width of Bars 
Horizontal/Vertical – Direction of Bars 
Even/Odd Layer – 1 through 32. Click [Select Color] Button
Even/Odd Color Start and End – Color is under the [Select Color] Button
Even/Odd Graduation Angle – 0 through 360 degrees 
Even/Odd Graduation Progression – Linear, Logarithmic, Reverse
Logarithmic 
Screen Type – Dot or Line Screen 
Screen Lineage – Lineage Value 
Screen Angle – Angle or Auto (system default) 

In many situations, it is desirable to have rows or columns within a business
form identified with a screen tint. The first bar drawn has the odd bar properties
and the second bar drawn has the even bar properties. The characteristics of
these bars are displayed in their respective areas.

Even Bars are not printed
Odd Bars Start Color is 605
End Color is 605
Grad Angle is 0
Layer is 1
Screen Lineage is 100
Bar Spacing is 1 / 6 inch
Odd Bars are Drawn
Bar Direction is H

Bar Attributes are:

Both Odd and Even Bars
Start Color is 610
End Color is 630
Grad Angle is 90
Layer is 1
Screen Lineage is 100
Bar Spacing is 1 / 3 inch
Both Bars are Drawn
Bar Direction is H

Bar Attributes are:

Figure 4-21: Bar Designs are Common Among Forms

To add shaded bars to a box, make all the "Inside" color values None. Input
which bars are to be used under the Input tab and specify the desired tint
values through the Even/Odd Bars tab. These commands will create equally
spaced bars inside a large box.

The Bar Spacing controls the thickness of each bar, and is always a whole
fraction, such as "1/6i". Decimals will be converted to fractions.

Horizontal and Vertical refer to the direction of the bars.
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The Layer, Color, and Screen Properties of both Odd and Even bars can be
determined in their respective areas. These properties are the same as Line
Properties and are discussed on page 66.

Figure 4-22: Even/Odd Bars Tab

Box Borders Tab

The Border Tab displays the following information:

Border Number – Library Number 
Point Size – Shows Point Size 
Dimension – Width of Border Character 
Background/Foreground Layer – 1 through 32. Click [Select Color].
Background/Foreground Color – FCP Color Number or Percentage of Color.
Click [Select Color].
Screen Type – Dot or Line Screen 
Screen Lineage – Lineage Value 
Screen Angle – Angle or Auto (system default) 

Borders are decorative designs used to surround a rectangular area. They are
fonts in the sense that controlling the size is through point size. The corners
are the point size and the vertical sides scale vertically to meet the corners
and the horizontal sides scale horizontally.
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Figure 4-23: Box Border Tab

There is a large library of stock borders to choose from. These can be accessed
in the box properties dialog box. Although the library contains many basic
border designs, OneForm allows you to manipulate these designs in such a
variety of ways that the end result is unlimited. Just reversing the color or
changing the point size, creates different effects. A display of all borders
available can be found in Chapter 11: Borders and Pantographs Library or by
clicking the [Show Library] button.

Border Number: The number that appears in this box is the number that
corresponds to the Border Style in the Border Library. OneForm has a stock
library of Borders which can be seen under the "Show Library" Button.

Point Size: This is the point size of the border. All borders are automatically
adjusted to fit around a box by slightly scaling the individual border font
characters. They are fonts in the sense that controlling the size is through point
size. The corners are the point size entered and the vertical sides scale vertically
to meet the corners and the horizontal sides scale horizontally.

The border menu will default to 10-point. If you are trying to match our printed
samples, we have designated the point size we specified on our library pages
with each border.
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Creating Different Border Looks From One Design

Below is an example of the wide variety of graphic effects which can be
accomplished just by changing the point size and color density.
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Default
Background Color 100%

Foreground Color 0%
Point Size 10P

Swapping the Colors
Background Color 0%

Foreground Color 100%
Point Size 10P
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Increasing the Size
of the Border

Point Size 15P

Increasing the Size
of the Border

Point Size 15P
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Screening
Background Only

Background Color 40%
Foreground Color 0%

Point Size 18P

Screening
Foreground Only

Background Color 0%
Foreground Color 40%

Point Size 18P

Color in Both
Background Color 100%
Foreground Color 40%

Point Size 18P

Color in Both
Background Color 40%
Foreground Color 100%

Point Size 18P

Figure 4-24: The Many Designs of Border #026
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Dimension: This is the width the border character will print.

The Layer, Color, and Screen Properties are common among all attributes
and are discussed on page 66.

Assigning Background and Foreground Colors allow you to put white on
black or black on white, with their respective layers. All borders are created
with two characters: a background character and a foreground character.
Swapping colors of these characters usually makes a completely different look.
That is why our library shows the border and its reverse image.

Box Pantograph Tab
The Pantograph Tab displays the following information:

Panto Number – Library Number 
Point Size – Shows Point Size 
Background/Foreground Layer – 1 through 32. Click [Select Color].
Background/Foreground Color – FCP Color Number or Percentage of Color.
Click [Select Color].
Rotation – Angle of Design 
Adjust Pattern to Fit – Y
Screen Type – Dot or Line Screen 
Screen Lineage – Lineage Value 
Screen Angle – Angle or Auto (system default)

Figure 4-25: Box Pantograph Tab
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Various Pantograph Looks From the Same Design

A Pantograph is a printed pattern creating a general background tone. They
are used most frequently on checks and similar documents to produce an
attractive hard-to-copy background.
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����������Pantograph #003

100% Panto Background 0%
0% Inside Color Start 100%

Default Point Size 10P

Screening Both the
Background and Insides

30% Panto Background 10%
10% Inside Color Start 30%

Decreasing Size of Design
by Changing the Point Size

in the Panto Menu.
Point Size 7P

Graduating the Inside
10% Panto Background 10%
30% Inside Color Start 30%
80% Inside Color End 80%

Increasing Point Size and
Rotating the Pantograph

90 Degrees in Panto Menu.
Point Size 12.5P

Swapping Around the Colors
10% Panto Background 10%
80% Inside Color Start 80%
30% Inside Color End 30%

Screening the Design by
Changing 100% Color to 40%

40% Panto Background 0%
0% Inside Color Start 40%

Black Design on
White Insides

White Design on
Black Insides

Directional Radial

Directional Radial
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Increasing Point Size and
Rotating the Pantograph

180 Degrees in Panto Menu.
Point Size 15P

Figure 4-26: The Many Designs of a Type A Pantograph
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Using a pantograph is as easy as picking a design out of the library and putting
in the number, point size and colors. A display of all pantographs available
can be found in Chapter 11: Borders and Pantographs Library or by clicking
the [Show Library] button.

Pantograph Style: This is the number that corresponds to the Pantograph
style. OneForm has a stock library of Pantographs which can be seen under
the "Show Library" Button.

The Layer, Color, and Screen Properties are common among all attributes
and are discussed on page 66.

Point Size: This refers to the point size of the Pantograph design.

Rotation revolves the standard pantograph around a center axis. This reports
the rotation angle.

Adjust Pattern to Fit Box allows you to force a pantograph pattern to exactly
fill the box up to the edges, with perfect symmetry. Keep in mind that this
adjustment is made on a box-by-box basis, and if you have several
pantograph-filled boxes side-by-side on your page, the patterns might not be
aligned with each other.
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Figure 4-27: Adjusting Keeps the Design Character Completely Within the Box

More on Pantographs

Pantographs give you a wider variety of graphic effects than borders because
the Inside attribute of the box also plays a part in the look and the pantograph
can be rotated in 90 degree increments. There are three types of Pantographs:

Type A – These allow the most dramatic effects to be accomplished through
the variables of background, foreground, and insides They are created with
one character, which then allows the Inside of the box to become the
background of the pantograph and show through the design. The foreground
character is not used.
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Type B – These pantographs are made of two characters: both the foreground
and background. These characters are such that they have holes in them which
allow the Inside Color to show through allowing some variety.

Type C – Here we again have two characters, but they are complete characters
which mask over the entire insides of the box.

Modifying Existing Boxes
To make corrections to existing drawn boxes, you will need to choose the
Select Cursor tool and pick the box you wish to change. Then, click the right
mouse button. This will bring up a list of box options. Choose Box Properties
in the pop-up menu to make changes to attributes. This brings up a similar
dialog as Set Box Properties, but you will notice the title is labeled Modify
Box Properties. Make the necessary changes to the values and then [Okay].
You will see the modification take place on the screen to the designated box.
Repeat this process for each box that needs corrected. Groups of boxes can
be changed in one instance.

Set Area Properties

Figure 4-28: Set Area Properties Tool

Area components are screens or solid fills which are created by picking points
around an outside path. The Draw Area Tool is controlled by the Set Area
Properties tool.

The area outside boundaries cannot be modified once completed, only the area
attributes for the fill can be changed.

Figure 4-29: Area Components Allow You to Screen Any Shape
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Area Properties Dialog
The attributes are controlled by the current Set Area Properties dialog. Once
an area has been created, if an attribute change is necessary this can be
accomplished through the pop-up menu option, Area Properties.

The Area Properties dialog is very similar to the Box Inside Tab in that you
have a Color Start and End Density along with Graduation controls.

Layer – 1 through 32. Click [Select Color] Button
Color – FCP Color Number or Percentage of Color. Click [Select Color] Button
Screen Type – Dot or Line Screen 
Screen Lineage – Lineage Value 
Screen Angle – Angle or Auto (system default) 
Graduation Angle – 0 through 360 degrees 
Graduation Progression – Linear, Logarithmic, Reverse Logarithmic 
Graduation Type – None, Directional, Radial 
Radial Center X and Y – Starting Coordinates of the Graduation 

Figure 4-30: Set Area Properties Dialog

Area Graduations
Areas have the ability to produce graduated screens when the Starting and
Ending colors are not the same. It is very much like the Graduations within a
Box component. See Figures 4-18, 4-19 and 4-20 for examples of Graduation
Angle, Progression and Type.
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Modifying Existing Areas
If existing area attributes need to be changed, pick on the area with the Select
Cursor Tool and then choose the Modify Area Properties in the pop-up. You
will be given access to the same dialog box options as the Set Area Properties
tool, but you will notice the dialog title is labeled Modify Area Properties.
Make the necessary changes to the values and then [Okay]. You should see
the modifications take place on the screen to the designated area. Repeat this
process for each area that needs corrected or replaced. Groups of areas can be
changed in one instance.

Please note that the shape of the area cannot be changed. The Area can be
scaled and rotated, but the picks that make up the area cannot be modified.

Area Convert: This option was created to help clean-up imported files when
lines and rectangles come in as Area fills. The Area Convert option will analyze
the file and convert thin areas to Line components and rectangular areas to
Box components. Just click the [Process] button.

Example of Creating an Area to Fill a Circle
The following are steps for creating a solid area fill for a circle.

1. First we need to draw a guide. Select the Circle Tool and draw a small
circle approximately 1/4 inch. Since areas can be scaled, draw a small
circle then later scale it to the appropriate size after the area has been
created. This will speed up the process.

2. Zoom in on the circle. Now select the Area tool. You are prompted to
pick the first point of the area. Pick on the circle edge, you will notice a
red asterisk appear, as you pick around the circle you are creating the area
boundary. Be sure that the boundary comes to a complete close, not
containing any breaks.

Figure 4-31: Picking Points Around the Path

3. After you have made your picks around the entire circle. Right mouse
click and select "Done Defining Paths", then select "Close Path". Once
you have selected "Close Path" the area fill will appear.

4. If the area looks like it doesn’t fill the entire circle, increase the circle’s
line weight.
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Set Text Properties

Figure 4-32: Set Text Properties

Choosing the Text Properties tool on the Tool Bar will take you to the Set
Text Properties Dialog shown below. By setting the values for the Text Input
tool, you can easily create any type of text needed on your form.

The Set Text Properties Dialog has many tabs, each controlling different
aspects of the text attributes. It starts with the Font Tab allowing you to choose
the font family/style and point size of the text being created with the Text
Input tool. Each tab will be described in detail.

Text Font Tab

Figure 4-33: Text Font Tab

The following are options of the Text Properties:

Font Name – Font Name/Style
Type of Font –Check the Type of Fonts to Show in Listing
Horiz Size – Horizontal Point Size
Vert Size – Vertical Point Size
Leading – Baseline-to-Baseline Leading in Points
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Rotation – Angle of Text
Left Margin – Baseline-to-Baseline Leading in Points
Right Margin – Angle Position of Text
Comp Mode – FL = Flush Left

FR = Flush Right
CE = Centered
JU = Justified

Language – Horizontal Point Size
Units – Vertical Point Size

The Font Name field shows what font is currently selected. Clicking on the
[Select Color] button next to the Font Name field will bring up a drop-down
list of the fonts accessible. Selecting the font and style needed will display
the assigned mnemonic. Click the [Okay] button to accept the font.

The Horiz Size and Vert Size options control the size of your text. The
Horizontal Size controls the width of the text and the Vertical Size controls
the height. These values can be entered in 1/10th point increments (decipoints).
When they have two different values, you are requesting it to expand or
condense the font.

Leading controls the spacing from the baseline of the first text line to the
baseline of the second text line. The values can be input in 1/10th point
increments. It is recommended that the leading be equal to or larger than the
vertical size of the text to keep lines from oversetting.

Rotation controls the angle of the text. A positive value will rotate
counter-clockwise. A negative value will rotate clockwise.

Left Margin: The Left Margin is the point where your first character of your
lines will align. With Flush Left and Justified text, the position pick point is
considered the 0 point for the Left Margin. With Centered text, the position
pick point is the center of the Left and Right Margins.

MECCA III brings the benefits of electronic publishing technology
within reach of every business. The powerful stand-alone desktop
workstation provides real-time interactive page composition,
including graphics. Designed for use by forms composers, graphic
artists, typesetters, and technical writers,

Flush Left

MECCA III brings the benefits of electronic publishing technology
within reach of every business. The powerful stand-alone desktop

workstation provides real-time interactive page composition,
including graphics. Designed for use by forms composers,

graphic artists, typesetters, and technical writers,

Flush Right

MECCA III brings the benefits of electronic publishing technology
within reach of every business. The powerful stand-alone desktop
workstation provides real-time interactive page composition,
including graphics. Designed for use by forms composers, graphic
artists, typesetters, and technical writers,

Justified

MECCA III brings the benefits of electronic publishing technology
within reach of every business. The powerful stand-alone desktop

workstation provides real-time interactive page composition,
including graphics. Designed for use by forms composers,

graphic artists, typesetters, and technical writers,

Centered

Figure 4-34: Examples of Composition Modes and Pick Points

Right Margin: The Right margin determines where your line will end and
will begin to wrap to the next line. It is the width of the text component.

The Comp Mode (Composition Mode) field has a drop-down list of four
different modes which are: Flush Left, Centered, Flush Right, and Justified.
This controls how lines of text are placed within your text box.
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Flush Left aligns all left edges, Flush Right aligns right edges, Centered will
center all lines over each other, and Justified will adjust each line’s spacing
to align both the left and right edges of the text.

Language: The default is English. If you are composing Bengali, this is
necessary to turn on the character shaping aspects of the language, which is
similar to ligatures.

Units: This is the only tab that does not convert all units to inches. The
horizontal and vertical point sizes and leading will always display in points.

Text Enumeration Tab

An enumeration is a letter, number or other item in the left margin of an
indented paragraph.

Figure 4-35: Text Enumeration Tab

The options are used in the same manner as the Font Tab. These describe the
attributes of the enumerated piece of text only.

Use Enumeration –This turns on Enumeration. The options in this tab are
not read unless this is checked. See Figure 4-36 for examples of enumerations.
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This is an example of a hanging paragraph

style using the options for Indent. The values

used are Indent Line 1 (IN1) = 0, Indent Line

2 (IN2) = 16p, and Number of Lines

to Indent = 3.

This is an example of an indented

paragraph style using the options for Indent.

The values used are Indent 1 (IN1) = 16p,

Indent 2 = 0, and Number of Lines to Indent

= 1.

IN2

IN1

▼

LM

▼

RM

IN1

LM RM

LM RM LM RM

ERMERM ERMERM

IN1

Indented Style Hanging Style

Enumeration
Hanging Style

Enumeration
Embedded Style

▼

▼

▼ ▼ ▼ ▼

▼ ▼ ▼

▼

▼ ▼ ▼ ▼

The embedded enumeration

style includes enumeration options and

indent options. Use the values shown in both

the indented style and the enumeration

hanging style to create this look.

This is the enumerated paragraph

style using the Enumeration Tab.

The values are Enum. Left Margin

= 0, Enum. Right Margin = 20p,

Left Margin = 24p and Right

Margin = 240p.

A. A.

Figure 4-36: Paragraph Indents and Enumeration Examples

Text Layer, Color, and Screen Tab
Layer, Color, and Screen attributes are common among all components and
are discussed under Line Properties on page 66.

Figure 4-37: Text Layer, Color, Screen Tab
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Text Paragraph Tab
The following are options of the Paragraph Tab:

Lead Before – Space Before a Paragraph
Lead After – Space After a Paragraph
Indent 1– First Indent Value, Used on Number of Lines 
Indent 2 – Second Indent Value, Used for Rest of Paragraph
Lines Indent – How Many Lines Uses Value 1

Figure 4-38: Text Paragraph Tab

Paragraph
Paragraphs hold white space between them, which we call "leading before".
This leading is measured from baseline of the last line of the previous paragraph
to the baseline to the first line of the current paragraph.

Lead Before and Lead After: These are for setting the leading between
paragraphs when using "Text Input From File" within the Text pop-up. This
option’s usage is described in Chapter 6: Working with Text.

Indent
An Indent is the space used to place a line (or lines) of type in from the regular
margin normally to indicate the start of a new paragraph. In some cases, there
may be a need to have a hanging indent. This is when all, but the first line is
indented. See Figure 4-36 for examples.

Indent 1: This is the amount you wish to indent a line of a paragraph from
its left margin.

Indent 2: This gives you a second indention value to create a hanging
paragraph effect.
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Lines Indent: How many lines of the paragraph are to be indented using the
Indent 1 value. The rest of the paragraph will read from Indent 2 value.

Text Hyphenation and Word Space Tab

Figure 4-39: Text Hyphenation and Word Space Tab

The following are options of the Hyphen and Word Space Tab:

Consecutive – Consecutive Lines of Hyphenation
Min Word – Minimum Characters in Word
Min Before – Minimum Characters Before Hyphenation
Min After – Maximum Characters After Hyphenation
Nom WS – Ideal Word Space
Min WS – Minimum Word Space
Max WS – Maximum Word Space

Hyphenation

Hyphenation controls allow you to turn on and off hyphenation with the
minimum characters in a word option. Turn if off by setting the minimum
word size to a large number of characters, such as 25. The other controls adjust
the values of the hyphenation.

Consecutive: is the number consecutive lines of hyphenation allowed.

Min Word: Minimum Word Size is the minimum number of characters
allowed before the word will hyphenate.

Min Before: This is the minimum number of characters allowed before a
hyphen.

Min After: This is the minimum number of characters allowed after a hyphen.
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Word Space

Word Space is the space between words. Adding or subtracting space between
words is used to justify a line of type to a given measure or to improve
appearance. Word spacing is a relative unit in relation to the font and point
size. To get an approximate idea, there are 100 units in the uppercase M.

Nom WS: Ideal Word Space.

Min WS: Minimum Space Allowed Between Words When Justifying.

Max WS: Maximum Space Allowed Between Words When Justifying.

Recursive Hyphenation Allowed: Allow Repeated Hyphenations

Text Letter Space and Kerning Tab
The following are options of the Letter Space and Kerning Tab:

Kerning – On/Off
Nom LS – Ideal Letter Space
Min LS – Minimum Letter Space
Max LS – Maximum Letter Space

Figure 4-40: Text Letter Space and Kerning Tab

Kerning

Kerning is the adjustment of the space between letter pairs so that part of one
extends into the space of another. This option turns Kerning On or Off.
Kerning controls are part of a font.

AV - VA - WA AV - VA - WA
Not Kerned Kerned

Figure 4-41: An Example of Kerning Pairs
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Letter Space

Letter spacing at 0 is the normal amount of letter spacing in relative units. It
is in relation to the font and point size. To get an approximate idea, there are
100 units in the uppercase M. Use a negative number to tighten letter spacing
and a positive number to open up letter spacing.

Nom LS: This is the ideal letter space. 0 is normal, 1 will increase each internal
letter space, -1 will decrease each letter space.

Min LS: This control is used for justification and sets the Minimum letter
space allowed.

Max LS: This control is used for justification and sets the Maximum letter
space allowed.

Text Sub/Super Script Tab

This tab enables the user to control the position and size of a superscript
(above) or subscript (below) command used in the text. The offset values are
in relation to the baseline.

The following are options of the Sub/Super Script Tab:

Sub Offset – Percentage of Point Size to Offset from Baseline
Sub Size – Percentage of Point Size to be used for SubScript
Super Offset – Percentage of Point Size to Offset from Baseline
Super Size – Percentage of Point Size to be used for SuperScript

Figure 4-42: Text Sub/Super Script Tab
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SubScript
A SubScript is a distinguishing symbol or text placed lower and to the right
of another character. The size and position are relative and a percentage of
the current point size.

Sub Size: This is the size of the subscript. It is designated by a percentage of
the current point size.

Sub Offset: This is the position of the subscript relative and a percentage of
the current baseline.

SuperScript
A SuperScript is a distinguishing symbol or text placed above and to the right
of another character. The size and position are relative and a percentage of
the current point size.

Super Size: This is the size of the superscript. It is designated by a percentage
of the current point size.

Super Offset: This is the position of the superscript relative and a percentage
of the current baseline.

Text Miscellaneous Tab
The following are options of the Miscellaneous Tab:

OL Percentage – Outline Percentage when Text is Outlined
Tilde – Character Width Assigned to a Tilde
UL Position % – Position of Underline when Text is Outlined
UL Size %– Underline Percentage used for Underline Stroke

Figure 4-43: Text Miscellaneous Tab
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Outline

OneForm Designer Plus has the ability to outline any text and control the
thickness of the outline. The text will stay in its current type style, such as
Bold or Italic, but will be an outline of that current style.

OL Percentage: is the percentage of the point size that will make up the
Outline line weight when an outline command is used in the text. Outlines do
not display in OFDP, but print when using Save As PDF.

Tilde

The tilde character (˜) is used in OneForm as a "do not print" character. It
holds the space of the character input on the Miscellaneous Tab.

Tilde: The amount of space held by the Tilde character is determined by the
character place here. By default it is the width of the character "0". It will
pick up the width of the character typed in. The tilde will be an Em-space
when an "M" is used and an En-space when an "N" is used, and a Thin-space
if a "." is used.

Underline

This underline option enables the user to define the weight and position of
the baseline of an underline, when an underline command is used. Both values
are percentages of the current set point size. A negative value input for the
{Underline Position} percentage will place the line under the baseline, a
positive value will cause an overstrike to occur by placing the line above the
baseline.

UL Position %: This refers to the position of the underline relative to the
baseline.

UL Size %: This refers to the point size percentage that is used for the weight
of the line when an underline appears.

Modifying Attributes of Existing Text
If existing text attributes need to be changed, pick on the text with the Select
Cursor Tool and then right click and choose Properties Change. You will be
given access to the same dialog box options as Set Text Attributes, but you
will notice the dialog title is labeled Modify Text Attributes. Make the
necessary changes to the values and then [Okay]. You will see the
modifications take place on the screen to the designated text. Repeat this
process for each text item that needs corrected.

Text items can be group selected prior to modifying the properties. This will
change the property among all items grouped at one time.

See Chapter 6: Working with Text, for complete details on using the Text
Input tools and other text options.
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CHAPTER 5

The OneForm Designer Plus Menus

The OneForm Designer Plus Menu Bar accesses many of the functions
necessary to create your form. This chapter is a quick and easy reference of
the menus and their usage in order of their location along the menu bar.

Figure 5-1: The Menu Bar

File Menu

The File Menu holds functions which deal with the following file operations:
opening, saving, printing, importing, and font setup. For quick access to
previous files, it will list the last ten files opened. Four of the file menus have
shortcuts on the top toolbar – New, Open, Save and Print.

Figure 5-2: The File Menu

Creating a New Form File

Selecting New immediately brings up a Set New Drawing Properties dialog
box for naming the new file. This dialog also allows you to setup the properties
pertaining to the new file such as Width and Depth.

By default, the file created will be named "untitled.elf".
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Figure 5-3: Setup Drawing Properties Dialog

Before selecting [Okay], you have an opportunity to setup the following items:

File Name: This is the name the file will be given when saved. The file name
is very important to the whole process. It is used as the base name for any
other files generated.

The convention needed for OFDP e-forms is an alpha/numeric name with no
spaces or punctuation. Also, the file name should be at least 3 characters, start
with an alpha character, and use the extension of .elf (electronic form).

If you are creating files just for printing, you can use any amount of
alpha/numeric characters and end with the extension of .g (graphic drawing).

Date Initialized: This is the date the file was originally created. The date is
generated by the computer and cannot be changed.

Operator ID and Job Number: Here you can input names and job numbers
to assist in production management.

Form Width and Depth determines the size of page you are creating.

Form X Origin and Form Y Origin: This represents the location of the
lower-left corner of the form. If the page size is modified, this is the point in
which the page will shrink or grow.

Units: This shows the default units found in all dialogs when the form is
initially loaded. The choices are decipoints(d), points(p), picas(a), inches(i),
centimeters(c), millimeters(m), mils(t), and grids(g). You can’t change them
here. It is under Options, Drawing Options, Units.

Comments: This is handy place to keep comments concerning production of
the job.

You can modify a drawing’s properties through the Options menu.
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Color Model Options

When creating a new drawing the Color Model defaults to Process Color.
The "Set Component Attributes" dialogs change according to color model
chosen. See Chapter 4, Setting Drawing Component Properties for examples
of these dialogs.

Process Color is based on the use of a four color press, and uses the colors
of Cyan, Magenta, Yellow, and Black. The layer has no affect on the color
because the separations are always CYMK. Here color is controlled by the
"Four Color Process (FCP) Number" assigned.

Spot Color refers to a single run ink color in offset printing. Spot color is any
color generated by an ink (pure or mixed) that is printed through a single run.
The artwork is designating "Spots" for color a be applied. OneForm controls
spot colors through "Layers", by assigning colors to layers through the Drawing
Properties, [Set Layer Colors] as shown below.

Figure 5-4: Set Layer Color Dialog

Once a color is selected a Density can be applied to the Spot color through
the component’s properties while selecting the layer.

The options for Color Model and Set Layer Color work together. See Chapter
8: Working with Color for complete details and examples of usage.
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Opening an Existing Form File
When you select Open on the File menu, you are opening an existing file. It
will bring up a dialog box listing all valid files.

OneForm Designer Plus can open two types of files:

.g – OFDP Graphic Drawing Files

.elf – OFDP Electronic E-Form Files

You may look in another location by using the standard Windows browsing
techniques to get to the folder that contains the file you wish to open. Highlight
the file name and select [Open].

Figure 5-5: Open Files Dialog

You can also back out of the folder by clicking the Close Folder icon.

Note: If you have opened the file recently, it will be at the bottom of the File
menu.
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Combine Drawing
This option brings a copy of another file into your drawing. After clicking on
Combine Drawing in the File menu, browse for the drawing that you want
to bring into your form. A dialog box will appear that will allow you to
determine the placement of the Combined File.

Figure 5-6: Combine Drawing

Checking the No Alignment option will place the drawing by its original X/Y
origin.

The items can be placed by the corners or center of the page size by choosing
Drawing Limits. If you just want the extreme bounding box of the components,
choose Component Limits. Each choice has five handles: UpperLeft,
LowerLeft, Center, UpperRight, and LowerRight of which get placed upon
your picked position.

The drawing will appear on your form with the corresponding handle being
dropped on the page in the position you pick.

All components brought in will appear white because they are Group Selected
and are ready to be moved or possibly resized. Unselect the drawing by
choosing Group Unselect All under the Edit menu.
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Saving Your File
When you select Save, the action is immediate. You are overwriting the
existing file with the current version. If the file has never been saved before,
the Save As dialog will automatically appear.

The Save As allows you to save items under a different name. Here you have
an opportunity to give it a new name and/or save it in a different location.
You may find another location by using the standard Windows browsing
techniques to get to the folder you wish to use.

The file name can be alpha/numeric, and should be at least 3 characters. Use
the extension of (.g) for graphic drawing form files, and the extension of (.elf)
for electronic fielded form files.

The default for Save As is Save All Components, but you can save many
other ways:

• Save All Components saves all components in the file and allows you to
rename the file, change the extension or save your file in a different location.

• Save Only Grouped Components will save only items that are currently
grouped. This is helpful if you plan on combining the group into other
forms.

• Save Only Current Layers will only save the layers that are currently
being displayed. You may turn layers on and off through the Set Layers
On/Off under the Option Menu, before saving.

All Save options available through OFDP Profiles are discussed within their
corresponding documentation.
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Printing the Form
File’s Print option uses the standard Windows Print Manager: Print, Preview
and Print Setup. You can use your View selections to print the form with fields
(Normal Fields) or without fields (No Fields), or with field names (Show Field
Names).

Figure 5-7: Windows Print Dialog

It is recommended that you create PDF files for digital printing instead by
using our PDF Generator Module and Save As PDF option. For more
information, see Chapter 12: PDF Files for Digital Printers in the PDF
Generator Module reference manual.
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Import
OneForm Designer Plus has the capability to interpret and convert two file
types:

.eps – Encapsulated PostScript

.pdf – Adobe Acrobat 5.0 and higher

When a file is imported into OneForm Designer Plus it is converted into an
editable graphic file. Conversion tips are found in a chapter dedicated to
achieving the best results when importing files. See Chapter 9: Importing EPS
and PDF Files.

Figure 5-8: Import

Importing the file is easy. First, create a new page. Next, choose File, Import
and then select EPS Files or PDF Files. A dialog box will appear to locate
and import your file. The file will automatically be renamed with a .elf
extension. The newly imported file may now be saved and opened normally.

Other Import options available with OFDP Profiles are discussed within their
corresponding documentation.

Font Setup Menu Options
Font Setup is necessary to create the Text Tool’s font selection drop-down
list. See the section discussing fonts in Chapter 1 of the Getting Started manual.
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Edit Menu

The Edit menu has a variety of functions which allow you to make changes
to your file and the components in your file. The menu is broken into sections
according to the functionality. The main features are Undo/Redo, Grouping,
Cut/Copy/Paste, Depth Order, and Separating Components.

(Continued)

Figure 5-9: Edit Menu

There are times when you want to affect many items at once. The Grouping
options are designed just for this occasion. You can use the Group options for
designating items to temporarily link together. Select the items through Group
Select Pick, then choose a tool to apply to the group, such as Move. Specific
Component Types and Select by Property works with Group allowing you to
identify the type of components you are wanting to Group.

Edit also holds the options for arranging the Depth Order of components on
the page. For example, when two components overlap each other, which one
is on top. Send to Front and Send to Back are used to rearrange the display
order by moving components all the way to the front or all the way to the
back. Following are complete instructions on using the Edit Menu options.

Undo/Redo

Undo restores the last move, copy, or resize change, and Redo puts the change
back. Undo has multiple levels and will continue to restore each modification
up to the last save. These work with all components and tools.
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Specific Components and Select By Property

This is nice when you want to select all of the electronic fields or all lines,
but not the text. You can toggle on a component type for selection before the
Group Select process. This will enable you to only group that specific
component type.

Selecting by a Property allows you to locate a specific XML GUID or a specific
font. The fonts listed are those used on the form in either Text Components
or Field Components.

Figure 5-10: Specific Components and By Properties Menus

Group Selecting Items

There will be many occasions when you will want to Move, Copy, or otherwise
affect several items at once.

Choosing Select Intersect in the Edit Menu gives you the ability to select
multiple items to be members of a single "Group". Only one Group exists at
a time, and items stay selected until you unselect them.

Relationships are maintained during the select process. As you move selected
items around you will notice they stay in the same relational distance from
each other, and move together.

Items that have been Selected will appear in white. When the background is
also white that makes it hard to see. The background can be changed through
the View menu’s Page Background Color. Changing it to a shade of gray
makes the selected items stand out when they are shown as white. A color
density of 20 seems to work best. This is entirely for your viewing only and
will not affect the page color during printing or generating.

Group Select All/Unselect All

With this option you make the entire file part of the Group, whether visible
in the Window Area or not.
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Not surprisingly, Unselect All, is the opposite of Select All. Every item on
the screen will go back to its original color, having been Unselected. This also
affects those items not showing in the window. It will always be the fastest
and easiest way to get rid of a selected group no matter which option you used
to select it.

Group Select Pick/Unselect Pick
This option will only select an item that is chosen with your pointer.

In order to Unselect Pick, right click and choose Switch to Unselect. This will
now enable you to Unselect Pick your components.

Figure 5-11: Group Select Pick Pop-Up Menu

Changing to another Group Select method is through the right clicking pop-up
menu. Here you can quickly access Group Select Inside or Intersect.

Group Select Inside/Unselect Inside
This option allows you to select items by placing a dynamic rectangle and
completely surrounding the objects to be selected.

Using Group Select Inside: Pick a location for your first pick and make your
rectangle large enough to completely enclose the object(s) to be selected. It
will only group components that were completely enclosed by the rectangular
region drawn. This feature allows you to group text on top of boxes without
getting the box, so long as you make the dynamic rectangle small enough not
to enclose the entire box.

Group Unselect Inside is the opposite of Select Inside, unselecting only those
items totally enclosed by the dynamic rectangle drawn. This option may be
accessed by right clicking your mouse and selecting Switch to Unselect.

Change to another Group Select method through the right click to access the
pop-up. Here you can quickly access the other Group options.

Group Select Intersect/Unselect Intersect
Select Intersect allows you to select items by placing a dynamic rectangle
around or at least touching the items to be selected. Any item that comes in
contact with the box will be selected. Objects selected with this option do not
need to be completely enclosed.

Step 1: Use the Line and Box options to make enough items to fill the screen.
Go to the Edit menu.
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Step 2: Choose Select Intersect. Put your cursor in the middle of the items
you just drew, and pick a spot. As you move the cursor away, a
dynamic rectangle will stretch and move with the cursor.

Step 3: Pick a location for the second corner having it cut through a few
different items. As you pick, the rectangle will vanish and every single
item that came in contact with the dynamic rectangle will be selected.
They are now part of a group.

Step 4: Choosing Unselect All in the Edit Menu will get rid of the group.

Unselect Intersect is the opposite of Select Intersect. It can be accessed by
right clicking to bring up the Pop-up menu. Choose Switch to Unselect. The
method for Unselect Intersect is the same as Group Select Intersect.

Change to another Group Select method through the right click pop-up menu.
Here you can quickly access Group Select Inside or Pick.

Cut, Copy and Pasting Items

The Cut, Copy, and Paste are similar to the standard Windows options.
Components are identified for the Cut and Copy options by Grouping them.
They are normally used to bring items in from another file, since OneForm
has a Copy Components Tool. Items which are cut or copied are placed on
your clipboard, (a temporary Windows storage location), until you cut or copy
again.

Cutting Items

Cut is just another way to delete items from your file. The shortcut key for
cutting is [CTRL]+[X].

Step 1: Go to the Edit Menu and choose Select Intersect.

Step 2: Draw a dynamic rectangle around the items you wish to cut. When
selected, they will turn white.

Step 3: Go to the Edit Menu and choose Cut. Notice the selected items have
vanished. They are on the temporary clipboard. It you want them
back, choose Edit menu’s Paste option.

The Cut Text Only is only for Text components and to be used to capture
text keystrokes only and not the text attributes. The keystrokes can then be
pasted into other text components picking up their attributes instead.

Figure 5-12: Cut, Copy, and Paste
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Copying Items from One File into Another

You can copy items from one file into another by using the copy and paste
menus or tools. You can paste the items as many times as you want. They
stay on the clipboard, a temporary storage location, until you cut or copy again.

Step 1: Go to the Edit Menu and choose Select Intersect.

Step 2: Draw a dynamic rectangle around the items you wish to copy.

Step 3: Go to the Edit Menu and choose Copy. At this time you would not
see any action take place, but the group has been placed on the
temporary clipboard. The shortcut for Copy (to the clipboard) is
[CTRL]+[C].

Step 4: Close your current file and open the file which needs the copy.

Step 5: Go to the Edit Menu and choose Paste. You will be prompted to pick
a position to paste. Once a position is chosen, the group will be pasted
onto the form. The items are still selected so that you may Move them
to their preferred location.

The Copy Text Only is to be used to capture text keystrokes only and not
the text attributes. The text can then be pasted into text being edited.

Pasting Items

Paste places the items from your clipboard onto your current form. You may
paste the items as many times as you want, but they will always come in
selected. Choose Paste and pick where you wish the upper-left corner of your
component(s) to be placed. Paste does have options under the right-mouse
pop-up menu. "Combine at Original Position" will place the item at the same
coordinates it originally had.

Paste will always be available from one session to another if you have cut or
copied items. The clipboard does not remove itself when OneForm Designer
is closed. [CTRL]+[V] is the shortcut for paste.

Using Search

You can search and replace a word by using the Search option found under
the Edit menu. When choosing this option the following screen will appear.
Type in the word you are searching for and select Next. The found word will
appear highlighted. You can then type over the word or enter a replacement
word in the area provided and select Replace.
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Figure 5-13: Search Dialog Box

Arranging the Display Order

Send to Back and Send to Front are used to rearrange the display order of
components. They send the selected component to the very back or front of
the display list. During printing, only the displayed portions of the items are
printed. Using these tools allow you to draw a background screen last, and
still get it behind all existing lines and boxes. See Figure 5-14.

Choose Send to Front in the Edit Menu. Pick the item to be moved and it
will be placed in the front of the entire drawing.

Mark Reference Object works in relationship with Put Behind Object and Put
in Front of Object. This will allow you to choose a component as a reference
object first, to put in front of or behind the reference item.

For example, choose Mark Reference Object and then the item to be
referenced. Next, choose Put in Front of and then the item to be moved.

Figure 5-14: Use Move to Front When Text is Underneath

Separate All Components

This option separates all combines in an entire file, so be careful. If you want
to separate a single GUID Association, use the "Separate" or "Remove GUID
Association" option under Field’s Pop-up Menu.
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Combining Technique
There is a technique you can use if you need to combine components together,
but it requires a field. If you don’t need the field, just "Disable" it afterwards.
It will still appear in your field list, but will not be seen during generation or
printing.

Group the components that need linked along with the field. With the Select
cursor, pick the field and right-mouse to get to its Pop-up menu. Select the
"Create GUID Association" option; you will then be prompted to "Pick Item
to Attach to Field", so pick the group. This will link all components in the
group to that field.

There is a "Remove GUID Association" available if you ever want to
uncombine the items later in the field properties.

Options Menu
Options holds a wide variety of functions. The menu selections available are
dependent on the OneForm Profile. Since the functions are so diverse, we have
listed them all with a brief description first, and then expanded on those needing
more usage details.

EForms Only Profile All Profiles

Figure 5-15: The OFDP Profile Changes the Options Menu

EForm Options accesses the electronic form and field properties of a form:
Generate EForm, EForm Preferences, Field List, Set Tabbing Order, etc. See
the reference manual Creating E-Forms for usage.

Drawing Options takes you to the Drawing Properties dialog. It also holds
Output Specifications, default Units, and a Combine Colors option.
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Program Options: Here are many program preferences and settings. You can
set the OFDP profile, save component preferences, and assign short-cut keys.
There is also access to the Backup folder. This folder stores a copy of the ELF
every time it is saved.

Grid Options turns the Grid and Ruler View On and Off and controls grid
values.

Set Layers On/Off controls viewing of layers. Components can be placed on
any of the 32 layer choices, here you have the ability to turn the layers’ display
off and get them temporarily out of your way.

Font Search This is a more detailed list of the fonts that OFDP is using.

Drawing Options
Drawing Properties: This is the dialog which first appeared when creating a
new form. You can get back to it and change the form size if needed.

Figure 5-16: Setup Drawing Properties Dialog

Units specifies your default preference of units displayed within the dialog
boxes during composition of your form.

You can select one of seven units of measure to work with during form layout.
The following unit mnemonics are used for displaying measurements and for
measurement input:

i = Inches c = Centimeters
p = Points m = Millimeters
d = Decipoints t = Mils
a = Picas g = Grids

All measurement specifications will default to the chosen unit unless otherwise
specified with a mnemonic during input.

Output Specifications are used to indicate which layers are needed for each
part, and separation, during printing. And Combine Layer Colors allows you
to combine the layer color selections from another Spot Color file into the
current file. See Chapter 8: Working with Color for complete details.
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Program Options

Here are many program preferences and settings. The options that effect
composition are the component preferences save settings, the shortcut key
mapping, and the drawing backups.

Figure 5-17: Program Options

Saving Options and Drawing Backups

Auto Save saves a backup copy of your file after changes are made and saved.
Use the option Explore Drawing Backup Folder to locate a previous revision.
Since this can create a large volume of files, it is recommended to clean it out
every few months using Clean Up Drawing Backup Folder.

Save Component Settings allows you to save the current properties as a default
setting. You can setup a default for each setting property tool.

Figure 5-18: Saving Component Settings
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Key Mapping (for Assigning Hotkeys)

You can assign hotkeys by selecting Options, Program Options, Key
Mapping. This will bring up the following screen. Highlight the menu you
want to effect and click Define Shortcut. Here you will be allowed to assign
a Key Value.

Figure 5-19: Assigning Hotkeys

The [Shift] key is only used in conjunction with the [Alt] or [Ctrl] keys. For
example [Alt]+[Shift]+[A] or [Ctrl]+[Shift]+[A].

Note: A message will appear if the shortcut has already been assigned or
cannot be used. It is recommended that you exit OneForm Designer Plus and
restart after you have defined a hotkey.

Use External Editor

The External Editor is an alternative to Interactive Text. Its shortcut tool is
on the top toolbar. If you have used Amgraf’s MECCA Systems, you will
most likely find this to be the easiest transition into text. Selecting External
Editor as your means of editing, invokes Notepad while working with text.

Then you may enter text using all of the notepad features such as the [Del],
[Arrow] keys, [Insert], [Page Up] and [Down] along with cut and paste. Also,
the text can have embedded Immediate Composition Commands.
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Use Advanced Elf Properties Edit

There are two sets of Electronic Field Properties dialogs. The basic set allows
those who just use the common field types of Text, Numeric, and standard
Checkboxes to have what is needed without the clutter of all features.

The Advanced Electronic Field Properties includes advanced for Checkboxes,
Buttons, and Attach/Upload, etc. If you want the default of your software to
always use the advanced set of EForm Field dialogs, check this option.

Grid Options
The Grid and Ruler are great drawing assists for accuracy. The Grid Snap Tool
forces all picks to land on a grid during forms composition.

Grid Properties takes you to a dialog box for turning on the grid view and
setting the grid spacing. Once the Grid Setup Window appears, you will then
be able to customize your grid. Choose [On] to just view your Grid. [On/Snap]
turns on your grid, but also toggles the Grid Snap tool. Items such as the
horizontal and vertical spacing, units and grid origin are determined here.

Figure 5-20: Grid Properties Dialog Box

Hor/Ver Units: This is the units that will make up your grid.

Horizontal/Vertical Spacing per Unit: This is the number of divisions within
your chosen units.

Minor Division Count is the number of divisions that will display when your
grid is turned on. Normally this setting is 1, and will display all grid lines. If
2 is chosen, only every second line will display.

X & Y Origin on Page: This is the beginning location of the grid. You can
type in a coordinate here, or go back to the Options menu and use Set Grid
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Origin. This option allows you to specify a beginning point for the ruler
display. Our example places the beginning point at the top-left corner of our
letter size (11i) page.

Y Axis Direction: This controls how the ruler and cursor reads positioning.
Down will read from top of the page to the bottom. Up will read from the
bottom of the page to the top.

Set Grid Origin

By default the grid origin is 0,0. If you need it to be repositioned, select this
option and then carefully pick the grids new origin.

Composing in Grids

To compose in grids, set the Grid Properties first with Units to Inches. Then
set the main Options, Units, to "Grid". You will notice the cursor movement
readouts will report whole grid units. Then turn on the Ruler through Option’s,
Ruler Properties.

When typing in specific line measurements you can use the "g" mnemonic
(along with the direction arrow key) to represent the current grid spacing.

Figure 5-21: Ruler Position
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Set Layers On/Off
Set Layers On/Off controls viewing of layers. Components can be placed on
any of the 32 layer choices, here you have the ability to turn the layers’ display
off and get them temporarily out of your way.

OFDP allows 32 layer assignments. When many components are used on a
form, it may be easier to turn some of them off and get them out of the way
during composition.

Figure 5-22: Set Layers On/Off

Even though a layer is turned off, it will still be saved with the file and turned
back on the next time the file is opened. There is also a handy Save As selection
under the File menu to Save Only Current Layers into a new file. So, if you
need to combine just some of the layers into another file, turn off what you
don’t need and save the rest into a new file.
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Draw Menu
The Draw menu accesses additional options not found on the toolbars. All of
these menus are for creating new components. Each section will describe the
tools, how they work and the Pop-up functions that aid in creating them.

Vector

Arc

Text

Area

EForm Field Raster Image

Barcode

Figure 5-23: Draw Menu
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Types of Drawing Components
Listed below are the different types of drawing components that can be created
with the OneForm Designer Plus software. Many of these can be found on the
Tool Bar, however; all are found in the Draw menu.

For example, the Line Tool draws simple vectors. But under the Draw Menu,
Vector also has two other choices for drawing vectors: Prorated Multiple Lines
and Chained Lines.

Figure 5-24: Types of Components

Vectors

This includes any lines drawn by either the Line or Rectangle Tool. It also
includes lines drawn as Prorated Multiple Lines and Chained Lines. Rectangles
are four vectors drawn by two picks that present a dynamic rectangle. The
four vectors are combined together for moving, grouping and deleting.

Chained Lines are continuous lines, each linked by at least one endpoint; while
Prorated Lines creates any number of equally spaced horizontal or vertical
lines. All drawn vectors pick up their attributes from the Set Line Attribute
Tool.

Arcs/Circles/Ellipses

The Circle Tool draws only circles. But under the Draw Menu’s Arc option
there are also choices for drawing Arcs (semi-circle) and Ellipses too. You
can also specify your choice of picking: the center then edge, or edge then
center. All drawn arcs, circles, and ellipses pick up their attributes from the
Set Line Attribute Tool.
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Boxes

The box is a specialized component that can have squared or rounded corners,
filled insides, screened bars, individual line weights on edges, all as one
component. It also includes a library of border and pantograph designs. Because
of this, boxes can only be rotated in 90 degree increments.

Text

Text being created through the Input Text Tool is using the Draw Menu’s
option of Mark Anchor Position. There are also two additional options Mark
Left and Right Positions and Place Text in Boxes (rectangular shapes). All are
creating text and using the Set Text Attributes Tool for its attributes, just
placing the text is different with each option.

Areas

Areas are screened or solid fills that are created by picking an outside path.
Types of Areas include: Rectangular and Poly Line Area. The Area Tool uses
the Poly Line Area for drawing the boundary. The attributes for the fill is
defined through the Set Area Attributes Tool.

Splines

Splines are curved lines specified by 4 picks. The attributes for the spline is
defined through the Set Line Attributes Tool.

Barcodes

There are different types of barcodes that can be generated. Each have different
characteristics. After choosing the Barcode type, you will be prompted to enter
the code. A property box will then be displayed and characteristics may be
applied. You will then be able to define the location of the barcode.

Rasters

Rasters are scanned images. The most commonly used for electronic forms
are GIFs or JPEGs. For paper forms, BMPs or TIFs are common. The image
display within OFDP is color compressed, but will look fine on the final
artwork or electronic form. The Add Logo Tool uses the option Add Raster
at a Location and simply places the designated raster file by its upper-left
corner. The Add Raster to Fit will scale the raster to fit within a predefined
boundary by asking you to pick two diagonal corners.

EForm Fields

There are three menus for EForm Fields. The first two are the tools: Add
Singular Field and Auto Field Positions. The Add Focus Field is specific for
Accessibility Forms. See the Creating E-Forms manual for information on
creating fields.
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Drawing Vectors
There are three options under this menu, with the Draw Lines being the same
as the Line Tool. All drawn vectors pick up their attributes from the Set Line
Attribute Tool.

• Lines
• Prorated Multiple Lines
• Chained Lines

Drawing Lines

This is the same as the Line Tool. After picking the Line Menu, select the
first position for your line by finding the location on the page and clicking
the mouse. As you move the cursor, a line will appear. You are now ready to
define the line by making a second pick. The Eight Direction Lock Tool will
assist in keeping your lines horizontal or vertical, or you can hold down the
[SHIFT] key.

Chained Lines are multiple lines linked end to end. Where one line ends,
another begins.

Drawing Prorated Multiple Lines

Prorated Multiple lines divides an area by a given number of rules, placing
the rules equally spaced. Technically speaking, it generates a number of parallel
rule lines, within a specified rectangular region, such that the rules are evenly
placed within the region.

Once Prorated Multiple Lines is chosen, the Line Tool will appear activated
and the Set Multiple Line Properties dialog will appear.

Figure 5-25: Set Multiple Lines Dialog Box

In order to generate lines, three things must be known: region corners, direction
of lines, and number of lines. These are controlled by the Attributes Menu
and are used repeatedly until changed. You have a choice of Horizontal or
Vertical Lines, and how many to include "Inside" the two picks you make.
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Step 1: Choose Vectors and Prorated Multiple Lines under the Draw menu.
The Set Multiple Line Properties dialog will appear. Input the
properties here. Input 3 for both the number of horizontal and vertical
rules. [Check] all Outside Lines. [Okay] the settings and make your
first pick.

Pick First Point Pick Second Point Without Borders

✛

✛

Step 1 Step 2 Step 3

Figure 5-26: Drawing Prorated Lines

Step 2: As you move your cursor, notice a rectangular shape following your
cursor. The rectangular region created will be the area that the multiple
lines will be equally spaced within. Pick again for your second pick.

Step 3: It will automatically include the four sides, unless you toggle off the
Add Outside Lines options. (This allows additional rules to be created
as a framework around the inside lines. You can check any
combination of top, bottom, left, and right outside lines.) [Okay] the
settings and pick two diagonal corners.

Making modifications to the attributes of Multiple Lines is the same as
modifying singular lines. Once drawn the lines are considered singular line
components.

Draw Arc

The Circle Tool draws only Center - Tangent Circles. But under the Draw
Menu’s Arc option there are also choices for drawing Arcs (semi-circle) and
Ellipses.

• Center - Tangent (Circles)
• Tangent - Center (Circles)
• Arc Through 3 Points
• Ellipse - Center/Corner
• Ellipse - Corner/Corner

You can also specify your choice of picking: the center then edge, or edge
then center. All drawn arcs, circles, and ellipses pick up their attributes from
the Set Line Attribute Tool.



Chapter 5: The OneForm Designer Plus Menus

Draw Menu

123

Circle Arc Ellipse

First Pick

Second Pick

First Pick Second Pick

Third Pick

First Pick

Second Pick

✛ ✛

✛

✛

✛✛

✛

Figure 5-27: Drawing a Circle, Arc and Ellipse

Drawing Circles

To draw a circle, choose the Circle Tool and pick a center and tangent. If you
wish to change the order of your picks, choose Circle-Tangent/Center under
the Draw menu. This will make your first pick the tangent and the second pick
the center.

Arc Through 3 Points

An arc is a segment of a circle that is defined by three points. The first and
second picks are the endpoints, while the third pick defines the curve.

Step 1: Choose Arc’s and Arc Through 3 Points under the Draw menu.

Step 2: Pick the position of the first endpoint of the arc.

Step 3: Pick the position of the second endpoint of the arc.

Step 4: Choose the tangent keeping your cursor between the two endpoints.
With this pick, the arc will be created.

Ellipse

An Ellipse is a closed curve in which the distance from the center is not
equidistant. An egg shape is an example of an ellipse.

After choosing Ellipse-Center/Corner, pick the position that will be the center
of the ellipse. As you move your cursor, the ellipse will take shape. Pick the
position of the corner of the ellipse.

Ellipse-Corner/Corner offers an alternative method for drawing ellipses. The
two picks will be the diagonal position of the corners rather than the first pick
being the center.

Draw Rectangle

This menu pick is activating the Rectangle Tool. Pick two diagonal corners
to draw a rectangle. A rectangle consists of four vectors joined to create a
rectangular shape. Since rectangles are vectors, they use the Set Line Attributes
for its properties.
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Draw Box

This menu pick is activating the Box Tool, just pick two diagonal corners to
draw a box. The Set Box Attributes Tool controls the look of the box. Since
a box is a specialized component that holds many attributes, see Chapter 4:
Setting Component Attributes, Set Box Properties.

Draw Text

The Draw Text menu allows you to input Text through three different methods.
For complete details on usage see Chapter 6: Working with Text. When text
is created the attributes are drawn from the Set Text Attributes Tool which is
discussed in Chapter 4: Setting Component Attributes.

Mark Anchor Position: This method allows you to simply pick a position
and begin entering text. This menu is the Text Input Tool.

Mark Left and Right Position: This method allows you to define a dynamic
rectangle as the text position. After selecting this option, choose the upper-left
corner of the text boundary. A dynamic rectangle will appear as you move
your cursor. Choose your second diagonal corner and you are ready to begin
inputting text.

Place Text in Boxes: This option assists in the placement and input of text
into pre-drawn boxes often found in business forms. The box shapes can be
drawn with Lines, Rectangles or Boxes. The system is looking for four sides
to determine the placement.

Draw Area

Areas are screened or solid fills that are created by picking points around an
existing boundary. Attributes for the area fill are setup by the Set Area
Attributes Tool.

Pick First Point Continue Picking Points

✳

✳ ✳

✳

✳

✳

✳

Pop-up: Close Path

Figure 5-28: Drawing Poly Line Areas

Poly Line Areas: The Poly Line Area is the same as the Draw Area Tool.
This type of area does not take on any specific shape. You are determining
the shape solely by your picks. Begin picking positions for your area. Red
asterisks will display your positions. Once you have finished defining your
area, right click and choose Close Path.
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Rectangular Areas: To Draw a Rectangular Area, choose Draw, Area,
Rectangular Area. Select a position for the upper-left corner of your
Rectangular Area. As you move your cursor, you will see a dynamic rectangle
representing the rectangular size. Pick your second diagonal corner to complete
your area.

Draw Spline
This menu activates the Spline Tool which draws curves by 4 picks and then
specifying Done. Attributes are through Set Line Attributes.

Drawing Barcodes
Draw Barcode is your access to creating ten different types of barcodes:
Codabar, Code 3 of 9, Postal (FIM and ZIP), UPC (A and E), Interleaved 2
of 5, Code 128, EAN-13, and Intelligent Mail. Each have different
characteristics, see Chapter 7: Working with Barcodes.

Drawing Electronic Form Fields
This option draws electronic form fields used to display or collect data on an
electronic form. See the Creating E-Forms Manual.

Draw Raster Image
The Draw Raster Image option allows you to import a scanned image into
your file. It has two menus:

• Add Raster at a Location
• Add Raster to Fit

Add Raster at a Location: This menu activates the Add Logo Tool and
prompts you to choose the position for the upper-left corner of your logo. This
will then bring up the Logo dialog window so that you may locate the file
you wish to include and choose its characteristics. Click [Okay] when finished
setting its attributes and the logo will be placed on your form.

Add Raster to Fit: This defines a rectangular region in which your logo will
fit into. Select Draw, Raster Image, Raster to Fit. Draw a rectangular region
for your logo with two diagonal picks. A window will appear in order to locate
and open your Raster image. This option distorts the image to fit in the box;
therefore, losing the proportions of the original image.

For details on types of image files which can be imported, see the Add Logo
Tool, in the Getting Started manual.
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Modify Menu
The Modify Options allow you to modify existing items. The Move, Copy,
Scale, and Rotate are their corresponding tools. They are discussed in detail
in Chapter 1: The Tool Bars.

Figure 5-29: Modify Menu Options

Area Convert

This option was created to help clean-up imported files. When importing some
lines and rectangles become color fills, which is our Area component. The
Area Convert option will analyze the file and convert thin areas to Line
components and rectangular areas to Box Components. Just click the [Process]
button.

Adjust Text Leading

This option allows easier vertical positioning of existing text paragraphs. The
text items to move are identified by grouping them together. There are three
major functions to this Modify menu, Adjust Text Leading option:

• Moving the Entire Group – Flush Top, Centered, or Flush Bottom

• Changing the Leading Before of each Paragraph in the Group

• Changing the Internal Line Leading of each Paragraph in the Group

After choosing Adjust Text Leading, you will be prompted for two picks
which will identify a top and bottom position of the column.

Vertical Just Mode: There are three placement modes: Flush Top, Centered,
or Flush Bottom. Once the top and bottom limits are known, clicking the [Auto
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Adjust] button will move the grouped paragraphs to the selected vertical
position and adjust the spacing between them.

We call this spacing the "lead before" value of the paragraph. If the paragraphs
do not have a first line indent, then the lead before value will be the line lead
plus 2-points. If the paragraphs have a first line indent, then the line leading
is used as the lead before value.

The lead before value is found in the Text Properties, Paragraph Tab. This
leading is measured from baseline of the last line of the previous paragraph
to the baseline of first line of the current paragraph.

Lead Before: This option allows you to control the vertical spacing between
paragraphs which we call "lead before". The first paragraph will not move or
be modified. The second and all others following in the group, will be moved
consistently.

If you know the leading value you need, just type it in under Specify, and
press the [Tab] key.

When using the Increase/Decrease arrows with an increment, type in the value
to increment (1p) and then click the arrows until you get a visual movement.
The total additional leading must be larger than the line leading. If you know
that you are starting with 11-point lead, movement will not start until the
additional leading is at 12p. You can start with 11p and then change to your
increment of 1p, if you do not want to click the [Up Arrow] twelve times.

Line Leading: This option allows you to adjust the internal line leading of
the grouped paragraphs. Type in an increment to adjust by and then use the
Increase/Decrease arrows to see the adjustments.

Lock Line Leading: If you toggle this On, the line leading will not be adjusted.

Miscellaneous Notes: The [Undo] tool will remove all leading changes, not
just the last one.

The Flush Bottom mode moves the baseline of the last text line in the paragraph
to the bottom limit provided. There is no provision made to account for any
descenders that may be in this text line.

Recombine Text

This option is the same as Combine Selected Text in the pop-up menu. It takes
grouped text components and converts them into one text component.

Recompose All Text and Barcodes

These options recompose the Text or Barcodes in the entire file using the latest
composition update.

View Menu
The View menu controls the display on the screen. These options only affect
how you are viewing your page and not the end result.

A drawing’s color model can be either Spot Color or Process Color. The view
is an easy way to find out without opening Drawing Properties. If Layer Color
is checked, the file is Spot Color.
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Show Stepping: This displays stepped components that would not normally
display. Stepping can be set through Output Specifications by choosing the
layers, distance and number of steps. To view the Stepping, choose the Part
to view and then check Show Stepping.

Parts: Viewing one or all parts is possible through this control. View an
individual part on a multi-part form is as easy as selecting which part is to be
shown. See Chapter 8: Working with Color for details on designating parts.

Electronic Fields: Viewing Normal fields, Focus fields or No fields is possible
through this selection.

Pages: If the file is a multiple page composite file, or has pages linked through
the EForms "Multiple Page Tab", then you can click on the Page to view.

Page Background: There are times when the standard gray Page Background
Color can be hard to work with, especially when your form has a gray screen
already. White (0), shades of gray (1-99), or black (100).

View Zero Weight Lines: Displays all zero weight lines when checked.

View Hidden Components: Displays components that were selected with the
Change Visibility option.

View Color Chart: This allows you to see all colors available in OFDP through
a color chip chart. It displays the colors found in the /COLOR/FCP01 color
number list. Clicking on a color chip will display its FCP color number that
can be used in attribute dialogs for process color or drawing properties for
layer color.

Figure 5-30: View Color Chart
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Window Menu
The Window menu controls the viewing of the Toolbars, Status bar, and
Zooming.

Use Zoom to magnify an image when you are performing close detailed work.
When you use the Zoom Tools, you are not actually changing the size of a
document – only your view of the image. Enlarge and Reduce magnification
are the same as the tools.

The Window Center allows you to pick another portion of the drawing to be
the center of the screen. This allows panning around in the drawing area. You
can also cause the window to adjust to either the Height or the Width of the
form by selecting one of the Fit options: Fit Width and Fit Height.

The Fit all Data to Screen does just that. It will expand your file’s drawing
area to enclose all components, including any drawing components that are
visually off of the page. This can happen by accident when "Moving" or
"Copying" to the wrong location. You will be prompted to save it as your
current drawing properties.

Help Menu
The Help menu will take you to the on-line documentation through the Help
Option or the About OneForm Designer Plus which reports the software version
and options installed.
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CHAPTER 6

Working With Text
Forms have many varying text styles and sizes to make items fit. This chapter
describes how to use the Text options available. The following will be covered
in this chapter:

• Set Text Properties Tool

• Methods for Inputting Text

• Working with Interactive Text
• Interactive Text Pop-Up Menus 
• Importing ASCII Text
• Special Character Commands
• International Accented Character Commands

• Working with the Text Editor 
• Using Immediate Text Commands 
• Special Character Commands 
• Copying International Accented Characters

• Placing Text

• Check Spelling Tool

• Text Command References
• Immediate Commands
• Special Characters
• Accented Characters

Set Text Properties Tool

Figure 6-1: Set Text Properties Tool

Choosing the Text Properties tool on the Tool Bar will take you to the Set
Text Properties Dialog Box. By setting the values for the Input Text tool, you
can easily create any type of text needed. Setting text attributes is discussed
in depth in Chapter 4: Setting Component Attributes.

Text Attributes Readout

Figure 6-2: Font / Horizontal Size / Vertical Size / Composition Mode
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The Text Formatting Display is a quick reference to the Font Style, Font Size
and Composition Mode of text. When clicking on the Text Input Tool it
displays the current setups. Font characteristics cannot be changed here, it
references Text Properties. When editing text, it will display that component’s
font characteristics.

Methods for Inputting Text
There are two methods for inputting text: Interactive or through a Text Editor.
The Text Editor can be turned on by selecting the Text Editor Selector Tool.
When the Text Editor is off, the Interactive mode takes over.

Figure 6-3: Text Editor Selector Tool

The Interactive method inputs text directly onto the form and displays it
exactly as it will print. This method has pop-up menus for achieving special
text effects.

The Text Editor method will bring up Notepad to use as the text editor. There
is no pop-up menu available so special text effects are controlled through the
use of text commands.

Working with Interactive Text
Interactive Text will input text directly onto the form in the font and style
previously setup through Set Text Attributes. The display shows the exact
interaction of the text as it is input onto the form. This is why it is called
"Interactive" Text. If you need to turn on Interactive Text, toggle the Text
Selector tool.

To start inputting text interactively, choose the Text tool, the position of the
text and begin typing. When finished, click the right mouse button and select
Text Input Done. This ends your text input in the current text box, yet does
not turn off the Text tool. Once you have chosen Text Input Done, either pick
your next text position or toggle off the Text tool.

Interactive Text Pop-Up Menus

When creating with Interactive Text, special effects are accessed through a
pop-up menu. See Figure 6-4. The pop-up menu can be found by right clicking
when inputting. A description of the pop-up menu options are listed below.
These menus are conditionally displayed according to the action taking place.
Some menus only appear when text is highlighted.

Text Input Done: This ends your text input in the current text box, yet does
not turn off the Text tool. Once you have chosen Text Input Done, either pick
your next text position or toggle off the Text tool.
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Figure 6-4: Interactive Text and the Pop-Up Menu

Altering Properties Within a Paragraph

Font Set Immediate: This option is for changing your text characteristics
within a text string before typing the next word. For example, changing the
font from Normal to Bold can be accomplished by selecting this option. Its
dialog box will appear and its font style, size and layer can be modified. [Okay]
will put the changes into effect at the cursor position. This font change will
remain until it is changed back to Normal. You must again choose Font Set
Immediate and make the appropriate changes.

Figure 6-5: Font Set Immediate Dialog

Change Highlighted Text: If you wish to change the characteristics of a piece
of text, you may do so by choosing Change Highlighted Text in the pop-up
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menu after highlighting a piece of text. You may highlight text by clicking
on the first character to be highlighted and dragging the cursor until you reach
the last character. The [Shift]+[Arrow] keys can be used to highlight text, as
well. Once the text is highlighted, select Change Highlighted Text and choose
the new font style, size or layer. The dialog box is similar to Font Set
Immediate.

Figure 6-6: Switching Fonts Within a Text String

Inserting Text Commands

Insert Command inserts one of the following effects: New Line, Force Justify,
Horizontal Space, Horizontal Rule, Leader Fill, and Fraction. Once you have
chosen the command to insert, if a value is needed a dialog box will appear
for input of the value. For example, when Horizontal Rule is chosen, you must
input the length and line weight. These commands are always represented by
a red arrow while you are in the edit mode; the effect only appears after the
text is closed.

Figure 6-7: Insert Commands List

Insert Special Characters: Special Characters are text characters that are not
typically found on the keyboard such as stars, daggers, and bullets. The Special
Character layouts are broken down into categories: Basic Typesetting,
Accented Characters, Greek Characters, Math Characters, Arrows, etc. The
shortcut sequence [Ctrl]+[L] will also pull up the Special Character Selector
dialog.

To insert a Special Character, choose Insert Special Characters in the pop-up
menu. Choose a layout and then a character. [Okay] will insert the character
at the cursor position.
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Figure 6-8: Basic Typesetting Special Character Layout

Add Text Effects option only appears when text is highlighted. It allows the
highlighted word to have effects such as: Underline, Sub/SuperScript,
Graduated Color, Reverse, or Outline. Choosing the appropriate option is all
there is to it. These effects will not appear while you are in the edit mode;
the effect only appears after the text is closed. The properties for these options
are found in the Set and Modify Text Properties.

There are several ways to highlight text for use with Add Text Effects. You
may highlight text by clicking on the first character to be highlighted and
dragging the cursor until you reach the last character. The [Shift]+[Arrow]
keys can be used to highlight text, as well. Once the text is highlighted, select
Add Text Effects and choose one of the options and select [OK].

Figure 6-9: Add Text Effects Menu List
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Editing and Modifying Existing Text

There are many times when you will need to edit the content of existing text.
This can be easily achieved by choosing the Select tool and then the text item.
If you have the Text Editor on, you will edit in the Text Editor, Save and Exit,
and the edit will be composed.

If you have the Text Editor off, you will edit in the Interactive mode. Insert,
delete or highlight text to replace. When you have finished with your editing,
right click and choose Text Edit Done.

The properties for the text component are found on the pop-up menu under
Properties Change. This pop-up menu only appears while in Interactive mode.

Properties Change: This modifies properties of the selected text box.
Properties Change brings up the same dialog box as the Set Text Attributes
tool. Make your necessary changes and [Okay] to accept.

Up/Down Size: This option will modify the Point Size, Leading, Letter Space,
Word Space, and Measure of the entire text box. This dialog box only appears
when editing text. Arrows increase or decrease the value in increments of one.
[Okay] accepts the changes.

Importing ASCII Text

ASCII Text can be imported into OneForm Designer Plus from either the
Windows Clipboard or from a text (.txt) file. Both Text Input From Clipboard
and Text Input From File are found in the Text Tool’s pop-up menu.

Text from Clipboard inputs text from your Window’s clipboard. Here, you
are inserting text that had previously been Cut or Copied from another
application.

The Text from Clipboard dialog inputs either the whole clipboard or specific
paragraphs. You may arrow through the file and select the specific paragraph(s)
to input into your text box or Insert All.

Text from File: This inputs a .txt file. A .txt file is a text file that contains
no formatting. Most Word Processors have the ability to save in this format.
This works the same way as Text from Clipboard.

Since they work the same, we will just show Text Input From a File. Choose
the Text tool and a position on the form. Right-click and choose Text Input
From File. This will import a text (.txt) file. The Import File dialog will
appear. Search for the file to import and select [Okay].

At this point, a new dialog will appear. It will display one paragraph of text
at a time. Use the [Left] and [Right] Arrows to move through the text file.
Use the [Input Next] to input the paragraph displayed. [Input All] will input
the whole text file. [Done] will end the text input.
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Figure 6-10: Importing Text

International Accented Character Commands
Accented Characters can be input while in Interactive Text by either using the
pop-up option Insert Special Characters, or through a Accent Character
Command.

All characters supported with these commands are listed on page 191. This
list shows the command to produce the accented character. Accented characters
are produced through a three character command beginning with the @ symbol
and followed by the character’s keyboard sequence. The accented characters
can only be seen once the three characters have been input.

Following is an example of an Accented Character, the Character Name, along
with the Accent Character Command:

Accent Character: Á
Character Name: Aacute
Descriptive Name: Capital A with acute 
Keyboard Sequence Command: @’A

Accent Character: á
Character Name: aacute
Descriptive Name: Lower a with acute 
Keyboard Sequence Command: @’a

When the @ key is alone, the @ will print normally. When it is followed by
an acceptable character sequence, the accented character will print.
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Working with the Text Editor
The Text Editor is an alternative to Interactive Text. If you have used Amgraf’s
MECCA Systems, you will most likely find this to be the easiest transition
into text. Selecting Text Editor as your means of editing, invokes Notepad
while working with text.

You may enter text using all of the notepad features such as the [Del], [Arrow]
keys, [Insert], [Page Up] and [Down] along with cut and paste. Also, the text
can have embedded MECCA Immediate Composition Commands.

Note: If you are using Windows NT, it is likely that you will receive an error
when using the Text Editor. The problem lies in the location of the Notepad.exe
in Windows NT versus Windows. OneForm Designer looks for the Notepad
in a directory named C:\WINDOWS. In the NT, there is no such directory.
The fix is to create a folder directly under the C drive called WINDOWS and
copy the Notepad.exe into this folder. This should take care of the problem.

The text will appear in the current font attributes only after Notepad has been
closed and saved. Every occurence of text input and editing will open Notepad
and display the text as keystrokes and command sequences.

When using the Text Editor, you change the internal characteristics of the text
through commands, not pop-up menus. There is an opportunity directly after
Notepad has been closed and the text component is still selected to get to the
Properties Change pop-up menu.

Figure 6-11: Text Editor Allows Immediate Commands

This option will change the properties of the entire paragraph with any internal
font changes being accomplished through commands. These commands are
the same commands used with our MECCA Software.
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Using Immediate Text Commands
Immediate Commands are input directly through the Text Editor. Immediate
commands are used for special effects such as emphasis on words, phrases or
paragraphs. They are called Immediate commands because they take action
immediately. When using a special effect command, insert the desired
command at the position in the text where the effect should begin. Inputting
the command will place or modify text at the cursor position. Use another
command to reset the effect back at the point where the effect should cease.
All Immediate commands are automatically canceled each time a new
paragraph begins.

The command format is a backslash (\), followed by the characters representing
the command and ended by a caret (^). A command for bold would appear:

Input: This is an example of the \B^Bold Text Command.

Output: This is an example of the Bold Text Command.

The complete Immediate Command list along with usage starts on page 146.

Special Character Commands
Special characters are those characters that are in the font but do not appear
on your keyboard. For example, bullets and stars are not on your keyboard
but they are characters that you can access.

You may set a character while in the Text Editor by using our Special Character
command. This Special character command always starts with a backslash (\)
and ends with a caret (^).

To ask for a bullet you would look through the Special character access chart,
find the bullet and look at its assigned position number. A bullet happens to
be 121 in the list. Typing in \121^ will output a bullet. It will not display on
the graphics screen until you exit the text box.

Following are examples of commonly used Special Character Commands:

\80^ —
\81^ –
\111^ ©
\121^ •

A Special Character Chart for Helvetica can be found on page 183.
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Copying International Accented Characters
Any special character or international accented character can be copied using
the Windows Character Map.

When working in the Text Editor, you can open your Character Map to access
Accented characters. Double-click on the character(s) you wish to insert in the
Character Map. Notice the character is displayed in Characters to Copy . Once
you have selected the character(s), click on the [Copy] button. Finally, pick
a position in your Text Editor and Paste.

Figure 6-12: Windows Character Map Can Access International Characters
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Placing Text
Now that we know how to Set Text Attributes and Input Text, we are ready
to begin positioning text correctly. There are three methods for placing text:

• Text Input Tool - Mark Anchor Position

• Mark Left and Right Position

• Place Text in Boxes

The Text Input Tool can be accessed on the Tool Bar; while the other two
options can only be accessed through the Text option under the Draw Menu.

Text Input Tool (Mark Anchor Position)
The Text Input tool is the same as the Draw menu option, Mark Anchor
Position. This option is most widely used.

Using the Text Input tool requires that you simply pick a position and start
typing. To quit out of text input, toggle off the Text Input tool.

With this option, remember that before picking a position, you can use any of
the Position Assistant options for cursor placement. Also, the position that
you do pick is always in relationship to the text composition mode attribute.

MECCA III brings the benefits of electronic publishing technology
within reach of every business. The powerful stand-alone desktop
workstation provides real-time interactive page composition,
including graphics. Designed for use by forms composers, graphic
artists, typesetters, and technical writers,

Flush Left

MECCA III brings the benefits of electronic publishing technology
within reach of every business. The powerful stand-alone desktop

workstation provides real-time interactive page composition,
including graphics. Designed for use by forms composers,

graphic artists, typesetters, and technical writers,

Flush Right

MECCA III brings the benefits of electronic publishing technology
within reach of every business. The powerful stand-alone desktop
workstation provides real-time interactive page composition,
including graphics. Designed for use by forms composers, graphic
artists, typesetters, and technical writers,

Justified

MECCA III brings the benefits of electronic publishing technology
within reach of every business. The powerful stand-alone desktop

workstation provides real-time interactive page composition,
including graphics. Designed for use by forms composers,

graphic artists, typesetters, and technical writers,

Centered

Figure 6-13: Examples of Composition Modes and Pick Points

Mark Left and Right Position
Mark Left and Right Position can be accessed under the Draw menu. Use this
option if you need to visually specify the right margin. It requires two picks
that will define the starting point of your text and the width of the text box.

To use Mark Left and Right Position, pick the upper-left position of the text
box. Notice the rectangular area following the cursor. Next, pick the position
that will represent the right margin. This is the lower-right corner of the text
box. Your cursor will appear so that you may begin typing.
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Place Text in Boxes
The Place Text in Boxes option uses a dynamic rectangle to provide two
corners of a region in which it looks for rectangular box shapes. The positions
it finds will be portrayed on the screen by a red diagonal line drawn through
each location.

This function is devised to assist in the placement of text items into pre-drawn
boxes. In forms, horizontal and vertical rules often divide the body of the form
into individual rectangular boxes. Each of these boxes can serve to provide a
location for the positioning of text.

Begin by choosing the Place Text in Boxes option. It can be found under the
Draw menu. Its properties dialog box will automatically appear.

Figure 6-14: Place Text in Boxes

Setting Attributes for Text Positions

The Gutters Setting attributes for text positions is controlled through the
Attributes menu. The dialog automatically appears once Place Text in Boxes
is selected as shown above.

Before text items can be composed and positioned into boxes, a number of
controlling attributes must be set. Please note that attribute settings have been
provided default values and that you are not required to set them every time
you position text items. But if you desire settings different from the default
or different from those used in the last session, you should change them before
drawing.
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Gutters

Within the rectangular text box you may set gutter values for all 4 sides. The
gutters are then used in calculating the positions for those modes where the
text would touch the side of the box, such as flush left.

Composition Modes

This function lets you set both horizontal and vertical composition modes. A
drop-down list will appear showing your choices:

Horizontal Modes: Flush Left, Centered, Flush Right 
Vertical Modes: Flush Top, Centered, Flush Bottom

Pick on your desired modes and then pick [Okay] to finalize the settings. If
you wish to edit these properties, you may do so by choosing Set Comp
Modes/Gutters. Be aware that it will only edit the Composition Mode and
Gutters for boxes about to be drawn and not existing text.

Using Place Text in Boxes
Now that the attributes have been set, you are ready to determine the position
of your text. Drawing multiple text positions is just as easy as picking two
diagonal corners. This function uses the dynamic rectangle to provide two
corners of a region within which it looks for rectangular box shapes. The
positions will be visually displayed on the screen by a red diagonal line drawn
through each box location.

Immediately pick around a row or column of boxes. Red diagonal lines will
appear similar to what is shown below.

Figure 6-15: Defining Text Positions
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After you have picked the 2nd the corner of the text box, the software attempts
to find horizontal and vertical rules inside (or intersected by) the rectangle
you gave. The program determines the direction (i.e., from left to right or from
top to bottom) to construct text positions, based on the aspect of the rectangle
that you provided. If you drew a horizontal rectangle, positions will go from
left to right; if your rectangle is vertically longer than its horizontal side, then
the text positions will go from top to bottom.

You should note that the program will build at most "one strip" of text
positions. For example, you have a grid that looks like this:

Figure 6-16: Text Input Through Text Positions

and you give a horizontal dynamic rectangle covering the entire region, only
the top row of 4 boxes will be chosen. You may continue selecting text areas
one strip at a time until you are finished, in which case you should right-click
to choose Start Inputting Text . You are now ready to input text.

The [Return] key moves the cursor to the next line, while the [Tab] key moves
it to the next box. When you have finished, choose the pop-up option Quit
Text Box Completely. 

As you can see, Place Text in Boxes is faster and definitely more efficient
than the Input Text tool. The positioning is done without you having to use
the Position Assistants or moving the text.

Pop-up Menu Choices for Place Text in Boxes

Start Inputting Text: You must choose Start Inputting Text in order to begin
text input when using Place Text in Boxes.

Backup Last Selection: This is for placing Multiple Text Positions. This
returns your cursor to the previous text box for editing.

Edit Box List: This edits or removes a text box within your series of multiple
text boxes. Click on a red diagonal line to remove the box. Click on a red
vertical or horizontal line in order to edit its size or combine two boxes. This
will remove the line and change the dimensions of the box.

Continue Defining Boxes: This returns you to defining the Multiple Text
Positions.

Restart Box Text Definitions: This function removes the previous text
positions and allows you to redefine the multiple Text Positions.
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Set Comp Modes/Gutters: This edits the Composition Modes and Gutters
that had previously been set in the Set Multiple Text Positions Properties
dialog. Note: This does not alter the composition mode and gutters for existing
text boxes, but changes these properties for new text.

Quit Box Text Input Completely: This ends your Session in multiple text
positions.

Check Spelling Tool

Figure 6-17: Check Spelling Tool

Choose the Check Spelling Tool to check the spelling of the entire form. To
check the spelling of a single text item, simply pick the piece of text with the
Select cursor and then the Check Spell tool. It will run through the entire text
paragraph and give you replacement choices for any misspellings.

Text Command References

The following pages contain examples and usage for all accepted commands
including Immediate Commands, Special Characters, and International
Accented Characters.

Immediate Commands

Immediate Commands can be input directly through the Text Editor and are
used for special effects such as emphasis on words, phrases or paragraphs.
They are called Immediate commands because they take action immediately.
When using a special effect command, insert the desired command at the
position in the text where the effect should begin. Inputting the command will
place or modify text at the cursor position. Use another command to reset the
effect back at the point where the effect should cease. Immediate commands
only effect the current text component and are canceled out at the end of the
text component.

The command format is a backslash (\), followed by the characters representing
the command and ended by a caret (^). A command for bold would appear:

Input: This is an example of the \B^Bold Text Command.

Output: This is an example of the Bold Text Command.
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Alphabetical List of Immediate Text Commands

Automatic Fraction . . . . . . . . . . . .
Bold . . . . . . . . . . . . . . . . . . . . .
Bold Italic . . . . . . . . . . . . . . . . . .
Backup Center . . . . . . . . . . . . . . .
Backup Flush . . . . . . . . . . . . . . .
Black . . . . . . . . . . . . . . . . . . . .
Black Italic . . . . . . . . . . . . . . . . .
Change Font . . . . . . . . . . . . . . . .
Change Color . . . . . . . . . . . . . . . .
Change Mode . . . . . . . . . . . . . . .
Down for Subscript . . . . . . . . . . . .
Move Baseline Down . . . . . . . . . . .
First Point Size Reset . . . . . . . . . . .
Leader Fill – Default . . . . . . . . . . . .
Force Justify Line . . . . . . . . . . . . .
Horizontal Rule . . . . . . . . . . . . . .
Horizontal Space Relative . . . . . . . .
Horizontal Space Absolute . . . . . . . .
Horizontal Size . . . . . . . . . . . . . . .
Heavy . . . . . . . . . . . . . . . . . . . .
Heavy Italic . . . . . . . . . . . . . . . . .
Light . . . . . . . . . . . . . . . . . . . . .
Light Italic . . . . . . . . . . . . . . . . .
Line Leading . . . . . . . . . . . . . . . .
Change Layer . . . . . . . . . . . . . . .
Medium . . . . . . . . . . . . . . . . . . .
Medium Italic . . . . . . . . . . . . . . . .
Normal . . . . . . . . . . . . . . . . . . .
Italic . . . . . . . . . . . . . . . . . . . . .
New Line . . . . . . . . . . . . . . . . . .
Outline Type . . . . . . . . . . . . . . . .
Cancel Outline Type . . . . . . . . . . . .
Point Size . . . . . . . . . . . . . . . . . .
Reset for Super/Subscript . . . . . . . .
Thin . . . . . . . . . . . . . . . . . . . . .
Thin Italic . . . . . . . . . . . . . . . . . .
Tilde Character . . . . . . . . . . . . . .
Up for Superscript . . . . . . . . . . . . .
Move Baseline Up . . . . . . . . . . . . .
Underline Start . . . . . . . . . . . . . . .
Underline End . . . . . . . . . . . . . . .
Very Light . . . . . . . . . . . . . . . . . .
Very Light Italic . . . . . . . . . . . . . .
Vertical Size . . . . . . . . . . . . . . . .
Extra Bold . . . . . . . . . . . . . . . . .
Extra Bold Italic . . . . . . . . . . . . . .

\A (space) n/n^ . . . . . . . . . . . 149
\B^ . . . . . . . . . . . . . . . . . . . 150
\BI^ . . . . . . . . . . . . . . . . . . 150
\BC^ . . . . . . . . . . . . . . . . . . 151
\BF^ . . . . . . . . . . . . . . . . . . 152
\BK^ . . . . . . . . . . . . . . . . . . 153
\BKI^ . . . . . . . . . . . . . . . . . 153
\CF (space) aa^ . . . . . . . . . . . 154
\CLR n^ . . . . . . . . . . . . . . . . 155
\CM (space) aa^ . . . . . . . . . . . 156
\D^ . . . . . . . . . . . . . . . . . . . 157
\DN unit^ . . . . . . . . . . . . . . . 158
\F^ . . . . . . . . . . . . . . . . . . . 159
\FILL^ . . . . . . . . . . . . . . . . . 160
\FJ^ . . . . . . . . . . . . . . . . . . 161
\HR unit,unit^ . . . . . . . . . . . . 162
\HSA unit^ . . . . . . . . . . . . . . 163
\HSPA unit^ . . . . . . . . . . . . . 164
\HSZ unit^ . . . . . . . . . . . . . . 165
\HV^ . . . . . . . . . . . . . . . . . . 166
\HVI^ . . . . . . . . . . . . . . . . . 166
\L^ . . . . . . . . . . . . . . . . . . . 167
\LI^ . . . . . . . . . . . . . . . . . . . 167
\LEAD and \LD unit^ . . . . . . . . 168
\LYR n^ . . . . . . . . . . . . . . . . 169
\M^ . . . . . . . . . . . . . . . . . . . 170
\MI^ . . . . . . . . . . . . . . . . . . 170
\N^ . . . . . . . . . . . . . . . . . . . 171
\I^ . . . . . . . . . . . . . . . . . . . 171
\NL^ . . . . . . . . . . . . . . . . . . 172
\OL^ . . . . . . . . . . . . . . . . . . 173
\XOL^ . . . . . . . . . . . . . . . . . 173
\PSZ unit^ . . . . . . . . . . . . . . 174
\R^ . . . . . . . . . . . . . . . . . . . 175
\TH^ . . . . . . . . . . . . . . . . . . 176
\THI^ . . . . . . . . . . . . . . . . . 176
~ . . . . . . . . . . . . . . . . . . . . 177
\U^ . . . . . . . . . . . . . . . . . . . 178
\UP unit^ . . . . . . . . . . . . . . . 179
\US^ . . . . . . . . . . . . . . . . . . 180
\UE^ . . . . . . . . . . . . . . . . . . 180
\VL^ . . . . . . . . . . . . . . . . . . 181
\VLI^ . . . . . . . . . . . . . . . . . . 181
\VSZ unit^ . . . . . . . . . . . . . . 182
\XB^ . . . . . . . . . . . . . . . . . . 183
\XBI^ . . . . . . . . . . . . . . . . . 183
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AUTOMATIC FRACTION

\A

Purpose: Allows fractions to be created with minimal coding. A
numerator and denominator is set with the fraction bar
character replacing the forward slash.

Format: \A (space) n/n^

Arguments: n/ is the numerator of the fraction

and

n^ is the denominator of the fraction.

Example: In this example, the \A 1/2^ fraction command will
produce the one-half fraction. (There must be a
wordspace between the \A and the fraction itself.)

Input: The carpet measures 16\A 1/2^ feet, not
16\A 3/4^ feet.

Output: The carpet measures 161⁄2 feet, not 163⁄4 feet.

Default: The default font is Helvetica.
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BOLD and BOLD ITALIC \B^

\BI^

Purpose: These are the two type style commands for Bold and
Bold Italic. Bold is a thicker version of the normal
type style, while Bold Italic is a slanted thicker
version. Both of these commands will stay in effect
until another style command is encountered within the
text component.

Format: \B^ and \BI^

Argument: None

Example: In the examples below, notice the command is
connected to the word it is changing.

Input: Use the \B^Bold Command \N^to place emphasis
on words or sentences. \BI^Here we are using
the Bold Italic Command.

Output: Use the Bold Command to place emphasis
on words or sentences. Here we are using
the Bold Italic Command.

List of
Type Styles: \VL^ Very Light \VLI^ Very Light Italic

\TH^ Thin \THI^ Thin Italic
\L^ Light \LI^ Light Italic
\N^ Normal \I^ Italic
\M^ Medium \MI^ Medium Italic
\B^ Bold \BI^ Bold Italic
\XB^ Extra Bold \XBI^ Extra Bold Italic
\HV^ Heavy \HVI^ Heavy Italic
\BK^ Black \BKI^ Black Italic

Note: Type styles are dependent on availability of that style
on your system. If you select a style that is not
available, the system will default to the closest match:
normal, bold, or italic.
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BACKUP CENTER

\BC^

Purpose: This command allows any character or number to back
up and center itself on top of the previous character.
The two different character widths are centered by the
wider character.

Format: \BC^

Argument: None

Example: The command looks for the character following it and
centers that character on the character before it.

Input: My brother’s ham radio handle is 
WO\BC^/LFMAN.

Output: My brother’s ham radio handle is 
WO/ LFMAN.

Related 
Command: \BF^

BACKUP FLUSH
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BACKUP FLUSH

\BF^

Purpose: This command allows any character or number to back
up the full distance of the previous character giving a
flush-left effect.

Format: \BF^

Argument: None

Example: The Special Character numbers are \316^ = ⎡ and \317^
= ⎣. Check your Special Characters Tables for the
correct numbers for your system.

Input: \316^\BF^\DN60^\317^

Output: ⎡
⎣

Related 
Command: \BC^

BACKUP CENTER
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BLACK and BLACK ITALIC \BK^

\BKI^

Purpose: These are the two type style commands for Black and
Black Italic. Black is a thicker version of the bold
type style, while Black Italic is a slanted thicker
version. Both of these commands will stay in effect
until another style command is encountered within the
text component.

Format: \BK^ and \BKI^

Argument: None

Example: In the examples below, notice the command is
connected to the word it is changing.

Input: Use the \BK^Black Command \N^to place
emphasis on words or sentences. \BKI^Here we
are using the Black Italic Command.

Output: Use the Black Command to place emphasis
on words or sentences. Here we are using
the Black Italic Command.

List of
Type Styles: \VL^ Very Light \VLI^ Very Light Italic

\TH^ Thin \THI^ Thin Italic
\L^ Light \LI^ Light Italic
\N^ Normal \I^ Italic
\M^ Medium \MI^ Medium Italic
\B^ Bold \BI^ Bold Italic
\XB^ Extra Bold \XBI^ Extra Bold Italic
\HV^ Heavy \HVI^ Heavy Italic
\BK^ Black \BKI^ Black Italic

Note: Type styles are dependent on availability of that style
on your system. If you select a style that is not
available, the system will default to the closest match:
normal, bold, or italic.
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CHANGE FONT

\CF

Purpose: Enables user to Change Font, at the beginning of, or
within a text paragraph.

Format: \CF (space) aa^

Argument: aa are the mnemonics assigned to your fonts. AG
for Avant Garde and TI for Times Roman.
These commands will override the font setup
and stay in effect until another command is
encountered or the text component ends.

Example: Notice in the example below the wordspace between the
\CF and the Font Mnemonic. The command will not be
recognized without it.

Input: \CF AG^Text will be in Avant Garde.
\CF TI^Text will be in Times Roman.

Output: Text will be in Avant Garde.
Text will be in Times Roman.
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CHANGE COLOR

\CLR

Purpose: This command allows the user to assign text a different
color, immediately within a sentence. And if needed, to
switch back again.

Format: \CLR n^

Argument: n is the color number assigned to the text
following.

Example: Color Number 485 is red.

Input: Every good \CLR 485^ boy \CLR 0^does fine.

Output:
(Black)

Every good does fine.

Output:
(Magenta)

Output:
(Yellow)

boy

boy

Default: 0

Related
Command:

\LYR
LAYER

Note: This command references the color numbers set in the
Drawing Properties. The table that controls the defaults
is located under the OneForm directory /COLOR/fcp01. 
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CHANGE MODE

\CM

Purpose: Enables the user to change the composition mode of a
paragraph. The composition mode controls how the text
will set between the left and the right margins. This
command controls the whole paragraph; the last
composition mode change read, will be the one used.

Format: \CM (space) aa^

Argument: n is the new composition mode.

The options are:

FL Flush to the Left Margin
CE Center
FR Flush to the Right Margin
JU Justify at Both Margins

Example: Below are examples of the six composition modes along
with how to input the command.

Input: \CM CE^MECCA III brings the benefits.....

MECCA III brings the benefits of electronic publishing technology
within reach of every business. The powerful stand-alone desktop
workstation provides real-time interactive page composition,
including graphics. Designed for use by forms composers, graphic
artists, typesetters, and technical writers,

Flush Left

MECCA III brings the benefits of electronic publishing technology
within reach of every business. The powerful stand-alone desktop

workstation provides real-time interactive page composition,
including graphics. Designed for use by forms composers,

graphic artists, typesetters, and technical writers,

Flush Right

MECCA III brings the benefits of electronic publishing technology
within reach of every business. The powerful stand-alone desktop
workstation provides real-time interactive page composition,
including graphics. Designed for use by forms composers, graphic
artists, typesetters, and technical writers,

Justified

MECCA III brings the benefits of electronic publishing technology
within reach of every business. The powerful stand-alone desktop

workstation provides real-time interactive page composition,
including graphics. Designed for use by forms composers,

graphic artists, typesetters, and technical writers,

Centered
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DOWN FOR SUBSCRIPT

\D^

Purpose: This command allows the user to immediately create
subscripts. It lowers the baseline and reduces the
current point size by 50% for the characters following
the command.

Format: \D^

Argument: None

Example: The subscript command is reset with the \R^ RESET
Command.

Input: One atom of hydrogen-1 has a mass of
1.67 x 10\D^24 \R^g.

Output: One atom of hydrogen-1 has a mass of
1.67 x 1024 g.

Related 
Commands: \F^

FIRST POINT SIZE RESET

\R^
RESET FOR SUPER/SUBSCRIPT

\U^
UP FOR SUPERSCRIPT

Note: Controls for these commands are found under the Set
Text Attributes Tool and Text Properties Change.
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MOVE BASELINE DOWN

\DN

Purpose: This command allows the user to immediately lower the
baseline of the text line following it for that paragraph
only.

Format: \DN unit^

Argument: unit is the amount the baseline is to be lowered.

Example: In our example, notice that the second line also moved
down.

Input: To move a line \DN 3.5p^DOWN just use the
immediate down command.

Output: To move a line DOWN just use the
immediate down command.

The original positioning is restored
at the end of the text item.

Related
Command: \UP unit^

MOVE BASELINE UP
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FIRST POINT SIZE RESET

\F^

Purpose: This command resets the point size and baseline, after
super/subscript, back to the original type size and
baseline. When utilizing more than one level of sizes
(such as a superscript between subscripts), this
command will automatically reset the type back to the
original level before it encountered the first
super/subscript.

Format: \F^

Argument: None

Example: In the example we are using both the \F^ and \R^
Commands to achieve the effect needed.

Input: Levels of super/subscripts are easy:
1.11 \D^22\U^33\R^ 22 \F^1.11.

Output: Levels of super/subscripts are easy:
1.11 223322 1.11.

Related
Commands: \D^

DOWN FOR SUBSCRIPT

\R^
RESET FOR SUPER/SUBSCRIPT

\U^
UP FOR SUPERSCRIPT

Note: Controls for these commands are found under the Set
Text Attributes Tool and Text Properties Change.
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LEADER FILL – DEFAULT

\FILL^

Purpose: Allows a pattern of leader dots to be drawn between
text pieces in a paragraph or table. The purpose of the
\FILL^ command is to fill remaining space in a measure
with the leader dots.

When the \FILL^ command occurs in a line, the text to
the left of the command will set flush left and the text
to the right of the command will set flush right. With
any remaining space being taken up by the fill. If more
than one \FILL^ command is in a given line, they will
divide equally the remaining space on the line.

The composition mode of the text item using the fill
must be either Flush Left (FL) or Justified (JU). If you
want a designated line break, you must use the \NL^
NEW LINE command to break the line. Otherwise, the
\FILL^ command will break the lines as normal and use
the remaining space to fill. In the case of justified lines
there is no remaining space, so a \FJ^ command to
control the line break is
absolutely necessary. On any line that contains a \FILL^
command, the line will fill the measure.

Format: \FILL^

Argument: None

Example: This is the default format of the \FILL^ command. This
will produce a leader dot pattern made up of the period
character of the current font spaced at 6 points between
with a 6 point gutter at each end. It will pick up the
style of the associated paragraph.

Input: This is the default\FILL^ leader fill.

Output: This is the default . . . . . . . . . . . . . . . leader fill.
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FORCE JUSTIFY LINE

\FJ^

Purpose: Enables the user to immediately force the current line to
end and be justified, with all remaining text to start
composing on the next baseline.

Format: \FJ^

Argument: None

Examples: This is how the paragraphs look without using the
FORCE JUSTIFY LINE command and letting the lines
justify normally.

Input: BEHAVIOR OF GOOD BOYS

Every good boy does fine most of the time. It
is hard to do good behavior all of the time.

Output: BEHAVIOR OF GOOD BOYS

Every good boy does fine most of the time. It is hard to
do good behavior all of the time.

Using the \FJ^ command causes the right
margin to justify regardless of the current
wordspacing controls.

Input: BEHAVIOR OF GOOD BOYS\FJ^

Every good boy does fine most of the time. It
is\FJ^hard to do good behavior all of the
time.

Output: BEHAVIOR OF GOOD BOYS

Every good boy does fine most of the time. It is
hard to do good behavior all of the time.

Note: This command will not squeeze items to fit in a certain
line measure. It only expands wordspacing. Even after
the FORCE JUSTIFY is removed the wordspacing
controls for that piece stays set to the larger value. You
will need to change NOM wordspacing afterwards to
36.
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HORIZONTAL RULE

\HR

Purpose: Allows the user to draw a horizontal rule within a
paragraph or table. It is used for "fill-in-the-blank" type
material.

Format: \HR unit,unit^

Arguments: unit, is the length of the rule

and

unit^ is the height (or weight) of the rule.

Remarks: This command draws a horizontal rule the specified
length from the current position. Paragraph or table
margins are used to control the starting position. The
command must be within a Text Item, it cannot sit
alone.

Example: In this example, the \HR command will produce a line
one inch long with a thickness of one point.

Input: I hereby certify the above to be true
to the best of my knowledge on
the \HR .5i,1p^ day of April, 2000.

Output: I hereby certify the above to be true to the best of my
knowledge on the  day of April, 2000.
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HORIZONTAL SPACE RELATIVE

\HSA

Purpose: Enables the user to move Horizontal Space Relative to
current position.

Format: \HSA unit^

Argument: unit is the amount to move from current position

Remarks: This command moves text a specified amount by using
an X coordinate (positive or negative), relative to the
text’s current position. In the example below, a
HORIZONTAL SPACE RELATIVE command is used
to open up space in a line.

Example: Input: There are\HSA 24p^U.S. dry pints per
British Imperial fluid ounce.

Output: There are U.S. dry pints per British Imperial fluid
ounce.

In the example below, the command is used to close
space between the A and V characters. There are
KERNING controls for this, but for those cases where
kerning tables are not available, the negative HSA is
useful.

Input: \PSZ 36p^SA\HSA -7p^VE

Output: SAVE
Notes: This command can also be used to match the emspace,

enspace, and thin space characters in other systems. The
emspace is usually 100% of a given point size. The
enspace is 60% of the point size and a thin space is
30%.
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HORIZONTAL SPACE ABSOLUTE

\HSPA

Purpose: Enables the user to move horizontally from the left
margin to a fixed position.

Format: \HSPA unit^

Argument: unit is the amount to move from left margin

Remarks: This command moves text a specified amount by using
an X coordinate (positive only), absolutely from the left
margin of the Text Item. In the example below, a
HORIZONTAL SPACE ABSOLUTE command is used
to create two columns and yet linking the items together
within one paragraph.

Example: Input: 01009 \HSPA 1i^ Kearny\NL^
0298CX \HSPA 1i^ Rockaway\NL^
0299CZ \HSPA 1i^ Belleville\NL^
03AAZ \HSPA 1i^ Springfield

Output: 01009 Kearny
0298CX Rockaway
0299CZ Belleville
03AAZ Springfield

Remarks: If the absolute position has already been passed before
encountering the command, then a line break will be
forced and the position will be honored on the next
line.
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HORIZONTAL SIZE

\HSZ

Purpose: Enables the user to alter Horizontal Size of type.

Format: \HSZ unit^

Argument: unit is width of type in any unit

Remarks: This command alters horizontal set width; can condense
or expand: \HSZ 8p^ = horizontal size of 8 points, and
\HSZ 14p^ = horizontal size of 14 points.

Example: Input: \HSZ 8p^You are reading an example of 8-point
condensed type.

\HSZ 14p^You are reading an example of
14-point expanded type.

Output: You are reading an example of 8-point condensed type.

You are reading an example of
14-point expanded type.

Related
Commands: \PSZ unit^

POINT SIZE

\VSZ unit^
VERTICAL SIZE
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HEAVY and HEAVY ITALIC \HV^

\HVI^

Purpose: These are the two type style commands for Heavy and
Heavy Italic. Heavy is usually considered a very thick
version of the bold type style, while Heavy Italic is a
slanted version. Both of these commands will stay in
effect until another style command is encountered
within the text component.

Format: \HV^ and \HVI^

Arguments: None

Example: In the examples below, notice the command is
connected to the word it is changing.

Input: Use the \HV^Heavy Command \N^to place
emphasis on words or sentences. \HVI^Here we
are using the Heavy Italic Command.

Output: Use the Heavy Command to place emphasis on words
or sentences. Here we are using the Heavy Italic
Command.

List of
Type Styles: \VL^ Very Light \VLI^ Very Light Italic

\TH^ Thin \THI^ Thin Italic
\L^ Light \LI^ Light Italic
\N^ Normal \I^ Italic
\M^ Medium \MI^ Medium Italic
\B^ Bold \BI^ Bold Italic
\XB^ Extra Bold \XBI^ Extra Bold Italic
\HV^ Heavy \HVI^ Heavy Italic
\BK^ Black \BKI^ Black Italic

Note: Type styles are dependent on availability of that style
on your system.
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LIGHT and LIGHT ITALIC \L^

\LI^

Purpose: These are the two type style commands for Light and
Light Italic. Light is a thinner version of the normal
type style, while Light Italic is a slanted thinner
version. Both of these commands will stay in effect
until another style command is encountered within the
text component.

Format: \L^ and \LI^

Arguments: None

Example: In the examples below, notice the command is
connected to the word it is changing.

Input: Use the \L^Light Command \N^to place emphasis
on words or sentences. \LI^Here we are using
the Light Italic Command.

Output: Use the Light Command to place emphasis on words or
sentences. Here we are using the Light Italic Command.

List of
Type Styles: \VL^ Very Light \VLI^ Very Light Italic

\TH^ Thin \THI^ Thin Italic
\L^ Light \LI^ Light Italic
\N^ Normal \I^ Italic
\M^ Medium \MI^ Medium Italic
\B^ Bold \BI^ Bold Italic
\XB^ Extra Bold \XBI^ Extra Bold Italic
\HV^ Heavy \HVI^ Heavy Italic
\BK^ Black \BKI^ Black Italic

Note: Type styles are dependent on availability of that style
on your system. If you select a style that is not
available, the system will default to the closest match:
normal, bold, or italic.
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LINE LEADING \LEAD

\LD

Purpose: Enables the user to change Line Leading within a
paragraph. There are two commands:

\LEAD is the baseline-to-baseline leading for the entire
paragraph, regardless of where within the paragraph it
is encountered.

\LD takes affect after the line in which it is
encountered. It is an additional leading (positive or
negative value) that affects all subsequent lines unless
another \LD command is issued. There can be multiple
\LD commands in one paragraph item.

Format: \LEAD unit^

Argument: unit is line leading from baseline to baseline.

Example: Input: This is an\PSZ 8p^\LEAD 9p^example of the
pointsize and leading command used to change
the set size and leading. Remember the LEAD
command affects the entire paragraph.

Output: This is an example of the pointsize and leading
command used to change the set size and leading.
Remember the LEAD command affects the entire
paragraph.

Format: \LD unit^

Argument: unit is a positive or negative amount to add to
existing lead value.

Input: Dr. John Mercers\NL^
\PSZ 8p^\LD -3p^Seaport Towers, Suite 110\NL^
3904 Main Street\NL^
Kansas City, Missouri 64111\LD 5p^\NL^
\PSZ 12p^General Surgery

Output: Dr. John Mercers
Seaport Towers, Suite 110
3904 Main Street
Kansas City, Missouri 64111

General Surgery
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CHANGE LAYER

\LYR

Purpose: Enables the user to change Layer immediately within a
text string.

Format: \LYR n^

Argument: n is a number from 1 to 32, which is the new
layer number of the text to follow.

Example: Input: Every good \LYR 2^ boy \LYR 1^does fine.

Output: 
(Layer 1)

Every good  does fine.

Output: 
(Layer 2)

boy

Default: Layer 1
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MEDIUM and MEDIUM ITALIC \M^

\MI^

Purpose: These are the two type style commands for Medium
and Medium Italic. Medium is usually a slightly
thicker version of the normal type style, while Medium
Italic is a slanted thicker version. Both of these
commands will stay in effect until another style
command is encountered within the text component.

Format: \M^ and \MI^

Arguments: None

Example: In the examples below, notice the command is
connected to the word it is changing.

Input: Use the \M^Medium Command \N^to place
emphasis on words or sentences. \MI^Here we
are using the Medium Italic Command.

Output: Use the Medium Command to place emphasis on
words or sentences. Here we are using the Medium
Italic Command.

List of
Type Styles: \VL^ Very Light \VLI^ Very Light Italic

\TH^ Thin \THI^ Thin Italic
\L^ Light \LI^ Light Italic
\N^ Normal \I^ Italic
\M^ Medium \MI^ Medium Italic
\B^ Bold \BI^ Bold Italic
\XB^ Extra Bold \XBI^ Extra Bold Italic
\HV^ Heavy \HVI^ Heavy Italic
\BK^ Black \BKI^ Black Italic

Note: Type styles are dependent on availability of that style
on your system. If you select a style that is not
available, the system will default to the closest match:
normal, bold, or italic.
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NORMAL and ITALIC \N^

\I^

Purpose: These two type style commands allow the user to
change to a NORMAL type style or the ITALIC
(slanted) version of the normal type style. Normal is the
most commonly used type style and is the system
default. Both of these commands will stay in effect
until another style command is encountered within the
text component.

Format: \N^ and \I^

Arguments: None

Example: Input: \I^Use the \N^Normal Command to get back to
the regular type style, \I^after placing
emphasis \N^on words or sentences with
another type style. \I^Slanted type is the
italic type style.

Output: Use the Normal Command to get back to the regular
type style, after placing emphasis on words or
sentences with another type style. Slanted type is the
italic type style.

List of
Type Styles: \VL^ Very Light \VLI^ Very Light Italic

\TH^ Thin \THI^ Thin Italic
\L^ Light \LI^ Light Italic
\N^ Normal \I^ Italic
\M^ Medium \MI^ Medium Italic
\B^ Bold \BI^ Bold Italic
\XB^ Extra Bold \XBI^ Extra Bold Italic
\HV^ Heavy \HVI^ Heavy Italic
\BK^ Black \BKI^ Black Italic

Note: Type styles are dependent on availability of that style
on your system.
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NEW LINE

\NL^

Purpose: Enables the user to immediately force the current line to
end and all remaining text to start composing on the
next baseline.

Format: \NL^

Argument: None

Example: Input: Mr. George Jones\NL^
1115 Grand Ave.\NL^
Kansas City, MO 64109

Output: Mr. George Jones
1115 Grand Ave.
Kansas City, MO 64109

Note: The NEW LINE command overrides line justification.
When the composition program encounters a NEW
LINE command, the system immediately stops that line
of text (without justifying the line) and drops down to
the next baseline.

Related
Command: \FJ^

FORCE JUSTIFY LINE
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OUTLINE TYPE \OL^

\XOL^

Purpose: Enables the user to change to an OUTLINE type style.
The character will stay in its current type style, such as
Bold, or Italic, but will outline that current style. This
command will stay in effect until canceled with the
\XOL^ Cancel Outline command.

Format: \OL^ and
\XOL^

Argument: None

Examples: Input: Use the \OL^Outline Command \XOL^to outline
words or sentences. Connect the command to
the word you are stressing.

Output: Use the Outline Command to outline words or
sentences. Connect the command to the word you are
stressing.

Input: Using \I^\OL^Outline \N^\XOL^Type

Output: Using Outline Type
Note: Controls for these commands are found under the Set

Text Attributes Tool and Text Properties Change.

Note: The OFDP display does not show the outline. This
takes place when it is printed.
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POINT SIZE

\PSZ

Purpose: Enables the user to change Point Size.

Format: \PSZ unit^

Argument: unit is the size of type in any valid unit

Example: Input: \B^\PSZ14p^E\N^\PSZ9p^very good boy does
fine.

Output: Every good boy does fine.

Related
Commands: \HSZ unit^

HORIZONTAL SIZE

\VSZ unit^
VERTICAL SIZE



Chapter 6: Working With Text

Reset for Super/Subscript

173

RESET FOR SUPER/SUBSCRIPT

\R^

Purpose: This command allows the user to reset a super/
subscript back to the last known point size. It will reset
to previous level of super/subscript if multiples are
necessary, or will reset back to original point size if
there is only one super/subscript.

Format: \R^

Argument: None

Example: Input: Using Kleenex\U^\112^\R^ to clean your
eyeglasses can scratch your lenses.

Output: Using Kleenex® to clean your eyeglasses can scratch
your lenses.

Below is an example that is occasionally necessary
when working with equations – placing a superscript
inside a subscript.

Input: Levels of super/subscripts are easy:\NL^
1.11 \D^22\U^33\R^22 \F^1.11.

Output: Levels of super/subscripts are easy:
1.11 223322 1.11.

Related
Commands: \D^

DOWN FOR SUBSCRIPT

\F^
FIRST POINT SIZE RESET

\U^
UP FOR SUPERSCRIPT

Note: Controls for these commands are found under the Set
Text Attributes Tool and Text Properties Change.
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THIN and THIN ITALIC \TH^

\THI^

Purpose: These are the two type style commands for Thin and
Thin Italic. Thin is a thinner version of the light type
style, while Thin Italic is a slanted thinner version.
Both of these commands will stay in effect until another
style command is encountered within the text
component.

Format: \TH^ and \THI^

Arguments: None

Example: In the examples below, notice the command is
connected to the word it is changing.

Input: Use the \TH^Thin Command \N^to place emphasis
on words or sentences. \THI^Here we are using
the Thin Italic Command.

Output: Use the Thin Command to place emphasis on words or
sentences. Here we are using the Thin Italic Command.

List of
Type Styles: \VL^ Very Light \VLI^ Very Light Italic

\TH^ Thin \THI^ Thin Italic
\L^ Light \LI^ Light Italic
\N^ Normal \I^ Italic
\M^ Medium \MI^ Medium Italic
\B^ Bold \BI^ Bold Italic
\XB^ Extra Bold \XBI^ Extra Bold Italic
\HV^ Heavy \HVI^ Heavy Italic
\BK^ Black \BKI^ Black Italic

Note: Type styles are dependent on availability of that style
on your system. If you select a style that is not
available, the system will default to the closest match:
normal, bold, or italic.
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TILDE CHARACTER

~

Purpose: The tilde character is used to hold a specific amount of
space. The tilde character is OneForm’s hardspace
character. The width is a figure space. You can define
the width through the Text Attribute Tool or Text
Properties Change.

Format: ~

Argument: none

Example:

Input: 12345.00
~1234.00
~~123.00
~~~12.00
~~~~1.00
~~~~~.00

Output: 12345.00
1234.00

123.00
12.00

1.00
.00

Remarks: When the tilde is used to join two words together it will
not allow those words to break. To get a tilde to print
you must use the special character number \248^.

Default: The tilde holds the space of the number zero.
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UP FOR SUPERSCRIPT

\U^

Purpose: This command allows the user to immediately create
superscripts. It raises the baseline and reduces the
current point size by 50% for the characters following
the command.

Format: \U^

Arguments: None

Example: Input: One atom of hydrogen-1 has a mass of
1.67 x 10\U^24 \R^g.

Output: One atom of hydrogen-1 has a mass of
1.67 x 1024 g.

Related 
Commands: \D^

DOWN FOR SUBSCRIPT

\F^
FIRST POINT SIZE RESET

\R^
RESET TO SUPER/SUBSCRIPT

Note: Controls for these commands are found under the Set
Text Attributes Tool and Text Properties Change.
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MOVE BASELINE UP

\UP

Purpose: This command allows the user to immediately raise the
baseline of the text following it for that paragraph only.

Format: \UP unit^

Argument: unit is the amount the baseline is to be raised.

Example: Input: To move a line up just \UP 3.5p^use the
immediate UP command.

Output: To move a line up just use the
immediate UP command.

Related
Command: \DN unit^

MOVE BASELINE DOWN
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UNDERLINE START and END \US^

\UE^

Purpose: Enables the user to underline a word or words. This
command will stay in effect until an UNDERLINE
END command (\UE^) is encountered or the end of the
text item.

Format: \US^ and \UE^

Arguments: None

Example: Input: Underscoring is used 
\US^to place emphasis on words or
sentences.\UE^ Connect the command to the
word you are
stressing.

Output: Underscoring is used to place emphasis on words or
sentences. Connect the command to the word you are
stressing.

Note: Controls for these commands are found under the Set
Text Attributes Tool and Text Properties Change.
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VERY LIGHT and VERY LIGHT ITALIC \VL^

\VLI^

Purpose: These are the two type style commands for Very Light
and Very Light Italic. Very Light is an extremely thin
version of the light type style, while Very Light Italic
is the slanted version. Both of these commands will
stay in effect until another style command is
encountered within the text component.

Format: \VL^ and \VLI^

Arguments: None

Example: In the examples below, notice the command is
connected to the word it is changing.

Input: Use the \VL^Very Light Command\N^to place
emphasis on words or sentences. \VLI^Here we
are using the Very Light Italic Command.

Output: Use the Very Light Command to place emphasis on
words or sentences. Here we are using the Very Light
Italic Command.

List of
Type Styles: \VL^ Very Light \VLI^ Very Light Italic

\TH^ Thin \THI^ Thin Italic
\L^ Light \LI^ Light Italic
\N^ Normal \I^ Italic
\M^ Medium \MI^ Medium Italic
\B^ Bold \BI^ Bold Italic
\XB^ Extra Bold \XBI^ Extra Bold Italic
\HV^ Heavy \HVI^ Heavy Italic
\BK^ Black \BKI^ Black Italic

Note: Type styles are dependent on availability of that style
on your system. If you select a style that is not
available, the system will default to the closest match:
normal, bold, or italic.
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VERTICAL SIZE

\VSZ

Purpose: Enables the user to alter Vertical Size.

Format: \VSZ unit^

Argument: unit is the height of the type in any valid unit

Remarks: This command will alter vertical set width; can reduce
or heighten: \VSZ 14p^ = vertical size of 14 points.

Example: Input: Every good \VSZ 14p^boy does fine.

Output: Every good boy does fine.
Related
Commands: \PSZ unit^

POINT SIZE

\HSZ unit^
HORIZONTAL SIZE
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EXTRA BOLD and EXTRA BOLD ITALIC \XB^

\XBI^

Purpose: These are the two type style commands for Extra Bold
and Extra Bold Italic. Extra Bold is a thicker version
of the bold type style, while Extra Bold Italic is a
slanted thicker version. Both of these commands will
stay in effect until another style command is
encountered within the text component.

Format: \XB^ and \XBI^

Arguments: None

Example: In the examples below, notice the command is
connected to the word it is changing.

Input: Use the \XB^Extra Bold Command\N^to place
emphasis on words or sentences. \XBI^Here we
are using the Extra Bold Italic Command.

Output: Use the Extra Bold Command to place emphasis on
words or sentences. Here we are using the Extra Bold
Italic Command.

List of
Type Styles: \VL^ Very Light \VLI^ Very Light Italic

\TH^ Thin \THI^ Thin Italic
\L^ Light \LI^ Light Italic
\N^ Normal \I^ Italic
\M^ Medium \MI^ Medium Italic
\B^ Bold \BI^ Bold Italic
\XB^ Extra Bold \XBI^ Extra Bold Italic
\HV^ Heavy \HVI^ Heavy Italic
\BK^ Black \BKI^ Black Italic

Note: Type styles are dependent on availability of that style
on your system. If you select a style that is not
available, the system will default to the closest match:
normal, bold, or italic.
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Special Character Commands
Special characters are those characters that are in the font but do not appear
on your keyboard. For example, bullets and stars are not on your keyboard
but they are characters that you can access.

You may call up a character through the Text Editor and Interactive Text by
using our special character command. This special character command always
starts with a backslash (\) and ends with a caret (^).

Place the command directly where you want it to be within the paragraph.

Input: Made by Fluffy\111^ Toys, Inc.

Output: Made by Fluffy© Toys, Inc.

To ask for a bullet you would look through the special character access chart,
find the bullet and look at its assigned position number. A bullet happens to
be 121 in the list. Typing in \121ˆ will output a bullet. It will not display on
the graphics screen until you exit the text box.

The majority of the PostScript fonts have the same character layout, unless it
is a symbol or pi font. See the charts following for Helvetica and Zapf Dingbat
Character Numbers.
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NO. CHAR.

1 ˚

2 ˚

3 ´

4 ´

5 `

6 `

7 ˆ

8 ˆ

9 ¨

10 ¨

11 ˜

12 ˜

13 ¸

14 ¸

15 ß

16 Æ

17 Œ

18 æ

19 œ

20 T

21 U

22 V

23 W

24 X

25 Y

26 Z

27 a

28 b

29 c

30 d

31 e

32 f

NO. CHAR.

33 g

34 h

35 i

36 j

37 k

38 l

39 m

40 n

41 o

42 p

43 q

44 r

45 s

46 t

47 u

48 v

49 w

50 x

51 y

52 z

53 1

54 2

55 3

56 4

57 5

58 6

59 7

60 8

61 9

62 0

63 $

64 ¢

NO. CHAR.

65 &

66 :

67 ;

68 .

69 ,

70 ‘

71 ’

72 ?

73 !

74 %

75 *

76 (

77 )

78 /

79 -

80 —

81 –

82 ⁄

83 fi

84 fl

85 &

86 &

87 &

88 ^

89 ƒ

90 ‚

91 „

92 ¯

93 ˘

94 ˛

95 ˇ

96 ¦

NO. CHAR.

97 Ð

98 ð

99 º

100 ¼

101 ½

102 Ý

103 ý

104 °

105 ÷

106 ¾

107 ×

108 ©

109 ®

110 ™

111 ©
112 ®
113 ™
114 ¶

115 …

116 #

117 “

118 ”

119 ı

120 @

121 •
122 •
123 °
124 †

125 ‡

126 §

127 [

128 ]
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NO. CHAR.

129 A

130 B

131 C

132 D

133 E

134 F

135 G

136 H

137 I

138 J

139 K

140 L

141 M

142 N

143 O

144 P

145 Q

146 R

147 S

148 T

149 U

150 V

151 W

152 X

153 Y

154 Z

155 a

156 b

157 c

158 d

159 e

160 f

NO. CHAR.

161 g

162 h

163 i

164 j

165 k

166 l

167 m

168 n

169 o

170 p

171 q

172 r

173 s

174 t

175 u

176 v

177 w

178 x

179 y

180 z

181 1

182 2

183 3

184 4

185 5

186 6

187 7

188 8

189 9

190 0

191 $

192 ¢

NO. CHAR.

193 &

194 :

195 ;

196 .

197 ,

198 ‘

199 ’

200 ?

201 !

202 %

203 *

204 (

205 )

206 /

207 -

208 —

209 –

210 {

211 }

212 [

213 ]

214 ·

215 #

216 “

217 ”

218 @

219 _

220 ■

221 °
222 †

223 ‡

224 `

NO. CHAR.

225 ´

226 ¨

227 ¨

228 ˙

229 ˙

230 \

231 •

232 +

233 –

234 ×
235 ÷
236 =

237 ≠
238 ≈
239 ≡
240 &

241 <

242 >

243 ≤
244 ≥
245 ±
246 ˆ

247 |

248 ~

249 "

250 '

251 ˚

252 ˚

253  

254

255

256
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NO. CHAR.

257 Α
258 Β
259 Γ
260 Δ
261 Ε
262 Ζ
263 Η
264 Θ
265 Ι
266 Κ
267 Λ
268 Μ
269 Ν
270 Ξ
271 Ο
272 Π
273 Ρ
274 Σ
275 Τ
276 ϒ
277 Φ
278 Χ
279 Ψ
280 Ω
281 α
282 β
283 γ
284 δ
285 ε
286 ζ
287 η
288 θ

NO. CHAR.

289 ι
290 κ
291 λ
292 μ
293 ν
294 ξ
295 ο
296 π
297 ρ
298 σ
299 τ
300 υ
301 φ
302 χ
303 ψ
304 ω
305 ƒ
306 ∂
307 ∇
308 &

309 ⎧
310 ⎨
311 ⎩
312 ⎫
313 ⎬
314 ⎭
315 ∼
316 ⎡
317 ⎣
318 &

319 &

320 ⎢

NO. CHAR.

321 &

322 &

323 →
324 ←
325 ↑
326 ↓
327 &

328 &

329 &

330 &

331 &

332 &

333 &

334 &

335 &

336 &

337 √
338 &

339 ≅
340 ∫
341 ¡

342 ‰

343 £

344 ¥

345 &

346 &

347 &

348 ↵
349 ⊕
350 &

351 &

352 &

NO. CHAR.

353 &

354 &

355 ©
356 ↓
357 ™
358 ∝
359 ∂
360 ⇒
361 ⇐
362 •
363 ⌠
364 ⌡
365 &

366 &

367 &

368 &

369 ƒ
370 &

371 ℜ
372 &

373 &

374 √
375 &

376 ∞
377 ′
378 ˝

379 &

380 &

381 &

382 &

383 &

384 &
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NO. CHAR.

385 •

386 •

387 •

388 •

389 •

390 Á

391 á

392 Â

393 â

394 Ä

395 ä

396 À

397 à

398 Å

399 å

400 Ã

401 ã

402 Ç

403 ç

404 É

405 é

406 Ê

407 ê

408 Ë

409 ë

410 È

411 è

412 Í

413 í

414 Î

415 î

416 Ï

NO. CHAR.

417 ï

418 Ì

419 ì

420 Ñ

421 ñ

422 &

423 ©
424 ©
425 ®
426 ®
427 &

428 &

429 ♦
430 ♦
431 ♦
432 &

433 &

434 &

435 ♦
436 ♦
437 ♦
438 ◊
439 ◊
440 ◊
441 &

442 Ó

443 ó

444 Ô

445 ô

446 Ö

447 ö

448 Ò

NO. CHAR.

449 ò

450 Õ

451 õ

452 Š

453 š

454 Ú

455 ú

456 Û

457 û

458 Ü

459 ü

460 Ù

461 ù

462 Ÿ

463 ÿ

464 Ž

465 ž

466 •

467 «

468 »

469 ‹

470 ›

471 ¿

472 &

473 ⊕
474 ⊗
475 ¤

476 ¤

477 ı

478 ł

479 ø

480 œ

NO. CHAR.

481 ß

482 ♦
483 Æ

484 Ł

485 Ø

486 Œ

487 æ

488 &

489 ¤

490 &

491 •

492 •

493 •

494 ⇒
495 ⇐
496 ⇑
497 ⇓
498 ⇔
499 &

500 &

501 &

502 &

503 &

504 &

505 ¤

506 &

507 &

508 ℵ
509 &

510 &

511 ℘
512 &
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NO. CHAR.

1 ➊

2 ➊

3 ➂

4 ➂

5 ➁

6 ➁

7 ➃

8 ➃

9 ➈

10 ➈

11 ➄

12 ➄

13 ➋

14 ➋

15 ➻

16 ➡

17 ➪

18 ➱

19 ➺

20 ✴

21 ✵

22 ✶

23 ✷

24 ✸

25 ✹

26 ✺

27 ❁

28 ❂

29 ❃

30 ❄

31 ❅

32 ❆

NO. CHAR.

33 ❇

34 ❈

35 ❉

36 ❊

37 ❋

38 ●

39 ❍

40 ■

41 ❏

42 ❐

43 ❑

44 ❒

45 ▲

46 ▼

47 ◆

48 ❖

49 ◗

50 ❘

51 ❙

52 ❚

53 ✑

54 ✒

55 ✓

56 ✔

57 ✕

58 ✖

59 ✗

60 ✘

61 ✙

62 ✐

63 ✄

64 ❢

NO. CHAR.

65 ✆

66 ✚

67 ✛

68 ✎

69 ✌

70 ❀

71 ✇

72 ✟

73 ✁

74 ☎

75 ☛

76 ✈

77 ✉

78 ✏

79 ✍

80 ➐

81 ⑥

82 ❤

83 ③

84 ④

85 ✆

86 ✆

87 ✆

88 ✾

89 ❦

90 ❸

91 ❹

92 ➅

93 ➆

94 ➎

95 ➏

96 ➥

NO. CHAR.

97 ➦

98 ➧

99 ➫

100 ➬

101 ➭

102 ➮

103 ➯

104 ➲

105 ➳

106 ➴

107 ➷

108 ➼

109 ➽

110 ➾

111 ©
112 ®
113 ™
114 ❶

115 ❼

116 ✃

117 ♥

118 ❺

119 ➵

120 ✠

121 •
122 •
123 °
124 ⑦

125 ⑧

126 ❧

127 ✻

128 ✽
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NO. CHAR.

129 ✡

130 ✢

131 ✣

132 ✤

133 ✥

134 ✦

135 ✧

136 ★

137 ✩

138 ✪

139 ✫

140 ✬

141 ✭

142 ✮

143 ✯

144 ✰

145 ✱

146 ✲

147 ✳

148 ✴

149 ✵

150 ✶

151 ✷

152 ✸

153 ✹

154 ✺

155 ❁

156 ❂

157 ❃

158 ❄

159 ❅

160 ❆

NO. CHAR.

161 ❇

162 ❈

163 ❉

164 ❊

165 ❋

166 ●

167 ❍

168 ■

169 ❏

170 ❐

171 ❑

172 ❒

173 ▲

174 ▼

175 ◆

176 ❖

177 ◗

178 ❘

179 ❙

180 ❚

181 ✑

182 ✒

183 ✓

184 ✔

185 ✕

186 ✖

187 ✗

188 ✘

189 ✙

190 ✐

191 ✄

192 ❢

NO. CHAR.

193 ✆

194 ✚

195 ✛

196 ✎

197 ✌

198 ❀

199 ✇

200 ✟

201 ✁

202 ☎

203 ☛

204 ✈

205 ✉

206 ✏

207 ✍

208 ➐

209 ⑥

210 ❛

211 ❝

212 ✻

213 ✽

214 ⑨

215 ✃

216 ♥

217 ❺

218 ✠

219 ✿

220 ■

221 °
222 ⑦

223 ⑧

224 ➁

NO. CHAR.

225 ➂

226 ➈

227 ➈

228 ➇

229 ➇

230 ✼

231 ❷

232 ☞

233 ⑥

234 ×
235 ÷
236 ✝

237 ≠
238 ≈
239 ≡
240 ✆

241 ✜

242 ✞

243 ≤
244 ≥
245 ±
246 ➃

247 ❜

248 ❞

249 ✂

250 ♦

251 ➊

252 ➊

253  

254

255

256
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NO. CHAR.

257 Α
258 Β
259 Γ
260 Δ
261 Ε
262 Ζ
263 Η
264 Θ
265 Ι
266 Κ
267 Λ
268 Μ
269 Ν
270 Ξ
271 Ο
272 Π
273 Ρ
274 Σ
275 Τ
276 ϒ
277 Φ
278 Χ
279 Ψ
280 Ω
281 α
282 β
283 γ
284 δ
285 ε
286 ζ
287 η
288 θ

NO. CHAR.

289 ι
290 κ
291 λ
292 μ
293 ν
294 ξ
295 ο
296 π
297 ρ
298 σ
299 τ
300 υ
301 φ
302 χ
303 ψ
304 ω
305 ƒ
306 ∂
307 ∇
308 ✆

309 ⎧
310 ⎨
311 ⎩
312 ⎫
313 ⎬
314 ⎭
315 ∼
316 ⎡
317 ⎣
318 ✆

319 ✆

320 ⎢

NO. CHAR.

321 ✆

322 ✆

323 →
324 ←
325 ↑
326 ↓
327 ✆

328 ✆

329 ✆

330 ✆

331 ✆

332 ✆

333 ✆

334 ✆

335 ✆

336 ✆

337 √
338 ✆

339 ≅
340 ∫
341 ❡

342 ❽

343 ❣

344 ❥

345 ✆

346 ✆

347 ✆

348 ↵
349 ⊕
350 ✆

351 ✆

352 ✆

NO. CHAR.

353 ✆

354 ✆

355 ©
356 ↓
357 ™
358 ∝
359 ∂
360 ⇒
361 ⇐
362 •
363 ⌠
364 ⌡
365 ✆

366 ✆

367 ✆

368 ✆

369 ƒ
370 ✆

371 ℜ
372 ✆

373 ✆

374 √
375 ✆

376 ∞
377 ′
378 ➍

379 ✆

380 ✆

381 ✆

382 ✆

383 ✆

384 ✆
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NO. CHAR.

385 ❷

386 ❷

387 ❷

388 ❷

389 ❷

390 ❨

391 ❩

392 ❪

393 ❫

394 ❬

395 ❭

396 ❮

397 ❯

398 ❰

399 ❱

400 ❲

401 ❳

402 ❴

403 ❵

404

405

406

407

408

409

410

411

412

413

414

415

416

NO. CHAR.

417

418

419

420

421

422 ✆

423 ©
424 ©
425 ®
426 ®
427 ✆

428 ✆

429 ♦
430 ♦
431 ♦
432 ✆

433 ✆

434 ✆

435 ♦
436 ♦
437 ♦
438 ◊
439 ◊
440 ◊
441 ✆

442 ➤

443 ⑤

444 ⑩

445 ❾

446 ➀

447 ➉

448 ➌

NO. CHAR.

449 ➑

450 ➒

451 ➓

452 ➔

453 →

454 ↔

455 ↕

456 ➘

457 ➙

458 ➚

459 ➛

460 ➜

461 ➝

462 ➞

463 ➟

464 ➠

465 ➢

466 ❷

467 ♠

468 ❻

469 ①

470 ②

471 ❿

472 ✆

473 ⊕
474 ⊗
475 ♣

476 ♣

477 ➵

478 ➸

479 ➹

480 ➺

NO. CHAR.

481 ➻

482 ♦
483 ➡

484 ➨

485 ➩

486 ➪

487 ➱

488 ✆

489 ♣

490 ✆

491 ❷

492 ❷

493 ❷

494 ⇒
495 ⇐
496 ⇑
497 ⇓
498 ⇔
499 ✆

500 ✆

501 ✆

502 ✆

503 ✆

504 ✆

505 ♣

506 ✆

507 ✆

508 ℵ
509 ✆

510 ✆

511 ℘
512 ✆
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International Accented Character Commands
The keyboarding specifications for accented characters for support of
international language input follow. All characters supported are listed.

These characters are produced through a three character command beginning
with the @ symbol and followed by the character’s keyboard sequence. The
accented characters can only be seen once the three characters have been input
and the text is closed. When the @ key is alone, the @ will print normally.
When it is followed by an acceptable character sequence, the accented character
will print.

The following are the accented characters, their names, and their Keyboard
Sequence:

Á 
Aacute
Keyboard Sequence: @’A

á 
aacute
Keyboard Sequence: @’a

Â 
Acircumflex
Keyboard Sequence: @^A

â 
acircumflex
Keyboard Sequence: @^a

Ä 
Adieresis
Keyboard Sequence: @"A

ä 
adieresis
Keyboard Sequence: @"a

À 
Agrave
Keyboard Sequence: @‘A

à 
agrave
Keyboard Sequence: @‘a

Å 
Aring

Keyboard Sequence: @*A

å 
aring
Keyboard Sequence: @*a

Ã 
Atilde
Keyboard Sequence: @~A

ã 
atilde
Keyboard Sequence: @~a

Ç 
Ccedilla
Keyboard Sequence: @,C

ç 
ccedilla
Keyboard Sequence: @,c

É 
Eacute
Keyboard Sequence: @’E

é 
eacute
Keyboard Sequence: @’e

Ê
Ecircumflex
Keyboard Sequence: @^E
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ê 
ecircumflex
Keyboard Sequence: @^e

Ë 
Edieresis
Keyboard Sequence: @"E

ë 
edieresis
Keyboard Sequence: @"e

È 
Egrave
Keyboard Sequence: @‘E

è
egrave
Keyboard Sequence: @‘e

Í 
Iacute
Keyboard Sequence: @’I

í 
iacute
Keyboard Sequence: @’i

Î 
Icircumflex
Keyboard Sequence: @^I

î 
icircomflex
Keyboard Sequence: @^i

Ï 
Idieresis
Keyboard Sequence: @"I

ï 
idieresis
Keyboard Sequence: @"i

Ì 
Igrave
Keyboard Sequence: @‘I

ì 
igrave
Keyboard Sequence: @‘i

Ñ 
Ntilde
Keyboard Sequence: @~N

ñ 
ntilde
Keyboard Sequence: @~n

Ó 
Oacute
Keyboard Sequence: @’O

ó 
oacute
Keyboard Sequence: @’o

Ô 
Ocircumflex
Keyboard Sequence: @^O

ô 
ocircumflex
Keyboard Sequence: @^o

Ö
Odieresis
Keyboard Sequence: @"O

ö 
odieresis
Keyboard Sequence: @"o

Ò 
Ograve
Keyboard Sequence: @‘O

ò 
ograve
Keyboard Sequence: @‘o

Õ 
Otilde
Keyboard Sequence: @~O

õ 
otilde
Keyboard Sequence: @~o

Š 
Scaron
Keyboard Sequence: @vS
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š 
scaron
Keyboard Sequence: @vs

Ú 
Uacute
Keyboard Sequence: @’U

ú 
uacute
Keyboard Sequence: @’u

Û 
Ucircumflex
Keyboard Sequence: @^U

û 
ucircumflex
Keyboard Sequence: @^u

Ü 
Udieresis
Keyboard Sequence: @"U

ü 
udieresis
Keyboard Sequence: @"u

Ù 
Ugrave
Keyboard Sequence: @‘U

ù 
ugrave
Keyboard Sequence: @‘u

Š 
Ydieresis
Keyboard Sequence: @"Y

š 
ydieresis
Keyboard Sequence: @"y

ž 
Zcaron
Keyboard Sequence: @vZ

• 
zcarib
Keyboard Sequence: @vz

¡ 
exclamdown
Keyboard Sequence: @!!

¿ 
questiondown
Keyboard Sequence: @??

¢ 
cent
Keyboard Sequence: @C/

£ 
sterling
Keyboard Sequence: @-L

¤ 
currency
Keyboard Sequence: @XO

¥ 
yen
Keyboard Sequence: @=Y

§
section
Keyboard Sequence: @S!

Æ 
AEdipthong
Keyboard Sequence: @AE

æ 
aedipthong
Keyboard Sequence: @ae

Œ 
OEdipthong
Keyboard Sequence: @OE

œ 
oedipthong
Keyboard Sequence: @oe

‰
perthousand
Keyboard Sequence: @0/00

ß 
germandbls
Keyboard Sequence: @ss
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Ø 
Oslash
Keyboard Sequence: @O/

ø 
oslash
Keyboard Sequence: @o/

« 
guillemotleft
Keyboard Sequence: @«

» 
guillemotright

Keyboard Sequence: @ »

• 
bullet
Keyboard Sequence: @^.

En-Space
Keyboard Sequence: @N

Em-Space
Keyboard Sequence: @M

Thin Space
Keyboard Sequence: @T

Viewing International Characters

Following are two different views of the international characters. The first
shows the actual keystrokes as seen through Window’s Notepad. The second
shows the true character once Notepad is closed.

\i^Meursault est employ@’e de banque @‘a Alger. Son
existence est m@’ediocre, tout lui semble @<< @’egal
@>>.

\i^Apr@‘es le d@’ejeuner, un dimanche, il participe
@‘a une bagarre : son ami Raymond @’etait poursuivi
par deux Arabes pour une histoire de femme. Raymond a
le bras taillad@’e d’un coup de couteau, et Meursault
doit lui prendre son revolver pour l’emp@^echer de
tirer. Un peu plus tard dans l’apr@‘es-midi, seul,
Meursault rencontre de nouveau l’un des deux
Arabes...

C’@’etait le m@^eme @’eclatement rouge. Sur le sable,
la mer haletait de toute la respiration rapide et
@’etouff@’ee de ses petites vagues. Je marchais
lentement vers les rochers et je sentais mon front se
gonfler sous le soleil. Toute cette chaleur
s’appuyait sur moi et s’opposait @‘a mon avance. Et
chaque fois que je sentais son grand souffle chaud
sur mon visage, je serrais les dents, je fermais les
poings dans les poches de mon pantalon, je me tendais
tout entier pour triompher du soleil et de cette
ivresse opaque qu’il me d@’eversait. A chaque
@’ep@’ee de lumi@‘ere jaillie du sable, d’un

Figure 6-18: Keyboard Sequence Shown Through Notepad
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Meursault est employé de banque à Alger. Son existence est médiocre, tout
lui semble « égal ».

Après le déjeuner, un dimanche, il participe à une bagarre : son ami
Raymond était poursuivi par deux Arabes pour une histoire de femme.
Raymond a le bras tailladé d’un coup de couteau, et Meursault doit lui
prendre son revolver pour l’empêcher de tirer. Un peu plus tard dans
l’après-midi, seul, Meursault rencontre de nouveau l’un des deux Arabes...

C’était le même éclatement rouge. Sur le sable, la mer haletait de toute la
respiration rapide et étouffée de ses petites vagues. Je marchais lentement
vers les rochers et je sentais mon front se gonfler sous le soleil. Toute
cette chaleur s’appuyait sur moi et s’opposait à mon avance. Et chaque
fois que je sentais son grand souffle chaud sur mon visage, je serrais les
dents, je fermais les poings dans les poches de mon pantalon, je me tendais
tout entier pour triompher du soleil et de cette ivresse opaque qu’il me
déversait. A chaque épée de lumière jaillie du sable, d’un coquillage blanchi
ou d’un débris de verre, mes mâchoires se crispaient. J’ai marché long-
temps.

Figure 6-19: International Characters After Closing Notepad
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CHAPTER 7

Working with Barcodes

A barcode is a group of printed bars and spaces that are designed to be scanned
as identification for the object it labels. OneForm Designer Plus has Software
and PostScript fonts for the barcodes shown.

Codabar

Code 3 of 9

UPC-A — 8.00 cpi UPC-E — 8.00 cpi

Intelligent Mail

Postal — FIM Code Bars

a0123456789t
0123456789

*0123456789*
0123456789

A
A

B
B

C
C

§"8Ndz¤
0123456789Interleaved 2 of 5

|001234+FGHIJF|01234 567890 5 |EEA235+4402350 0

Code 128

EAN-13

Postal — Zip Code Bars

|6410814240|

6410814240

00 700 123456789 123456 64108 1424

Interleaved 2 of 5 Luhn

Figure 7-1: The Different Barcode Types
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General Information

To create a barcode, pick the Draw Barcode menu. Select a type, input the
number, and pick a position to be the lower-left corner of the barcode.

Figure 7-2: Barcode Menu

You can set the Properties or modify them afterwards. Use the Select Tool to
pick the newly created barcode, then right-click and select Barcode Properties
from the pop-up menu.

They are internally accessed as a font which must be setup prior to using any
of the barcodes. See Setting up Fonts in the Getting Started manual.

Barcodes are broken down into three main parts: the bars, the background,
and human-readable numbers.

Background AttributesBarcode Attributes

Human-Readable NumbersPick Position
|EJ34I0+493480

0 2

✳

Figure 7-3: The Three Main Parts and the Pick Position
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You can Group, Move, Copy, Delete or Rotate a barcode. When picking on a
barcode, only the bars are seen.

Barcode Properties
Under Barcode Properties you control the attributes of the barcode. Let’s look
at a generic version of the menus for general discussion. In the dialog box,
height and characters per inch (density) control the size of the barcode. You
will notice in the menus the default units of measure is mils (t = thousands
of an inch). The attributes you are probably most familiar with are the Layer,
Color and Screen. These are found on each tab for the ability to assign the
bars, background, and numbers any mix of layers and colors.

Barcode Attributes

Figure 7-4: Codabar Attributes Dialog Box

Here we are assigning attributes to the bars themselves. The reduction is
measured in mils and is the amount of bar width reduction required to account
for press expansion. The height controls how tall the bar is.

CPI is characters per inch horizontally. This is the printed density of the bars.
Each barcode has its own standards as to how many characters are
recommended per inch, but be aware that the output resolution must be taken
into consideration. The 2.78 cpi is necessary to produce a barcode which can
output on a 300 dpi output device and be legible. A 10 cpi barcode would be
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too dense for a proof printer, but would work just fine on a high resolution
output device.

Background Attributes

Figure 7-5: The Background Tab

This is for the rectangular background area that shows through the bars. The
gutters control how much the background extends out from the bars.

a0123456789t
0123456789

Y-Position is 598 mils

Top and Bottom Gutters set at 0.

Left and Right Gutters set at 500 mils.

Background Color set to 10%.

Figure 7-6: Use of Gutters and Y-Position of Numbers

If no background is wanted at all, slide the Color Density bar to None. Each
of the Human-Readable Numbers have a background area of their own. This
allows knockout of the bars in the case of UPC codes.
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Human Readables

"Show this Human Readable" will print the numbers, while Y Position controls
where the numbers are placed. Measure from the bottom of the bar to the
baseline of the numbers. See Figure 7-6.

Figure 7-7: Human Readables Tab

Hint: If you do not want the human-readable to print, but do need the operator
to see the code numbers, here are some ideas: 1) specify an invisible color
(same as background) for the numbers; or, 2) put the code numbers on a layer
which is off during output.

Edit Barcode Data

To change the barcode numbers use the Select Tool to pick the barcode, then
right-click and select Edit Barcode Data from the Pop-up menu.

Figure 7-8: The Barcode Data Dialog Box



202 OFDP Business Forms Composition – Ver 8.0

Codabar
To generate a Codabar simply type in the Codabar Code. This barcode is
typically a 10 digit code plus Start and Stop characters. Go to Properties if
you are not using 10 digits and change the "Number of Digits" which is a
check against not typing in the right amount of digits.

Figure 7-9: Codabar Dialog Boxes

The start and stop characters are generated automatically.
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Codabar Facts

a0123456789t
Y-PositionBar Code Number

0123456789

a0123456789t
0123456789a t

Stop CharacterStart Character

Figure 7-10: Default Codabar with Stop and Start Characters

Font Name: cd

Style: n

Start: a, b, c, d

Stop: t, n, *, e

X/Y Offset: 0,0

Minimum Digits: 1

Maximum Digits: 16

Valid Characters: [0-9], -, $, :, /, +

Height: 500 mils (Approx. Vertical Size = 36 point)

CPI: 2.78 (Approx. Horizontal Size = 36 point)
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Code 3 of 9

Generating a Code 3 of 9 barcode requires you to input only the Wide to
Narrow Ratio, Code 3 of 9 Code and then decide whether you want a Check
Digit or not.

Figure 7-11: Code 3 of 9 Dialog Boxes

Note: A space is a valid character, but will display a tilde
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Wide to Narrow Ratio: This is the ratio of the width of the widest bar to the
thinnest bar in the barcode. The larger the number the thicker the barcode.

Check Digit: The check digit is calculated from the code through various
mathematical steps, and is a second verification that the correct code was read
when scanned. If you want the Check Digit turn it on by checking it. This will
add one character to your code automatically.

Code 3 of 9 Facts

*01234567892*
Check DigitBar Code Number

01234567892

*0123456789*
0123456789* *

Stop CharacterStart Character

Figure 7-12: Default Code 3 of 9 Showing Check Digit and Start/Stop Characters

Font Name: ctn

Style: n

Start: *

Stop: *

X/Y Offset: 0,0

Minimum Digits: 1

Maximum Digits: 16

Valid Characters: [0-9], [A-Z], space, -, ., $, /, + ,%

Height: 500 mils (Approx. Vertical Size = 36 point)

CPI: 2.78 (Approx. Horizontal Size = 36 point)

Although there are only 43 data characters in Code 3 of 9’s character set, it
is possible to encode all 128 ASCII characters using Code 3 of 9’s Full ASCII
feature. If a reader is in its Full ASCII mode, the symbols $ / % and + are
used as precedence codes with the 26 letters as shown in Figure 7-13 and
Figure 7-14.
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ASCII CODE 39 ASCII CODE 39

NUL %U SP Space
SOH $A ! /A
STX $B " /B
ETX $C # /C
EOT $D $ /D
ENQ $E % /E
ACK $F & /F
BEL $G ! /G
BS $H ( /H
HT $I ) /I
LF $J * /J
VT $K + /K
FF $L ’ /L
CR $M - -
SO $N . .
SI $O / /0
DLE $P 0 0
DC1 $Q 1 1
DC2 $R 2 2
DC3 $S 3 3
DC4 $T 4 4
NAK $U 5 5
SYN $V 6 6
ETB $W 7 7
CAN $X 8 8
EM $Y 9 9
SUB $Z : /Z
ESC %A ; %F
FS %B < %G

%G

GS %C = %H
RS %D > %I
US %E ? %J

Figure 7-13: Code 3 of 9 ASCII Chart (Part 1)
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ASCII CODE 39 ASCII CODE 39

@ %V %W
A A a +A
B B b +B
C C c +C
D D d +D
E E e +E
F F f +F
G G g +G
H H h +H
I I i +I
J J j +J
K K k +K
L L l +L
M M m +M
N N n +N
O O o +O
P P p +P
Q Q q +Q
R R r +R
S S s +S
T T t +T
U U u +U
V V v +V
W W w +W
X X x +X
Y Y y +Y
Z Z z +Z
[ %K { %P

%L | %Q
] %M } %R
↑ %N ~ %S
— %O DEL %T,%X

%Y,%Z

\

Figure 7-14: Code 3 of 9 ASCII Chart (Part 2)
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Postal
There are two types of Postal Codes: ZIP Code Bars (which is also referred
to in the industry as POSTNET), and Facing Identification Marks (FIM) codes.

A

|6410814240|

Offset Position

Offset Position

Pick Position

ABC GRAPHICS, INC.
10 ELM STREET
ANYWHERE, USA 64108-1424

Pick Position

FIM A

ZIP + 4

CLEAR ZONE

Figure 7-15: ZIP + 4 and FIM-A Showing Pick & Offset Positions with Clear Zone

Note: You cannot change the Height or CPI of either Postal Code since the
U.S. Postal Service requires these dimensions. Even though you can change
the background gutters, the default is regulation.

For further reference see United States Postal Service, Publication 67, October
1989.
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Postal – ZIP Code Bars

Generating a Zip Code bar requires you to input either the Zip code or the
Zip + 4 code. (The last 2 digits are for future postal ABC implementation.)

Zip code bars require check digits, so if you request a human-readable you
will always see a check digit. This check digit is calculated from the Zip code
through various mathematical steps, and is a second verification that the correct
code was read when scanned.

Figure 7-16: Zip Code Dialog Boxes
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Once you have input the Zip Code, clicking [Okay] will generate a barcode.
The barcode will not fall where you picked but will be offset to position it
properly in reference from the corner of the envelope. See Figure 7-17.

So, when picking the position for a Postal Zip, pick the intersection of the
lower right corner of the envelope. The barcode will be offset from that position
to center it within the authorized CLEAR ZONE.

Human Readable numbers are available for ZIP even though they are never
printed. This is so the operator can see the code for proofing. If you do not
want them to show, place them on a layer which is not referenced during
output; or, assign them an invisible color (same as the background).

ZIP Code Facts

|6410814240|

Offset Position

Pick PositionZIP + 4

CLEAR ZONE

Figure 7-17: Zip Code Showing Offset Position

Font Name: zip

Style: n

Start: |

Stop: |

X/Y Offset: -3875t,250t

Minimum Digits: 5

Maximum Digits: 11 (this includes future ABC)

Valid Characters: [0-9]

Height: 125 mils (Approx. Vertical Size = 9 point)

CPI: 10 (Approx. Horizontal Size = 10 point)
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Postal – FIM CODE
Generating a FIM Pattern only requires you to choose which one you want.
There are three types A through C. See Figure 7-19. Once you have input the
type, selecting [Okay] will generate a FIM pattern. The code will not fall
where you picked but will be offset to position it properly in reference from
the corner of the envelope. See Figure 7-17.

Figure 7-18: Postal FIM Code Dialog Boxes

So, when picking the position for a FIM, pick the intersection of the top right
corner of the reply card or envelope. The code will be offset from that position
to center it within the authorized CLEAR ZONE.
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Postal FIM Patterns

|6410814240|

A

ABC GRAPHICS, INC.
10 ELM STREET
ANYWHERE, USA 64108-1424

A

FIM A

ABC GRAPHICS, INC.
10 ELM STREET
ANYWHERE, USA 64108-1424

B NO POSTAGE
NECESSARY

IF MAILED
IN THE

UNITED STATES

BUSINESS REPLY MAIL
FIRST-CLASS MAIL PERMIT NO 73026 WASHINGTON DC

POSTAGE WILL BE PAID BY ADDRESSEE

|6410814240|

ABC GRAPHICS, INC.
10 ELM STREET
ANYWHERE, USA 64108-1424

NO POSTAGE
NECESSARY

IF MAILED
IN THE

UNITED STATES

BUSINESS REPLY MAIL
FIRST-CLASS MAIL PERMIT NO 73026 WASHINGTON DC

POSTAGE WILL BE PAID BY ADDRESSEE

B

C

C

Courtesy Reply Mail
with POSTNET

FIM B

Business Reply,
Penalty or

Franked Mail
Without POSTNET

Business Reply,
Penalty or

Franked Mail
With POSTNET

FIM C

Figure 7-19: FIM Patterns A through C
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FIM Pattern Facts

A
Offset Position

Pick PositionFIM A

CLEAR ZONE

Figure 7-20: FIM Code Showing Offset Position

Human Readable letter is available for FIM even though it is never printed.
This is so the operator can see the code for proofing. If you do not want it to
show, place it on a layer which is not referenced during output; or, assign it
an invisible color (same as the background).

Font Name: zip

Style: n

Start: none

Stop: none

Valid Characters: [A-C]

Height: 625 mils (Approx. Vertical Size = 45.2 point)

CPI: 5 (Approx. Horizontal Size = 200 point)

X/Y Offset: -2520t,-625t



UPC Codes

214 OFDP Business Forms Composition – Ver 8.0

UPC Codes
There are two types of UPC Barcodes: UPC-A, and the condensed version
UPC-E.

UPC-A UPC-E

|001234+FGHIJF|01234 567890 5 |A1C3E5+0123450 7

Figure 7-21: UPC-A and UPC-E Barcodes

For Your Information: Only manufacturer numbers ending with zeros and
item numbers beginning with zeros are valid for UPC-E.

UPC-E codes are the manufacturer number and item number encoded into a
6 digit number, (a compressed UPC-A).

Default UPC-A (Exception: Background
Color is 10% so it can be seen.)

This time the Check Digit is not printed
and the Y-Position of the ‘‘Number
System Character’’ has been changed
from ‘‘-55t’’ to ‘‘400t’’.

Here the Background Attribute gutters
have all been set to 250 mils.

|001234+FGHIJF|01234 567890 5

|001234+FGHIJF|01234 56789

0

|001234+FGHIJF|01234 56789

0

Figure 7-22: Different Varieties of UPC-A
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UPC Dialog Boxes
Their dialogs are so similar that we will just show the UPC-A variety.

Figure 7-23: UPC-A Dialog Boxes
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UPC-A Facts
UPC-A Barcode: This barcode is typically a 12 digit code plus a start, stop
and center character. The start, stop and center characters are generated
automatically.

The Number System Character is always required. Valid digits are 0-9. Each
number has been assigned a specific use by the Uniform Code Council.

0 = Regular UPC Code

1 = RESERVED

2 = Random Weight Item (i.e., Meat and Produce)

3 = National Drug and Health Code

4 = Non-food Item

5 = Coupon

6 = Regular UPC Code

7 = Regular UPC Code

8 = RESERVED

9 = RESERVED

The Check Digit is a required option. This check digit is calculated from the
code through various mathematical steps, and is a second verification that the
correct code was read when scanned.

Once you have input the Number System Character and the UPC-A Code,
selecting [Okay] will generate a barcode with the given attributes in the
position that you picked.

Font Name: upca

Style: n

Start: |

Stop: |

X/Y Offset: 0,0

Valid Characters: [0-9]

Center: +

Height: 1000 mils (Approx. Vertical Size = 72 point)

CPI: 8.0 (Approx. Horizontal Size = 12 point)
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UPC-E Facts
UPC-E Code: This barcode is typically a 6 digit code plus a start and stop
character. The start and stop characters are generated automatically.

The Number System Character is always required to be a "0". Do not type
this in as part of the barcode. It is generated automatically.

The Check Digit is a required option. This check digit is calculated from the
code through various mathematical steps, and is a second verification that the
correct code was read when scanned.

Once you have input the UPC-E Code, selecting [Okay] will generate a
barcode with the given attributes in the position that you picked.

Font Name: upce

Style: n

Start: |

Stop: +

Valid Characters: [0-9]

Height: 1000 mils (Approx. Vertical Size = 72 point)

CPI: 8.0 (Approx. Horizontal Size = 12 point)

X/Y Offset: 0,0
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Interleaved 2 of 5
Generating the Interleaved 2 of 5 barcode requires you to input two pieces of
information: Interleaved 2 of 5 Code Number and Number of Digits which
make up the code.

Figure 7-24: Interleaved 2 of 5 Dialog Boxes
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Interleaved 2 of 5 Facts

§"8Ndz¤
0123456789

Figure 7-25: Interleaved 2 of 5

Interleaved 2 of 5 Barcode: This barcode is typically a 10 digit code plus Start
and Stop characters. The start and stop characters are generated automatically.

There are three choices of ratio. The ratio controls the width relationship of
the wide and narrow bars. A ratio of 2.5 means the wide bar is 2.5 times wider
than the narrow bar.

Notes: You cannot change the ratio type once created. {Query} will tell you
the ratio type after it is created. While in the menu, you can determine the
type by looking at the Magnification: 100 = 2.2, 105 = 2.5, and 110 = 2.9.

The Number of Digits is a check against not typing in the right amount of
digits. Since Interleaved 2 of 5 works with pairs of numbers, the number of
digits must be an even number.

Once you have input those two pieces of information, pressing [Enter] will
generate a barcode with the given attributes in the position that you picked.

Font Name: int

Style: n

Start: §

Stop: ¤

X/Y Offset: 0,0

Minimum Digits: 2 (requires an even number of characters)

Maximum Digits: 16

Valid Characters: [0-9]

Height: 500 mils (Approx. Vertical Size = 36 point)

CPI: 2.78 (Approx. Horizontal Size = 36 point)
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Code 128
Code 128 is a very high density alphanumeric symbology. It is a variable
length, continuous code. Code 128 has 106 different printed characters. Each
printed character can have one of three different meanings, depending on which
of three different character sets is employed. Three different start characters
tell the reader which of the character sets is initially being used, and three
shift codes permit changing character sets inside a symbol.

Character set C consists of the 100 two-digit pairs 00 through 99. This allows
the effective density of Code 128 to be doubled when printing all numeric
data. Similar to Interleaved 2 of 5.

Amgraf, Inc. - OneFormAmgraf, Inc. - OneFormAmgraf, Inc. - OneFormAmgraf, Inc. - OneForm

Amgraf, Inc. - OneForm

Figure 7-26: Code 128 Dialog Boxes
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Code 128 Facts

Figure 7-27: Code 128

This barcode is a full ASCII code with 4 function codes, start, check digit,
and stop characters. Three code subsets are use to encode ASCII, control codes,
and numeric pairs. Generating this code may require two key strokes to
represent a single code (ie: ^m is CR). The items in parentheses represent the
output of the code keyed in. See Appendix G on page 222 for more details.

Minimize will create the shortest symbol length possible using rules for
different combinations of start, code, shift characters. It is recommended that
"minimized" be used, unless familiar with Code 128.

The OneForm Designer Plus implementation of the minimize function for Code
128 follows the guidelines set forth in the Uniform Symbology Specification
USS-128 developed by AIM. For more information on minimize specifications
see Appendix G.

Check Digit is calculated automatically. You will only see the extra numbers
in the human-readable if printed.

Font Name: 128

Style: n

Start: §

Stop: ¤

X/Y Offset: 0,0

Minimum Digits: 1 or 2

Maximum Digits: 66

Valid Characters: full ASCII Subsets: A, B, or C

Height: 500 mils (Approx. Vertical Size = 36 point)

CPI: 5.00 (Approx. Horizontal Size = 20 point)
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Appendix G
The same data may be represented by different USS-128 symbols through the
use of different combinations of start, code and shift characters.

Use of Start, Code, and Shift Characters

The following rules for the start, code and shift characters can be followed to
minimize the symbol length:

1. Determine the start character:

1a. If the data begins with 4 or more digits, use start Code C;

1b. Otherwise, if a control character occurs in the data before any lower
case character, use start Code A;

1c. Otherwise, use start Code B.

2. When step 1a is followed with an odd number of digits starting the data,
insert a Code A or Code B character before the last digit, following rules
1b and 1c to determine between Code A and Code B.

3. If 4 or more digits occur together when in Code A or Code B:

3a. If there are an even number of digits, insert a Code C character before
the first digit to change to Code C;

3b. Otherwise, there are an odd number of digits, so insert a Code C
character after the first digit to change to Code C.

4. When in Code B and a control character occurs in the data:

4a. If following that character, a lower case character occurs in the data
before the occurrence of another control character, insert a shift
character before the control character;

4b. Otherwise, insert a Code A character before the control character to
change to Code A.

5. When in Code A and a lower case character occurs in the data:

5a. If following that character, a control character occurs in the data
before the occurrence of another lower case character, insert a shift
character before the lower case character;

5b. Otherwise, insert a Code B character before the lower case character
to change to Code B.

6. When in Code C and a non-numeric character occurs in the data, insert a
Code A or Code B character before that character, following the rules of
1b and 1c to determine between Code A or Code B.

Appendix G was reprinted from USS-128 Uniform Symbology
Specification with permission from Automatic Identification
Manufacturers, Inc., 1326 Freeport Road, Pittsburgh, PA 15238,
(412) 963-8588.
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CODE A CODE B CODE C

~ (SP) ~ (SP) 00
! ! 01
" " 02
# # 03
$ $ 04
% % 05
& & 06

0606
’ ’ 07
( ( 08
) ) 09
* * 10
+ + 11
, , 12
- - 13
. . 14
/ / 15
0 0 16
1 1 17
2 2 18
3 3 19
4 4 20
5 5 21
6 6 22
7 7 23
8 8 24
9 9 25
: : 26
; ; 27
< < 28
= = 29
> > 30
? ? 31
@ @ 32
A A 33
B B 34
C C 35
D D 36
E E 37
F F 38
G G 39
H H 40
I I 41
J J 42
K K 43
L L 44
M M 45
N N 46
O O 47
P P 48
Q Q 49
R R 50
S S 51
T T 52
U U 53

VALUE MECCA

00
01
02
03
04
05
06
07
08
09
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53

!
"
#
$
%
&
’
(
)
*
+
,
-
.
/
0
1
2
3
4
5
6
7
8
9
:
;
<
=
>
?
@
A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P
Q
R
S
T
U
V

Appendix G (Part 1): Code 128 encodes the full 128 character ASCII character set using
three alternate character sets, A, B, and C. Each set includes shift codes and start codes to
control which set is to be used. Thus a given character pattern can have several meanings,
depending on the character set currently in use.
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V V 54
W W 55
X X 56
Y Y 57
Z Z 58
[ [ 59

60
] ] 61
^^ (^) ^^ (^) 62
^_ (_) ^_ (_) 63
^0 (NUL) ‘ 64
^a (SOH) a 65
^b (STX) b 66
^c (ETX) c 67
^d (EOT) d 68
^e (ENQ) e 69
^f (ACK) f 70
^g (BEL) g 71
^h (BS) h 72
^i (HT) i 73
^j (LF) j 74
^k (VT) k 75
^l (FF) l 76
^m (CR) m 77
^n (SO) n 78
^o (SI) o 79
^p (DLE) p 80
^q (DC1) q 81
^r (DC2) r 82
^s (DC3) s 83
^t (DC4) t 84
^u (NAK) u 85
^v (SYN) v 86
^w (ETB) w 87
^x (CAN) x 88
^y (EM) y 89
^z (SUB) z 90
^E (ESC) { 91
^F (FS) | 92
^G (GS) } 93
^R (RS) ^~ (~) 94
^U (US) ^D (DEL) 95
^3 (FNC 3) ^3 (FNC 3) 96
^2 (FNC 2) ^2 (FNC 2) 97
^S (SHIFT) ^S (SHIFT) 98
^C (CODE C) ^C (CODE C) 99
^B (CODE B) ^4 (FNC 4) ^B (CODE B)
^4 (FNC 4) ^A (CODE A) ^A (CODE A)
^1 (FNC 1) ^1 (FNC 1) ^1 (FNC 1)

CODE A CODE B CODE C VALUE MECCA

54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95
96
97
98
99
100
101
102

W
X
Y
Z
[
\230^
]
^
_
‘
a
b
c
d
e
f
g
h
i
j
k
l
m
n
o
p
q
r
s
t
u
v
w
x
y
z
{
|
}
\248^
\341^
\064^
\343^
\082^
\344^
\089^
\250^
\117^
\467^

START A
START B
START C
STOP

103

104

105

\469^

\470^

\126^

\475^

\\

Appendix G (Part 2): Code 128 encodes the full 128 character ASCII character set using
three alternate character sets, A, B, and C. Each set includes shift codes and start codes to
control which set is to be used. Thus a given character pattern can have several meanings,
depending on the character set currently in use.
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Code EAN-13

EAN-13 Barcode: Designed by the International Article Numbering
Association (EAN) in Europe. It is an extension to UPC-A to include the
country information. The only difference between UPC-A and EAN-13 is that
the number system in UPC-A is a single digit from 0 through 9 whereas an
EAN-13 number system consists of two digits ranging from 00 to 99. EAN-13
encodes 12 digits of numeric data along with a trailing check digit, for a total
of 13 digits of barcode data.

The Number System is the first two digits in the EAN number to identify the
country/region numbering authority.

The Check Digit is a required option. This check digit is calculated from the
code through various mathematical steps, and is a second verification that the
correct code was read when scanned.

You will get the correct check digit no matter what you type in: an "x", leave
it blank, or type in the incorrect digit. The field is really there for those who
are scanning their input.

Once you have input the Number System Character and the EAN-13 Code,
clicking [Okay] will generate a barcode with the given attributes in the position
that you picked.

In the HUMAN-READABLES there are references to printing the Number
System Character, Code Number, and Check Digit. Click the toggle button
"Show this Human Readable".

EAN-13 Facts

Figure 7-28: Code EAN-13

Font Name: ean

Style: n

X/Y Offset: 0,0

Valid Characters: [0-9]

Center: +

Height: 1000 mils (Approx. Vertical Size = 72 point)

CPI: 8.0 (Approx. Horizontal Size = 12 point)
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Intelligent Mail
The Intelligent Mail barcode used in the USPS mailstream is also known as
the USPS OneCode Solution or USPS 4-State Customer Barcode (4CB). The
Intelligent Mail barcode combines routing ZIP Code information and tracking
information into a single 4-state code. It effectively encodes data from
POSTNET and PLANET barcodes into a single barcode.

Figure 7-29: Sample Envelope with Intelligent Mail Barcode

Intelligent Mail Facts
The Intelligent Mail barcode is a 4-state barcode that consist of 65 bars. A
4-state barcode is based on a tracker with ascenders and descenders. The four
possible states are "tracker" (neither ascender nor descender), "full" (both
ascender and descender), "ascender only", and "descender only".

Figure 7-30: Tracker Regions

For more information, refer to the United States Postal Service website at
http://ribbs.usps.gov/OneCodeSolution/.
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Intelligent Mail Dialog

Figure 7-31: Intelligent Mail Dialogs

The IMB is made up of a Tracking Code and Routing Code. The Tracking
Code includes the following fields:

Barcode Identifier: This is assigned by USPS to encode the presort
identification currently printed on the Optional Endorsement Line (OEL). This
shall be two digits, with the second digit in the range of 0-4. OEL Description
follows: 00 is Default/No OEL Information, 10 is Carrier Route (CR),
Enhanced Carrier Route (ECR), and FIRM, 20 is 5-Digit/Scheme, 30 is
3-Digit/Scheme, 40 is Area Distribution Center (ADC), 50 is Mixed Area
Distribution Center (MADC), Origin Mixed ADC (OMX).

Service Type Identifier: This is a 3-digit code assigned by USPS for any
combination of services requested on the mailpiece. The no service choices
are 700 (First Class Mail with No Services), 702 (Standard Mail with No
Services), 704 (Periodicals with No Services), and 706 (Bound Printed Matter
with No Services).

Mailer Identifier: This is assigned by USPS as a unique, 6 or 9 digit number
that identifies a business entity.

Sequence Number: This is assigned by the mailer for uniquely identifying
and tracking mailpieces. The allowable encoding range shall be 000000000 -
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999999999 when used with a 6 digit Mailer ID and 000000 - 999999 when
used with a 9 digit Mailer ID.

The Routing Code is the following field:

Delivery Point ZIP Code: This is the ZIP code for routing the mailpiece.
This shall replace POSTNET for routing the mailpiece to its final delivery
point. The length may be 0, 5, 9, or 11 digits. Input into field as 5-digits
(space) 4-digits (space) 2-digits.

Miscellaneous Options

You have the option of making the Human Readable visible or rotating the
barcode 90 degrees. The tabs for the Background and the Human Readable
are the same as all other barcodes. See Figures 7-5 and 7-7.

Once you have input the required tracking and routing information, pressing
[Enter] will generate a barcode with the given attributes in the position that
you picked.

Font Name: uspsimb

Style: n

Tracking Code - 20 digits

Barcode Identifier: 2 (2nd digit must be 0-4)

Service Type
Identifier: 3 digits

Mailer Identifier: 6 or 9 digits

Sequence Number: 9 (when used with 6 digit Mailer ID)
6 (when used with 9 digit Mailer ID)

Routing Code -
Delivery Point ZIP

Code: 5,9, or 11 digits

Maximum Digits: 31
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CHAPTER 8

Working With Color
Within this chapter we will attempt to explain the following ideas and
techniques for working with color in OFDP and producing color PDFs.

• Differences Between Spot and Process Color

• Selecting a Color Model

• OFDP Color Chart and FCP Color Numbers

• Creating a File Specifically for Process Color

• Creating a File Specifically for Spot Color

• Viewing the Spot Color on Your Display

• Output Specifications for Spot Color

• Using Step and Repeat within Output Specifications

• Using Choke and Spread

• Exercise in Defining Spot Color Specifications

• PDF Output of the Exercise

• Select Batch Option

Differences Between Spot and Process Color
OneForm Designer Plus (OFDP) creates artwork for both spot color and process
color printing. The differences in printing techniques are significant.

Process Color is based on the use of a four color press, and uses the colors
of Cyan, Magenta, Yellow, and Black. The layer has no affect on the color
because the separations are always CYMK. Color is controlled by the Four
Color Process (FCP) Number assigned.

Process colors are built up by printing each of the four printer’s inks with
screen dots; not quite on top of each other, but so close that it takes a
magnifying glass to distinguish one color from the other. The combined effect
produces a rainbow of colors. In OFDP, the percentages of ink needed to create
each individual color is distributed among the separations by designating a
Four Color Process (FCP) color number to the component. With the FCP
method a minimum of four registered separations are needed to create the
specific colors selected.

The word "color" in Spot Color refers to the single run "ink color" the printer
is going to use during offset printing. The artwork itself is always black and
white. Percentages of black (gray screens) are used to get different densities.
The artwork is designating "Spots" for color a be applied on the press and
traditionally, with spot color, inks are never mixed on the printed page. With
the spot color method, a one color job only requires one separation, a two
color job only requires two registered separations, and so on. They can be
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printed in any color of ink. The color is controlled in OFDP by the layer
attribute. The layer colors for each drawing are determined through the
Drawing Properties dialog Set Layer Colors.

Since the methods are so different, it is necessary to choose a color model for
the drawing before the output separations are created. As a matter of fact,
the way you would designate the file’s layers would be handled differently
from one color model to another.

Selecting a Color Model
When creating a new drawing the Color Model is one of the choices in the
Drawing Properties, it will be either Spot Color or Process Color. The color
model designates the drawing’s method of output for separations.

Figure 8-1: Selecting a Color Model

Note: RGB Color should only be used for files that are generating HTML
only. If you are needing the same file to produce the HTML and the PDF print,
it is recommended that you use Process Color.
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OFDP Color Chart and FCP Color Numbers
OFDP uses Four Color Process (FCP) color numbers to display and print
colors. The Color Chart can be accessed through all component properties’
[Select Color] dialogs.

It is also available under View Menu, View Color Chart. Within the color chart
you can pick on a color chip and it will display its associated FCP number.
The color chart reads a color number list with their CYMK values found in
the file OneForm/COLOR/FCP01.

Figure 8-2: Locating a Color’s FCP Color Number with the Color Chart
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Creating a File Specifically for Process Color
When creating a new drawing for Process Color, the Color Model within
Drawing Properties, should be Process Color. This designates the FCP color
number as being the control for color separations during PDF output. You are
going to control the color through each component’s FCP color number
property. Any "Save As PDF" output will automatically use CMYK for a color
composite PDF.

Figure 8-3: Setup for Process Color

If individual CMYK separations are needed, adding Output Specifications will
make printing individual separations available through a Separations Tab in
"Save As PDF". Here you can check for a composite of the Part, or just an
individual separation. This is in Yellow, Cyan, Magenta, Black (YCMK) order.

Figure 8-4: Separations Tab in "Save As PDF"
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To setup Output Specifications for Process color, go to Options, Drawing
Options, Output Specifications, Add New Part. Give it a Description of
YCMK and [OK]. This means (Yellow, Cyan, Magenta, Black). Separation
1 is Yellow, Separation 2 is Cyan, etc. This reminds you of the order of colors
in the Separations dialog.

The following Process Color Specification Dialog will appear ready to apply
with an [Okay].

Figure 8-5: Process Color Specification Dialog

The View Menu denotes which color model is being displayed: Layer (Spot)
Color or Process Color. When Process Color is checked, the color displayed
is the FCP number within the components [Set Color] attributes.
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Creating a File Specifically for Spot Color
When creating a new drawing for Spot Color, the Color Model within Drawing
Properties, should be Spot Color. This designates layer as being the control
for separations during PDF output. You are going to control the color through
the drawing’s Set Layer Colors, then draw the components on those specific
layers. By default Layer 1 is Black. So if that is all you need, there is no setup
necessary.

Figure 8-6: Setup for Spot Color
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Viewing the Spot Color on Your Display
Within Option’s Drawing Properties, the Set Layer Colors dialog controls
the color assignment for each layer. This is only available when Spot Color
is the color model. Designating the layers to display in the colors needed, and
then drawing the components on those layers, allows you to control the color
display and color printing of the form.

Figure 8-7: Set Layer Colors is for Spot Color Control

Designate color assignments by clicking on the radio button to indicate the
layer, then select a FCP Number for that layer. You can see the color chip
change by pressing the [Tab] key. Once you have assigned all layers needed,
select [Okay] to save the assignments.

The View Menu denotes which color model is being displayed: Layer (Spot)
Color or Process Color. When Layer Color is checked, the components color
is being controlled by their respective Layer Color Assignment.
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Output Specifications for Spot Color
Spot Color separations are controlled by the Output Specifications found
under the Options, Drawing Options menu. Here is where you indicate which
layers are needed for each separation. This is also the point that you control
the arrangement of "Parts" for a multiple part job. Through this option, you
can define up to 16 parts, each with the ability to handle 8 separations.

Figure 8-8: Output Specifications Dialog for Spot Color

To get to the Spot Color Output Specifications dialog, select Options, Drawing
Options, Output Specifications and choose Add New Part. A field to name
the part will appear. Once you have named the part, the Output Specification
Dialog box will appear as shown in Figure 8-8. Here you can check which
layers are needed for each separation color. It’s features are described below.

Part: This field reports to you what part you are currently defining.

Max Separations: This field tells the system how many separations within
this definition to print. If the Max Separation is set to 4 it will output the first
4 separations.

Choke and Spread: This is the color overlap value measured in mils (1/1000").
It is necessary to assign Ink Darkness values if you wish to have chokes and
spreads. They are 1 through 8, with 8 being the darkest color.

Sep 1 through 8 Layers: Check which layers you want turned on for each
separation. Only layers turned on will print. If the checkbox displays as gray,
it will cause a knock-out in that separation.

FCP #: This is the ink color for that separation when printing to a color printer
or making a PDF file through "Save As PDF".
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Step and Repeat
The next two options control Step and Repeat. Input the number of steps and
the distance you wish to step the components. Here you will turn on layers
for stepping (copying) upon output. Use the X/Y Across and Around to
designate the stepping distance.

Step Across/Around: This is the number of steps Vertically and Horizontally.
Must have at least one.

Step Size Across/Around: This is the distance of the steps Vertically and
Horizontally. Must have at least one.

Scale X/Y: This is the percentage to scale the output in both the X and Y
direction.

Button Shortcuts
Using the Button Shortcuts when selecting layers allows you to get other
effects. Click onto the checkbox you need to effect and then select the button.

Print Positive, Knockout in Others: This will make the layer you have chosen
print, and will automatically knock-out that layer in all other separations.

Print Positive, Ignore in Others: This will make the layer you have chosen
print, but will then turn off that layer in all other separations.

Static Layer: This will turn on the layer for every separation.

Knock-Out in this Separation: This knocks out the layer in only the
separation picked.

Ignore in all Separations: This turns off a layer in all of the eight separations.
It is completely ignored and will not print on any separation.

Clear All Layers: This will turn off every layer and clear out the checkboxes
quickly, so that you can define your layer needs.
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Using Step and Repeat within Output
Specifications

Stepping a label is not the same as copying your job across three or four times
in the file. It is controlled upon output. Why? Because the label itself is creating
a large file, and to copy all of that internal information creates files even larger.
Instead, we are sending the printer one drawing and asking it to image it several
times. The instructions on the stepping is controlled in the output specifications
file.

Another advantage is that there is just one original label, which makes
corrections an easier task.

Drawing the Plate

Your plate size must be drawn as part of the label. Put in any trim marks
needed on Layer 16. The Color Bars for each separation are individual layers
because we do not want these stepped – we have used Layers 11 through 12
when creating those in our example.

Figure 8-9: Drawing the Plate
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Looking at the Output Specification
In the dialog you can see each separation is calling up a different layer. Layers
1 and 2 are the label art. Layers 11 through 12 are for the "Color Bars" needed
at the top of your plate, with Layer 16 being the Trim marks.

Figure 8-10: Output Specifications for the Label

Step layers is saying to step only Layers 1 through 2. These are the ones we
used for the label.

The Step Across/Around show that we want 3 across and 4 up.

Step Size Across/Around is the physical dimension of the label, including
bleed. Stepping a label that is 2 5/8 in wide and 2 7/8 in tall.

Note: Never leave 0 for across or around, this means no stepping. When
wanting just 1 across or 1 around, input 1.
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Viewing the Steps
To view the steps, go to the View Menu and choose the Part to view. Then,
choose Show Stepping under the View menu. The finished product will be
displayed.

Figure 8-11: Example of Step and Repeat
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Using Choke and Spread
During the printing process, there are times when two or more colors will
come into contact with each other. Requiring perfect registration on a press
is impractical and normally impossible. Avoiding mis-registration problems
when printing requires the use of what we call "Chokes & Spreads", this is
an image trap. This is the color overlap value measured in mils (1/1000").

No Trapping Used

Trapping Used

Choke & Spread Differences

Misregistration at Press
Time will Create a

White Gap

Knock-Out is Exact Size
as the Inside Color

Inside Color Exact Size
as the Knock-Out

Misregistration at Press
Time is Compensated

with a Trap

Knock-Out is Exact Size
Needed for the Inside

Color

Inside Color Larger than
the Knock-Out

Choke Created by
Lightest Color

Overlapping into the
Knock-Out Boundaries

Edge of Knock-Out and
Edge of Darker Color

Spread Created by
Lighter Color Extending

Out of the Knock-Out
Boundaries

Figure 8-12: Chokes and Spreads

Having the colors overlap slightly eases the registration process on the printing
press. During most situations you will find that it is the lighter ink color that
creates the actual trapping effect
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There are distinct differences between a choke and a spread. A choke is when
the hole created by the knock-out is smaller than the item that created the
knock-out. A spread is when the hole created by the knock-out is true to size,
but the object that sits in the hole is larger.

Determining the Trap Value

The value used for a trap should be recommended by your pressman, since
chokes and spreads vary depending on the inks and presses used. The value
for a one dot choke/spread can be determined by dividing 500 by the screen
lineage. The answer will be in mils (1/1000").

Formula: 500/Screen Lineage = Trap Value

Using this formula, to overlap one full dot when outputting 133 line screens,
use a 3.75 mil trap (7 mils equals 1/2 point).

This value would be input in the Spot Color Specification Dialog. The value
that you enter is considered to be a global value. Meaning that when a
choke/spread is applied, it is used on every one throughout the part. In order
for automatic choke and spread to take place, the object that creates the
knock-out or receives the trap must be 100% totally enclosed within the other
object’s boundaries.

Automatic Trapping through Output Specifications

Figure 8-13: Spread Effects Entire Component

Automatic Choke and Spread only effects Text, Areas, Barcodes, and Box
Insides.
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Exercise in Defining Spot Color Specifications
In order to make efficient use of the Spot Color Specifications, you must first
understand the printing process. The presses need to have individual plates
for each color of ink, for each part of a form, as well as, separate plates for
any back printing. Each plate generally contains the image of the form to be
printed, as well as, plate marks and registration marks dictated by the print
shop.

The first step begins before the first component is drawn on the page.
Evaluation of the form, its parts and colors are necessary to determine how
many layers will be used to make up the form and all of its parts.

Let’s look at the following form and determine its layer needs. It is a basic
unit set form. It has a Customer Copy on Part 1 and an Office Copy on Part
2. It also has a Terms and Conditions backer. Both Part 1 and 2 are made up
of two colors. The Backer is one color.

Body - Black Ink
Headers & Marginals - Red Ink

Back Printing - Black Ink

Figure 8-14: Example of Multiple Part Form

Below is a good example of what information can be deduced by a quick
evaluation of the form.

Body of Form Common to Parts 1 and 2 -Black Ink . . . . . Layer 1

Blockout for Part 1 - Black Ink . . . . . . . . . . . . . . . . . . . Layer 2

Headers & Marginal Word for Part 1 - Red Ink . . . . . . . Layer 3

Headers & Marginal Word for Part 2 - Red Ink . . . . . . . Layer 4

Backer Text - Black Ink . . . . . . . . . . . . . . . . . . . . . . . . Layer 5

Registration Marks on top-right for Front Printing . . . . Layer 14

Registration Marks on top-left for Back Printing . . . . . . Layer 15

Plate Marks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Layer 16
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We will compose the job making use of the 32 different layers. Any
arrangement of layers can be used. Controlling the layers within the Output
Specifications will allow us to output separations correctly according to the
job requirements from shift to shift, and to view the parts using the View,
Parts menu.

With these points in mind, we need to formulate a plan before composing to
insure the plates can be output to meet the needs of the job. A worksheet
similar to the one shown is very useful to plan the job before composition.
We know in order for the job to be printed we need 5 plates: Body of Part 1,
Body of Part 2, Headers & Marginal Part 1, Headers & Marginal Part 2, and
Backer.

Plate Description FCP Color Layers Needed

1

2

3

4

5

Part 1 of Form Base
w/Blockout

Headers & Marginal for
Part 1

Part 2 of Form Base

Headers & Marginal for
Part 2

Backer

Black - 700

Red - 185

Black - 700

Red - 185

Black - 700

1, 2, 14, 16

3, 14, 16

1, 14, 16

4, 14, 16

5, 15, 16

Figure 8-15: Part Layout

After the job is composed with appropriate components on appropriate layers,
we are able to output the job. In order to get the 5 plates (separations) for our
example, we have setup the following specifications (shown in Figure 8-16)
to turn on the layers needed for each separation.
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Notice that we have two separations that make up both Part 1 and 2, with only
one separation needed for Part 3 (the backer).

Figure 8-16: Output Specifications for Oakton Example
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PDF Output of the Exercise
Save As PDF option, uses the Output Specifications specified to produce
composites or separations to the PDF.

After selecting Save As PDF, you will need to select which Part to print. With
Spot Color, you can output up to eight colors per part. Checking just the part
will print ALL separations for that part and create a composite. Selecting
[Okay] will create the PDF.

Figure 8-17: Save As PDF, Separations Tab

The column for "Seps" is important. If you are asking for a Maximum of 2
separations, and you only want separation 1, you must check the separation
you want. By default, the Maximum number of separations will print if you
do not specify otherwise.
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PDF Select Batch Option
The PDF Select Batch outputs multiple files for printing. Start by going to
the Select Batch Tab under the Save As PDF option.

Next, decide on all files to be output. You can do this by picking Add Page(s).
This will take you to a standard Open dialog box. Highlight all of the files
you wish to output and [Okay]. To remove files from this list, click on the
file(s) to remove and pick Remove Page. Using [Ctrl] and the [Shift] keys
will aid you in selecting multiple files in the same directories.

Figure 8-18: Select Batch Dialog

Note: The only requirement is that all files are drawn using the same part/layer
color specifications: Black on layer 1, Second Color on layer 2, Cutmarks on
layer 3, etc.

Be aware that the files will print in the order selected and the only way of
re-arranging them is by removing and then adding the files back into the list.
The pages will be output in the order that they appear in the list.
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CHAPTER 9

Importing EPS and PDF Files
OneForm Designer Plus (OFDP) has the capability to interpret and convert
two file types: Encapsulated PostScript (EPS) and Adobe Acrobat 5.0 (PDF)
files. This is accomplished through the Import option found under the File
menu.

Importing PostScript Files
OFDP can interpret standard Encapsulated PostScript (.eps) files. Importing
an EPS file is easy. Go to the File menu and select Import, EPS Files. It will
recognize the file type and convert the EPS file to a (.g). Once the file has
been converted and saved, it can be opened normally.

PostScript Interpreter
PostScript is the publishing industry standard page-description language
developed by Adobe Systems and interpreted by PostScript printers. PostScript
provides a programmable set of tools for easily imaging all graphic elements.

OFDP’s PostScript Interpreter software interprets standard PostScript and
Encapsulated PostScript files and converts them into OneForm Designer Plus
graphic files.

When you need to get a good start on a file which has already been created
on another type of software, create an EPS file and import into OFDP. This
will save you from starting from scratch, but it doesn’t mean that there will
not be any work involved. The OneForm file will need to be proofed for
anything which didn’t convert well, and fixed.

Terminology:

• PostScript File: A file written in PostScript (PS) language can be printed
by printers which interpret PostScript. These files are in ASCII text format,
but can include binary information such as scanned TIFF images.

• PostScript Printers: A printer or imagesetter that contains the PostScript
language interpreter. Both printer and imagesetter provide text and graphics,
however the imagesetter produces higher quality output.

• Encapsulated PostScript: Encapsulated PostScript Format (EPS or EPSF)
is a file format for PostScript graphics that contains PostScript code for the
image, as well as an optional preview version. The EPS standard enables
device-independent transfer of graphics between different applications.

• PostScript Interpreter: A PostScript Interpreter is just that, it interprets
PostScript code to be read into OFDP. This file is a OneForm Designer
file, but it has problems inherent to converted files.
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Encapsulated PostScript Files
If at all possible we recommend that you work with EPS files versus standard
PostScript (PS and sometimes PRN). EPS files were developed for transfer
between applications and usually convert more successfully because they do
not contain device specific PostScript code.

Typical Encapsulated PostScript files start out with the heading stating it is a
EPSF file, version number, followed by the creator. Most PostScript files can
be opened and looked at by an editor.

Example of PS File Header

% BLOC Forms printing system --
Form:C:\F3\FORM\SRVRO.FDB
% Printer:GENERIC POSTSCRIPT PRINTER

Example of EPS File Header

%!PS-Adobe-2.0 EPSF-2.0
%%BoundingBox: 95 396 141 590
%%Creator: CorelDRAW!
%%Title: AB-LGBUG.EPS

Try to minimize the nesting of EPS files. Printing an EPS within the EPS
increases the chance that the file will not convert properly. Generally, if it
won’t print to a laser printer, it will not convert.

Multiple Page PS Files
If the file has multiple pages, we suggest creating an EPS file for each page.
You may combine the pages once they have been converted into OneForm
files. There will be less problems converting and naturally, if there are
problems, it is easier to find a problem on one page rather than on multiple
pages. However, if you do have a multiple page PostScript file, each page
should convert to a different layer. Then you can see your individual pages
just by using the Layers On/Off under the Options menu.
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Using Import EPS Files
Import allows you to import PostScript files from other drawing packages and
convert them to graphic files that OneForm can use. PostScript files can be
created in almost any program by going to Print and choosing a PostScript
printer as your device, and then selecting Print To File. This will not send the
job to a printer, but will allow you to make a file and name it. But we
recommend importing Encapsulated PostScript files for best results.

Start a New Drawing and then choose File, Import and then EPS Files. A
dialog box will appear to locate your EPS. The OFDP PostScript interpreter
will do the rest. The file will automatically be brought into OneForm and will
be renamed with a .g extension. The new graphic file may now be saved and
opened normally.

Figure 9-1: Import EPS Files Menu
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Importing PDF Files
The import PDF option converts Adobe Acrobat 5.0 PDF files to graphic files.
Before starting your conversions, there are several items to be aware of, so
please read the following information.

Converting the PDF File

First start with preparation of the PDF file. Open it in Acrobat Professional
and Optimize to Acrobat 5.0 and save the file into a OFDP naming convention.
Import only works with Acrobat 5.0 files. With Acrobat X, use Save As,
Optimized PDF. With older versions use the Advanced, PDF Optimizer option.
This will consolidate the file and make sure there is no security.

Importing the PDF file is easy. Go to the File menu and select Import, PDF
Files. Browse for your file, check "Import All Pages", and then [OK].

The naming convention is basename_pagenumber_.g for converted files. It
will create the ELFs in the same folder as the PDF.

Since PDF files can hold multiple pages, and you may not want to import the
entire file, you can get a list of pages. Unchecking "Import All Pages", and
then clicking [OK] will take you to the PDF Import dialogs. Here you can
select one page at a time to import.

Figure 9-2: Opening a PDF File
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To get a list of pages, click onto the plus sign (+). Then highlight a page and
select [OK]. Again, the naming convention is basename_pagenumber_.g for
converted files.

The PDF Dialogs

The PDF dialog allows you to select a page for conversion and also list the
fonts and layer colors which are going to be used during the conversion. Just
click on the plus sign (+) to list fonts or colors.

If the font does not exist on your system, you may index it to another of your
choice from a drop down list of fonts.

Figure 9-3: Indexing the Font

The Preview Tab options are not available at this time.

Note: We cannot import LZW compressed files. Also, we will not import
protected files. The maker must remove the security protection first.
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Typical Converted File
Below is a look at a typical converted EPS file. Notice the variety of
components. The area does have a 60 line screen.

After importing a file, the file will be saved with a .g extension. It is now
ready to proof and clean-up.

1st Purchaser

2nd Purchaser

Address

Enter my order for

VIN #

YR. MAKE TYPE

SALES CONSULTANT

BASE PRICE

Documentation Fees

Retail Accessories

1.

FACTORY INSTALLED ACCESSORIES

NEW

USED MILES

DEMONSTRATOR CAR

TRUCK

Saturn of Warren

7830 Convention Blvd.
Warren, MI 48092
(313) 979-2000

RETAIL BUYERS ORDER

County

A Member of The Galeana Group

Spline

Areas
(Colors 600 & 640)

(Screen Lineage 60)
Text – Helvetica Bold and Normal
Using Several Different Sizes.

Raster

User Defined
Line Pattern

Vectors

Figure 9-4: Converted EPS File Showing a Variety of Components

You will see text, vectors, splines, areas, arc/circles, and rasters. At this point
it is your responsibility to proof the file for conversion correctness. You have
the ability to modify any of the components through their respective options.
It is definitely better than starting from scratch, but is not always easy to
modify.

Since the EPS file is a printer driver, what you think the application has done
to create the image, is not always the case. What appears as vectors, is
sometimes handled as areas in some applications. What appears as text is
sometimes rasters. Screens, usually in the case of graduated areas, can be
vectors.

Also, vertical vectors can be many tiny line segments instead of one line. This
is usually seen when the original file comes from a word processing package
instead of a graphic application.
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Working with Converted Files
OFDP files which are generated from EPS or PDF files have inherent problems
which can be made easier to handle if the original files are created knowing
about them. Here are some suggestions on how to handle the following.

Area Issues
Area Convert: This option found under the Modify Menu was created to help
clean-up imported files. Some programs draw lines and rectangles as Area
fills. The Area Convert option will analyze the file and convert thin areas to
Line components and rectangular areas to Box Components. Just click the
[Process] button.

Text Issues
• Text only converts as individual lines of text. They will never be multi-line
paragraphs. PostScript issues beginning positions only and is not aware of
leading. To make a paragraph out of these individual lines requires you to pull
the lines together and modify attributes. (Instructions on next page.) You
should only massage text which needs to be edited or changed.

• If you use letter spacing in the original document, it will cause the text lines
to convert as individual letters, not just lines of copy.

• If you use word spacing in the original document, it will cause the text lines
to convert as individual words, not just lines of copy.

• If you use kerning in the original document, it will cause the text lines to
break into letters whenever kerning is encountered.

• Be aware that justified paragraphs may also come in as either individual
letters or words. How the application justifies determines what the EPS file
will contain.

• Pseudo-condensing causes the text to come in as individual letters.

• Pseudo-italic in most cases will be ignored.

• Any special characters included in the file should be referenced, if a match
cannot be found they will convert as question marks (?) and will need to be
replaced.

Graphic and Font Issues
Also, some of the problems cannot be resolved and must be avoided at the
application level. These are:

• If the original document has included files (such as rasters, logos,
Encapsulated PostScript), do not forget to copy or transfer them also. Just
because they are referenced in the PostScript file, does not make them
accessible during conversion.

• It is desirable not to download the fonts with the PostScript file since we
do not process the font information during conversion. Not including font
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information will allow the file size to be more manageable and the conversion
to run faster.

• The interpreter does not convert any fonts, but will find them if they are
mapped to OFDP. Any font which is not found on your computer will convert
as Helvetica.

• Line patterns from other applications will not convert.

• It is best not to place graduated screens in original document. Graduated
screens usually convert as individual lines with varying screen values.
Thousands of lines copied across the job makes working with the file difficult.

• Screen lineage may be lower than you would like. If the file was originally
set for a low resolution printer which normally uses a 60 line screen, the file
will reflect that lineage. It can easily be changed by Modifying the component
properties

Pulling Lines of Text Back Together

Text only comes in as individual lines of text. They will not be paragraphs.
To make a paragraph out of these individual lines requires you to Group all
the text that you wish to combine and then select Combine Selected Text
from the pop-up menu.

This is not hard, but there will be some cleanup needed to the measure,
justification, and line breaks; so only cleanup the text which needs revisions.

For justified paragraphs you will need to bring the text lines together using
the combine technique before changing the properties of the Right Margin
(width of text line) and Composition Mode. Select the text box to modify and
go to the Modify Properties. Change the Composition Mode to be Justified
and adjust the Right Margin to match the width that you wish the text box to
be.

Line breaks for combined text are controlled by the Immediate Command \NL^
(New Line). You will need to edit the content of the paragraph. This is most
easily done through the Text Editor method of working with text. Change the
Immediate Command \NL^ (New Line) to force lines to break at the correct
word to the Immediate Command \FJ^ (Force Justify) to make the line justify
but break at the assigned word.

Check for any style changes or special characters, etc. You would be looking
for any internal paragraph changes which we control with the Immediate
Commands or through the Pop-up menu.

If lines of text extend beyond your boundaries, it could be an issue with your
Letter or Word Spacing. Group and Modify the spacing.

Some fonts may be substituted. This is usually the case either if the font is
Not Found on the current computer. Just Group the text and change the font
properties to one that exists.
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CHAPTER 10

Business Form Templates
The most commonly used business form templates are included with your
OneForm Designer Plus software. They can be accessed by going directly to
the folder at C:/Program Files (x86)/Amgraf/OneForm/Templates.

The template choices are files which exist in the directory Templates. These
drawings are very useful as a starting point for production. The sizes are
organized by width and then depth.

Opening is a great starting point for a new drawing. Be sure to Save As and
rename it into another location. You can also Combine them into existing
forms.

Templates holds six categories:

• Continuous

• Heat Seal

• Mailer

• Standard

• Unit Set

• E-Form

E-Form Templates
Picking the E-Form type causes the file to have an ".elf " extension with a
page size. There are no components on the page.

Sizes: 8.5x11
11x8.5
8x5
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Continuous Form Templates
Each Continuous Form template has the following specifications:

Margins – 1⁄2" top and bottom.
Perforations – 1⁄2" left and right.
Perforation Holes – 1⁄2" apart, 5⁄32" diameter.
Perforation Marks – 1⁄8" long, 1⁄2-point line weight.
Register Mark – 3⁄16" square, 3⁄4" down on second hole.
Byline – 5-point Helvetica Normal.
Cuts – 1⁄4" long 1⁄16" gap, 1-point line weight.
Template is located on Layer 16.
An Output Specification is setup for Layers 1, 2 and 3.

Below is an example of one of our Continuous templates. Displayed are the
sizes available. If you do not find your needed size, load a similar size and
modify it by moving the boundary components.

Most Commonly Used

Other Sizes
17" x 5"
18" x 11"
18" x 14"
18" x 3.5"
18" x 3.667"
18" x 5.5"
18" x 7"
6" x 3"
7" x 3"
7" x 4"
8" x 3.5"
9.5" x 3.5"
9" x 5"

12" x 8.5"
14.875" x 11"
9.5" x 11"
9.5" x 14"
9.5" x 3.667"
9.5" x 5.5"
9.5" x 7"

10.5" x 4"
11.5" x 4"
11" x 3"
11" x 4"
12" x 4"
13" x 3"
13" x 4"
15" x 3.5"
16" x 11"
16" x 14"
16" x 3.5"
16" x 3.667"
16" x 3"
16" x 5.5"
16" x 7"
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Heat Seal Form Templates
Each Heat Seal Form template has the following specifications:

Margins – 11⁄2 sixths of an inch top and bottom.
Perforation – 3⁄4" left and right.
Perforation Holes – 1⁄2" apart, 5⁄32" diameter.
Perforation Marks – 1⁄8" long, 1⁄2-point line weight.
Register Mark – 3⁄16" square, 3⁄4" down on second hole.
Byline – 5-point Helvetica Normal.
Cuts – 1⁄4" long 1⁄16" gap, 1-point line weight.
Template is located on Layer 16.
An Output Specification is setup for Layers 1, 2 and 3.

Below is an example of one of our Heat Seal Form templates. Displayed are
the sizes available. If you do not find your needed size, load a similar size
and modify it by moving the boundary components.

Most Commonly Used

Other Sizes

16" x 4.25"
16" x 5.5"
17" x 4.25"
17" x 5.5"
9.875" x 11"

10" x 11"
13" x 11"
18" x 4.25"
18" x 5.5"
7.5" x 4.25"
9.5" x 11"
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Mailer Form Templates
Each Mailer Form template has the following specifications:

Margins – 1⁄2" top and bottom.
Perforation – 3⁄4" left and right.
Perforation Holes – 1⁄2" apart, 5⁄32" diameter.
Perforation Marks – 1⁄8" long, 1⁄2-point line weight.
Register Mark – 3⁄16" square, 3⁄4" down on second hole.
Byline – 5-point Helvetica Normal.
Cuts – 1⁄4" long 1⁄16" gap, 1-point line weight.
Template is located on Layer 16.
An Output Specification is setup for Layers 1, 2 and 3.

Below is an example of one of our Mailer Form templates. Displayed are the
sizes available. If you do not find your needed size, load a similar size and
modify it by moving the boundary components.

Commonly Used Sizes Other Sizes

In
se

rt
 Y

ou
r 

C
om

pa
ny

 B
y 

Li
ne

 H
er

e

10.625" x 4.25"
10.625" x 6"
11.75" x 4.25"
11.75" x 6"
11" x 5.667"
11" x 6"
12" x 8.5"

10.625" x 5.5"
10" x 3.667"
10" x 4.25"
10" x 4.667"
10" x 5.5"
10" x 5.667"

10" x 6"
11.75" x 5.5"
11" x 4.667"
11" x 5.5"
9.5" x 3.667"
9.5" x 5.5"

16.75" x 3.667"
16.75" x 4.25"
16.75" x 4.667"
16.75" x 5.5"
16.75" x 6"
9.5" x 11"



Chapter 10: Business Form Templates

Standard Size Templates

261

Standard Size Templates
Each Standard Size template has the following specifications:

Cuts – 1⁄4" long, 1⁄16" gap, 1-point line weight.
Cut marks and page size are on Layer 16.
Turn OFF Layer 16 for Laser Proof.
Turn ON Layer 16 for high resolution output.
An Output Specification is setup for Layers 1, 2 and 3.

Margins are set for 100% proof on Laser Proof Printers.
Margin lines are on Layer 15.

Below is an example of one of our Standard Size templates. Displayed are the
sizes available. If you do not find your needed size, load a similar size and
modify it by moving the boundary components.

Most Commonly Used
Landscape – 11" x 8.5"
A3 – 297mm x 420mm
A4 – 210mm x 297mm
A5 – 148mm x 210mm
B4 – 250mm x 353mm
B5 – 176mm x 250mm
Ledger – 11" x 17"
Legal – 8.5" x 14"
Letter – 8.5" x 11"
Statement – 5.5" x 8.5"

Landscape
A3 – 420mm x 297mm
A4 – 297mm x 210mm
A5 – 210mm x 148mm
B4 – 353mm x 250mm
B5 – 250mm x 176mm
Ledger – 17" x 11"
Legal – 14" x 8.5"
Letter – 11" x 8.5"
Statement – 8.5" x 5.5"
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Unit Set Form Templates

Each Unit Set Form template has the following specifications:

Stub – 5⁄8" top stub.
Margins – 21⁄2 tenths of an inch left and right
Perforation Holes – 1⁄2" apart, 5⁄32" diameter.
Perforation Marks – 1⁄8" long, 1⁄2-point line weight.
Register Mark – 3⁄16" square, 3⁄4" down on second hole.
Byline – 5-point Helvetica Normal.
Cuts – 1⁄4" long 1⁄16" gap, 1-point line weight.
Template is located on Layer 16.
An Output Specification is setup for Layers 1, 2 and 3.

Below is an example of one of our Unit Set templates. Displayed are the sizes
available. If you do not find your needed size, load a similar size and modify
it by moving the boundary components.

Most Commonly Used

Other Sizes

Insert Your Company By Line Here

11" x 9.125"
3.667" x 7.625"
3.667" x 9.125"
4.25" x 7.625"
4.25" x 9.125"
5.5" x 7.625"
5.5" x 9.125"
8.5" x 11.625"
8.5" x 14.625"
8.5" x 6.125"
8.5" x 7.625"
8.5" x 9.125"

11" x 14.625"
11" x 17.625"
11" x 4.875"
14" x 9.125"
17" x 11.625"
3.5" x 9.125"
3" x 5.625"
4" x 6.625"
6" x 4.625"
8" x 5.625"
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CHAPTER 11

Borders and Pantographs Library
Looking at the examples on the following pages, you will see a large library
of stock borders and pantographs to choose from. Borders and Pantographs
are drawn through the Draw Box tool and setup with the Box Properties tool.

Although the library contains 125 basic border/pantograph designs, the
software allows you to manipulate these designs in such a way that the end
result is unlimited.

For both borders and pantographs, just reversing the color numbers creates a
different effects; and since they are fonts, changing the point size to reduce
or enlarge the design, also creates different looks. For examples of different
effects see pages 264 and 272.

Borders
There are 67 stock borders which can be used with the Box tool. Each one of
these borders are reversible, which many times gives you another unique look.
Side-by-side is the standard border and its reverse. With a few of them,
reversing the colors simply makes the design white, in this instance we show
it on top of a black box so that it appears. See a variety of graphic effects
with borders on page 264. The Box Border Tab is described on page 78.

Pantographs
There are 58 stock pantographs which can be used with the Box tool. Each
one of these are reversible, which many times gives you another unique look.
Side-by-side is the standard panto and its reverse. See a variety of graphic
effects with pantographs on page 272. The Box Pantograph Tab is described
on page 81.
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Different Border Looks From One Design
Below is an example of the wide variety of graphic effects which can be
accomplished just by changing the point size and color density.
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Screening
Background Only

Background Color 40%
Foreground Color 0%

Point Size 18P

Screening
Foreground Only

Background Color 0%
Foreground Color 40%

Point Size 18P

Color in Both
Background Color 100%
Foreground Color 40%

Point Size 18P

Color in Both
Background Color 40%
Foreground Color 100%

Point Size 18P

Figure 11-1: The Many Designs of Border #026
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BG is Black
FG is 20%

Point Size 11P
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Point Size 11P
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Border #018
BG is Black
FG is White

Point Size 10P
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BG is White
FG is Black

Point Size 10P
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BG is Black
FG is White
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BG is Black
FG is 20%

Point Size 10P
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FG is Black

Point Size 5P

Border #043
BG is Black
FG is White

Point Size 4P

Border #043
BG is White
FG is Black

Point Size 4P

Border #045
BG is Black
FG is White

Point Size 5P

Border #045
BG is White
FG is Black

Point Size 5P

Border #046
BG is Black
FG is White

Point Size 4P

Border #046
BG is White
FG is Black

Point Size 4P

��

��

��
��

����

� �

��

��

��

��
��

����

� �

��

Border #039
BG is Black
FG is White

Point Size 4P

Border #039
BG is White
FG is Black

Point Size 4p

Border #044
BG is Black
FG is White

Point Size 4P

Border #044
BG is White
FG is Black

Point Size 4P

��

��

��
��

����

� �

��

��

��

��
��

����

� �

��
�

�

�
�
�

�
�
�

� �

��

�

�

�
�
�

�
�
�

� �

��

���

���

�
�
�
�
�

�
�
�
�
�

� �

��

���

���

�
�
�
�
�

�
�
�
�
�

� �

��

�

�

�
�

�
�

� �

��

�

�

�
�

�
�

� �

��

�

�

�
�
�

�
�
�

� �

��
�

�

�
�
�

�
�
�

� �

��

���

���

�
�
�
�
�

�
�
�
�
�

� �

��

���

���

�
�
�
�
�

�
�
�
�
�

� �

��

�

�

�
�

�
�

� �

��
�

�

�
�

�
�

� �

��

��

��

�
�
�
�

�
�
�
�

� �

��

��

��

�
�
�
�

�
�
�
�

� �

��

��

��

�
�
�
�

�
�
�
�

� �

��

��

��

�
�
�
�

�
�
�
�

� �

��

�

�
�
�

�
�

� �
��

�

�
�
�

�
�

� �
��

�

�

�
�

�
�

� �

��

�

�

�
�

�
�

� �

��

���

���

�
�
�
�
�

�
�
�
�
�

� �

��

���

���

�
�
�
�
�

�
�
�
�
�

� �

��

���

���

�
�
�
�
�

�
�
�
�
�

� �

��

���

���

�
�
�
�
�

�
�
�
�
�

� �

��

�

�

�
�

�
�

� �

��

�

�

�
�

�
�

� �

��

�

�

�
�

�
�

� �

��

�

�

�
�

�
�

� �

��



Chapter 11: Borders and Pantographs Library

Border Library

269

�

�

�
�

�
�

� �

��

�

�

�
�

�
�

� �

��

Border #050
BG is Black
FG is White

Point Size 7P

Border #050
BG is White
FG is Black

Point Size 7P

��

��
��

��
��

��
��

��
Border #051
BG is Black
FG is White

Point Size 10P

Border #051
BG is White
FG is Black

Point Size 10P

����

����

�
�
�
�
�
�
�

�
�
�
�
�
�
�

� �

��

����

����

�
�
�
�
�
�
�

�
�
�
�
�
�
�

� �

��

����

����

�
�
�
�
�
�
�

�
�
�
�
�
�
�

� �

��

����

����

�
�
�
�
�
�
�

�
�
�
�
�
�
�

� �

��

Border #052
BG is Black
FG is White

Point Size 10P

Border #052
BG is White
FG is Black

Point Size 10P

�

�
�

�

� �
��

�

�
�

�

� �
��

�

�

�

�

� �

��

�

�

�

�

� �

��

Border #053
BG is Black
FG is White

Point Size 12P

Border #053
BG is White
FG is Black

Point Size 12P

�

�
� �

��

�

�
� �

��
Border #049
BG is Black
FG is White

Point Size 7P

Border #049
BG is White
FG is Black

Point Size 7P

����

����

�
�
�
�
�
�
�

�
�
�
�
�
�
�

� �

��

����

����

�
�
�
�
�
�
�

�
�
�
�
�
�
�

� �

��

����

����

�
�
�
�
�
�
�

�
�
�
�
�
�
�

� �

��

����

����

�
�
�
�
�
�
�

�
�
�
�
�
�
�

� �

��

Border #054
BG is Black
FG is White

Point Size 12P

Border #054
BG is White
FG is Black

Point Size 12P

�

�

� �

��

�

�

� �

��

�

�
�
�

�
�

� �
��

�

�
�
�

�
�

� �
��

Border #047
BG is Black
FG is White

Point Size 4P

Border #047
BG is White
FG is Black

Point Size 4P

Border #048
BG is Black
FG is White

Point Size 5P

Border #048
BG is White
FG is Black

Point Size 5P

���

���

�
�
�
�
�

�
�
�
�
�

� �

��

���

���

�
�
�
�
�

�
�
�
�
�

� �

��

���

���

�
�
�
�
�

�
�
�
�
�

� �

��

���

���

�
�
�
�
�

�
�
�
�
�

� �

��

���

���

�
�
�
�
�

�
�
�
�
�

� �

��

���

���

�
�
�
�
�

�
�
�
�
�

� �

��
���

���

�
�
�
�
�

�
�
�
�
�

� �

��
���

���

�
�
�
�
�

�
�
�
�
�

� �

��



Border Library

270 OFDP Business Forms Composition – Ver 8.0

��

��

�
�
�

�
�
�

� �

��

��

��

�
�
�

�
�
�

� �

��

��

��

�
�
�

�
�
�

� �

��

��

��

�
�
�

�
�
�

� �

��

Border #060
BG is Black
FG is White

Point Size 6P

Border #060
BG is White
FG is Black

Point Size 6P

������������

������������
��
��
��
��
��
��
��
��
��
��

��������������������

� �
��

������������

������������
��
��
��
��
��
��
��
��
��
��

��������������������

� �
��

������������

������������

��
��
��
��
��
��
��
��
��
��

��������������������

� �

��

������������

������������

��
��
��
��
��
��
��
��
��
��

��������������������

� �

��

Border #061
BG is Black
FG is White

Point Size 2P

Border #061
BG is White
FG is Black

Point Size 2P

�

�

�

�

� �

��

�

�

�

�

� �

��

�

�

�

�

� �

��

�

�

�

�

� �

��

Border #062
BG is Black
FG is White

Point Size 6P

Border #062
BG is White
FG is Black

Point Size 6P

�����

�����

�
�
�
�
�
�
�
�

�
�
�
�
�
�
�
�

� �

��

�����

�����

�
�
�
�
�
�
�
�

�
�
�
�
�
�
�
�

� �

��

�����

�����

�
�
�
�
�
�
�
�

�
�
�
�
�
�
�
�

� �

��

�����

�����

�
�
�
�
�
�
�
�

�
�
�
�
�
�
�
�

� �

��

Border #059
BG is Black
FG is White

Point Size 8P

Border #059
BG is White
FG is Black

Point Size 8P�

�

� �

��

�

�

� �

��

Border #055
BG is Black
FG is White

Point Size 7P

Border #055
BG is White
FG is Black

Point Size 7P

�����

�����

�
�
�
�
�
�
�
�

�
�
�
�
�
�
�
�

� �

��

�����

�����

�
�
�
�
�
�
�
�

�
�
�
�
�
�
�
�

� �

��

�����

�����

�
�
�
�
�
�
�
�

�
�
�
�
�
�
�
�

� �

��
�����

�����

�
�
�
�
�
�
�
�

�
�
�
�
�
�
�
�

� �

��

Border #056
BG is Black
FG is White

Point Size 10P

Border #056
BG is White
FG is Black

Point Size 10P

���

���

�
�
�
�
�
�

�
�
�
�
�
�

� �

��

���

���

�
�
�
�
�
�

�
�
�
�
�
�

� �

��

���

���

�
�
�
�
�
�

�
�
�
�
�
�

� �

��

���

���

�
�
�
�
�
�

�
�
�
�
�
�

� �

��

Border #057
BG is Black
FG is White

Point Size 10P

Border #057
BG is White
FG is Black

Point Size 10P

�

�
�
�

�
�

� �
��

�

�
�
�

�
�

� �
��

�

�

�
�

�
�

� �

��

�

�

�
�

�
�

� �

��

Border #058
BG is Black
FG is White

Point Size 6P

Border #058
BG is White
FG is Black

Point Size 6P

�

�

� �

��

�

�

� �

��



Chapter 11: Borders and Pantographs Library

Border Library

271

�

�

�

�

� �

��

�

�

�

�

� �

��

�

�

�

�

� �

��

�

�

�

�

� �

��

Border #063
BG is Black
FG is White

Point Size 8P

Border #063
BG is White
FG is Black

Point Size 8P

�

�

�
�

�
�

� �

��

�

�

�
�

�
�

� �

��

�

�

�
�

�
�

� �

��

�

�

�
�

�
�

� �

��

Border #065
BG is Black
FG is White

Point Size 6P

Border #065
BG is White
FG is Black

Point Size 6P

�

�

�

�

� �

��

�

�

�

�

� �

��

�

�

�

�

� �

��

�

�

�

�

� �

��

Border #066
BG is Black
FG is White

Point Size 10P

Border #066
BG is White
FG is Black

Point Size 10P

�����

�����

�
�
�
�
�
�
�
�
�

�
�
�
�
�
�
�
�
�

� �

��

�����

�����

�
�
�
�
�
�
�
�
�

�
�
�
�
�
�
�
�
�

� �

��

�����

�����

�
�
�
�
�
�
�
�
�

�
�
�
�
�
�
�
�
�

� �

��

�����

�����

�
�
�
�
�
�
�
�
�

�
�
�
�
�
�
�
�
�

� �

��

Border #067
BG is Black
FG is White

Point Size 2P

Border #067
BG is White
FG is Black

Point Size 2P

��

��

�
�
�

�
�
�

� �

��

��

��

�
�
�

�
�
�

� �

��

��

��

�
�
�

�
�
�

� �

��
��

��

�
�
�

�
�
�

� �

��

Border #064
BG is Black
FG is White

Point Size 4P

Border #064
BG is White
BG is Black

Point Size 4P



Different Pantograph Looks

272 OFDP Business Forms Composition – Ver 8.0

Different Pantograph Looks From One Design
A Pantograph is a printed pattern creating a general background tone. They
are used most frequently on checks and similar documents to produce an
attractive hard-to-copy background.
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����������Pantograph #003

100% Panto Background 0%
0% Inside Color Start 100%

Default Point Size 10P

Screening Both the
Background and Insides

30% Panto Background 10%
10% Inside Color Start 30%

Decreasing Size of Design
by Changing the Point Size

in the Panto Menu.
Point Size 7P

Graduating the Inside
10% Panto Background 10%
30% Inside Color Start 30%
80% Inside Color End 80%

Increasing Point Size and
Rotating the Pantograph

90 Degrees in Panto Menu.
Point Size 12.5P

Swapping Around the Colors
10% Panto Background 10%
80% Inside Color Start 80%
30% Inside Color End 30%

Screening the Design by
Changing 100% Color to 40%

40% Panto Background 0%
0% Inside Color Start 40%

Black Design on
White Insides

White Design on
Black Insides

Directional Radial

Directional Radial
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Increasing Point Size and
Rotating the Pantograph

180 Degrees in Panto Menu.
Point Size 15P

Figure 11-2: The Many Designs of a Type A Pantograph
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There are 58 stock pantographs which can be used with the Draw Box tool. Each one
of these are reversible, which many times gives you another unique look. Side-by-side
is the standard panto and its reverse. Pantographs that have both a background and
foreground are marked. 

OneForm Designer Plus Stock Pantographs

Panto #001– Type A
100% Background 0%

Point Size 15P
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Panto #004 – Type A
100% Background 0%

Point Size 15P
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�������Panto #002 – Type B

100% 0%
0% 100%

Point Size 24P

BG
FG

FG is Foreground

Panto #005 – Type A
100% Background 0%

Point Size 15P

Panto #006 – Type A
100% Background 0%

Point Size 15P

Panto #003 – Type A
100% Background 0%

Point Size 15P

BG is Background
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Panto #047 – Type A
100% Background 0%

Point Size 6P

Panto #051 – Type A
100% Background 0%

Point Size 12P
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100% Background 0%

Point Size 15P
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100% Background 0%
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100% Background 0%
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INDEX

Accented Character Commands 137, 191
Accurate Spacing 52
Add Logo 12, 46
Alphabetical Immediate Commands 146
Altering Properties Within a Paragraph 133
Amgraf’s OneForm Designer Plus 1
Appendix G 222
Arc 119, 122
Area 124, 120
Area Graduations 85
Area Properties 27
Area Properties Dialog Box 32, 85
Areas, Modify 86
Arranging the Display Order 110
Attributes of Lines, Modify 69
Attributes of Text, Modify 96
Automatic Fraction Command 147
Background Attributes, Barcodes 200
Backup Center Command 149
Backup Flush Command 150
Barcode Data 201
Barcode Properties 199
Barcode Types 120, 125, 197
Baseline Down Command 156
Baseline Up Command 177
Basic Drawing Tools 2
Batch Option, PDF 247
Black Box with Square Corners 55
Black/Black Italic Command 151
Bold/Bold Italic Command 148
Border Looks 80, 264,
Borders Library 263
Box 120, 124
Box and Area Properties 27
Box Attributes 40
Box Borders Tab 78
Box Corner Tab 72
Box Edges Tab 70
Box Even/Odd Bars Tab 77
Box Graduation 56, 75
Box Inside Tab 74
Box Pantograph Tab 81
Box Properties Dialog Box 29
Box Rounded Corners 54
Boxes into Individual Columns 57

Boxes, Modify 15, 84
Business Form Templates 257
Button Shortcuts 237
Change Color 153
Change Font 152
Change Layer 167
Change Mode 154
Changing Angle of Graduation 59
Check Spelling 26, 145
Choke and Spread 241
Circle 119, 123
Codabar 202, 203
Code 128 220, 221
Code 3 of 9 204, 205
Code EAN-13 225
Color 229
Color Model 99, 230
Combine Drawing 101
Combining Technique 111
Commands, Text 132
Composition Features 1
Composition Mode 143
Continuous Form Template 258
Conversion Font Issues 255
Conversion Graphic Issues 255
Converted File 254, 255
Converting EPS Files 249
Converting PDF Files 252
Copy Tool 16
Copying Accented Characters 140
Copying Items Between Files 109
Creating a Filled Circle 86
Creating a New Form File 6, 98
Creating a Process Color File 232
Creating Different Border Looks 80
Creating Spot Color File 234
Creating Text Example 62
Cursor Accuracy Controls 14, 21
Cut, Copy and Pasting Items 22, 108
Designing a Form with Boxes 49
Determining the Trap Value 242
Differences, Spot & Process Color 229
Display Order 110
Divide Boxes into Columns 57
Down for Subscript Command 155
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Draw Area 124
Draw Box 53, 124
Draw Foundation Ruling First 39
Draw Lines and Boxes 41
Draw Menu 118
Draw Rectangle 123
Draw Spline 125
Draw Text 124
Drawing Chained Lines 132
Drawing Circles 123
Drawing Component Properties 63
Drawing Electronic Form Fields 125
Drawing Lines 121
Drawing Multiple Lines 42
Drawing New Components 10
Drawing Options 112
Drawing Properties 38
Drawing Prorated Multiple Lines 121
Drawing Raster Image 125
Drawing Templates 51
Drawing the Plate 238
Drawing Tools 2
Drawing Vectors 121
Drawing White Lines 58
Edit Barcode Data 201
Edit Menu 105
Editing and Modifying Existing Text 136
E-Form Fields 120
E-Form Templates 257
Electronic Field Tools 33
Electronic Form Fields 125
Ellipse 119, 123
Empty Boxes with Rounded Corners 54
Encapsulated PostScript Files 250
Enumeration Tab 89
Enumerations and Indents 90
EPS Interpreter 249
Exercise Spot Color Specifications 243
Extra Bold/Extra Bold Italic Command 181
FCP Color Numbers 231
Field Tools 33, 120
File Function Tools 6
File Menu 97
Fill Command 158
Filled Circle 86
FIM Pattern Facts 213
First Point Size Reset Command 157
Font Setup Menu Options 104

Font Tab, Text 87
Force Justify Line 159
Form Templates 257
Foundation Ruling First 39
Fraction Command 147
Getting Ready for Drawing 52
Graduated Box 56
Graduation, Changing Angle 59
Graduations, Area 85
Grid Options 115
Grid Spacing 39, 51
Group Selecting Items 106
Gutters 143
Heat Seal Form Templates 259
Heavy/Heavy Italic Command 164
Help Menu 129
Helvetica Special Character Chart 183
Horizontal Rule Command 160
Horizontal Size Command 163
Horizontal Space Abs. Command 162
Horizontal Space Rel. Command 161
Hot Keys for Position Assistant 34
Human Readables 201
Hyphenation Tab 92
Immediate Commands, List 146
Immediate Text Commands 139, 145
Import 104
Import EPS Files 251
Importing ASCII Text 136
Importing PDF Files 249, 252
Indents and Enumerations 90
Individual Columns 57
Inputting Text Methods 132
Inserting Text Commands 132
Insure Accurate Spacing 52
Intelligent Mail 226, 227
Interactive Text Pop-Up Menus 132
Interleaved 2 of 5 218, 219
International Characters 137, 191
Kerning Tab 93
Layer, Color, and Screen Tab, Text 90
Layer/Color and Screen Attributes 66
Layers On/Off 117
Leader Fill 158
Leading 166
Letter Space Tab 93
Level and To Level Position 19
Light/Light Italic Command 165
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Line Attributes 40
Line Leading Command 166
Line Properties Dialog Box 27, 28, 63
Line Style 65
Line Weight 64
Lines 58, 121
Lines and Boxes 41
Lines, Modify 15, 69
Logo Tool 12, 46
Logos, Modify 13, 15
Mailer Form Templates 260
Mark Text Anchor Position 141
Measure 21
Medium/Medium Italic Command 168
Menus 97
Methods of Inputting Text 132
Modify Lines with Select Cursor 43
Modify Menu 126
Modify Properties with Select Cursor 14
Modify Size Options 15
Modify Text Properties 44
Modify Tools 16
Modifying Areas 86
Modifying Attributes of Lines 69
Modifying Attributes of Text 96
Modifying Boxes 15
Modifying Boxes 84
Modifying Lines 15
Modifying Raster Properties 13
Modifying Size of Existing Logos 13, 15
Move and Copy Tools 16
Move Baseline Down 156
Move Baseline Up 177
Move to Level 19
Move to Plumb 18
Move Tools 16
Multiple Lines 42
Multiple Page PS Files 250
New Components 10
New Drawing Properties 38
New Form File 6, 98
New Line Command 170
Normal/Italic Command 169
OFDP Color Chart/FCP Color Numbers 231
OneForm Designer Plus Profile 233
Opening an Existing Form File 8, 100
Options Menu 111
Outline 96

Outline/Cancel Outline Command 171
Output Specifications 239
Output Specifications Exercise 243
Output Specifications Spot Color 236
Output Specifications, Step/Repeat 238
Pantograph Looks 82
Pantographs 273
Pantographs Information 83
Pantographs Library 263
Paragraph Indents/Enumerations 90
Paragraph Lines Back Together 256
Paragraph Tab, Text 91
Paragraph, Altering Properties 133
Pasting Items 109
PDF Dialogs 253
PDF Output 246
PDF Select Batch Option 247
Place Text in Boxes 45, 60, 142, 143
Placing Text 43, 141
Plate 238
Plumb and To Plumb Position 18
Point Size Command 172
Point Size Reset Command 157
Pop-Up Menus 4
Pop-Up Menu’s Position Assists 34
Position Assistant Hot Keys 34
Postal - FIM Code 211, 212
Postal - Zip Code Bars 209
Postal Barcode 220
PostScript Files 249
PostScript Interpreter 249
Printing 9, 62
Printing the Form 48, 103
Process Color Attributes 67
Process Color File 232
Program Options 113
Prorated Multiple Lines 121
PS Files, Multiple Page 250
Pulling Lines of Text Together 256
Raster Image 120, 125
Raster Image Properties Dialog 13
Raster Properties, Modify 13
Readout, Text Attributes 25
Rectangle 123
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